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Introduction
Welcome to AnyFileBackup Help. It is designed to explain how AnyFileBackup works and how it can be
configured to meet your needs. If you do not find an answer to your question here, please contact us
immediately -- we are committed to help you.
This help is comprehensive which means that everything you need to know about a particular option is
located in one section -- generally there is no need click on various links, then go back and so forth. This
also means that there may be two sections where some paragraphs are identical or almost identical. This
is absolutely normal and we assure you that these identical paragraphs are relevant to both sections where
you have found them.

1.1

Overview
AnyFileBackup v.4 is state of the art real-time backup and synchronization software. It is one of the
most customisable real-time backup and synchronization solutions in the market. At the same time it
remains easy to use and configure for users of almost any qualification and experience.
The scope of AnyFileBackup tasks includes real-time backup, replication, mirroring, bi-directional
(aka two-way) synchronization, monitoring, clean-up, and scheduled operations. All these backup,
synchronization, and other tasks support a wide range of Sources (that is what you backup) and
Targets (that is to where you backup):
local folders
local disks (HDD)
network (LAN) folders
network (LAN) disks (HDD)
NAS
FTP servers (UNIX/LINUX based or Windows-based)
SFTP servers (UNIX/LINUX based or Windows-based)
FTPS servers (UNIX/LINUX based or Windows-based)
FTP VMS servers
Amazon S3 clouds (including over SSL)
Mailboxes (both corporate and free public)
HTTP hosts
PING
System services
One of AnyFileBackup's distinctive features is Source to multiple Targets backup (aka One-2-Many or
1-to-Many replication). It distributes files from one location (folder, FTP, cloud, etc) to an unlimited
number of other locations. Which files goes to which Target can be manually defined so as the speed at
which files leave Source and at which they arrive to Target.
Three-level system of file filters allows to catch (or exclude, if needed) files with unprecedent precision.
Files are filtered by their origin (all, new, changed, deleted, etc.), by their name and extension (*.zip,
2014????_report.*, etc.), by their properties (exact or range: date, time, and size; attributes--hidden,
system, read only, compressed, archive, encrypted).
AnyFileBackup will constantly keep you informed on what it going on with your tasks. Backup
successfully completed? Remote FTP server is down? There is little disk space on your corporate server?
-- AnyFileBackup will notify you immediately by e-mail, SMS, LAN message.
Being able to operate in background as a system service or as an ordinary application, AnyFileBackup
does not require user logon or any kind of manual start up -- it automatically does everything for you at
the blink of an eye.
AnyFileBackup is 100% free to download, try, and evaluate. Support is provided to all users, whether
registered or not (registered users have priority in the waiting list).
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Getting Started
Topic Content
Sample Tasks
Creating Your First Task

AnyFileBackup is a powerful backup tool but it may also confuse with a verity of available options and
customizations. This section will help you to get familiar with AnyFileBackup and how it works.
We prepared a set of tasks that you may study to see how tasks may be configured. Some tasks may
be run without right now (they are marked with '[READY TO GO]' sign) -- they make some simple safe
operations and demonstrate AnyFileBackup in action.
We will also go with you through all steps of creating your first task with the New Task Assistant. It may
be easier to for just to follow our instructions for the first time. Next time you will certainly fell much more
confident but if not, please contact us -- we are committed to help you and will be glad to send you
comments and instructions accompanied by screenshots.

Sample Tasks
'Ready to
Go'

This type of tasks is ready to be launched almost on any computer. Please be rest
assured that they will make no harm to your system -- if there is any doubt, please read
the explanation of every task below or examine it yourself.
'Site Accessibility Monitoring': Checks whether www.any-file-backup.com is
accessible. Whether it is alive or not, you will see an appropriate confirmation
message.
'Free Disk Space Monitoring': Checks whether you have less than 100 GB of free disk
space on local drive C:. Whether it is there is more or less than 100 GB, you will see
an appropriate confirmation message.
'System Service Monitoring': Monitors whether Windows Update system service is
working. Whether it is working or not, you will see an appropriate confirmation
message.
'Local Files Back up': Copies cursor files (CUR) that have their filename starting with
'aero' (but excluding animated cursors with ANI extension) from C:\Windows\Cursors
to a new folder on desktop (will be created by AnyFileBackup automatically) that
bears the current date and words 'Backup by AnyFileBackup'. Files will be packed
into a single ZIP archive. If you launch this task several time, a new archive will have
a counter number (for example, '005_cursors.zip'). When copying is finished, you will
see a confirmation message and www.any-file-backup.com website will opened in
your default Internet browser.
'Folder Cleanup': Removes all files from C:\Windows\Temp\. When cleanup is
successful, you will see an appropriate confirmation message.

'Pure
samples'

This type of tasks is just examples of what kind of may be created. They do not work
because they are configured to only display AnyFileBacup functionality. Please do not
attempt to run them without changing their settings. For safety reasons their Activation
mode is set to Disabled to prevent accidental launches.
'One-to-Many Replication From FTP': Downloads FTP files to a local folder.
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'Email Attachments Replication': Downloads e-mail attachments to a local folder.
'Web Page Monitoring': Monitors download
webpage on www.any-file-backup.com for changes.

Creating Your First Task
Here we will provide a full guidance on how to set up a task. Start creating your first
task with pressing the 'Add New Task ' button on the Buttons Bar in the Main Window.
Task type

The first screen offers a choice of five types of tasks that can exist in AnyFileBackup.
Select 'Back up' and the Assistant will automatically bring you to next screen.

Location
(Source) of
files and (or)
folders

On this screen you need to decide on the type of Source which will be backed up.
Select the 'Folder' (includes local and LAN folders) and the Assistant will automatically
bring you to next screen.
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Source
properties

On this screen you need to enter local or LAN folder full path. Please type in the '
Source folder' field the location of AnyFileBackup settings folder, which is 'C:
\ProgramData\AnyFileBackupPro\' (without quotes).
You may either type it manually or select it from the standard dialogue by clicking on
the plus sign at the end of the 'Source folder' field.
We suggest not to include subfolders this time: select 'No' for the 'Include subfolders?'
option.
Press the 'Next' button at the at the bottom when you are ready to proceed.
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On this screen you can add actions that apply to every file that is being backed up. For
example, let's backup every files from AnyFileBackup settings folder to 'C:
\Users\[YOUR_USERNAME]\Desktop\${DATE}_Backup\'.
Replace
the
text
[YOUR_USERNAME] with your Windows login name.
To add a Target folder press on the green plus button at the bottom.
Press the 'Next' button at the at the bottom when you are ready to proceed.
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Do not modify other settings of this action. Press the 'Back ' button to return to the list.

Common
backup
properties

Leave the settings on this screen intact and press the 'Next' button to proceed.
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Primary File
Filter

Leave the settings on this screen intact and press the 'Next' button to proceed.

Further
actions

On this screen you can add actions that are performed after Backup has been
completed. For example, let's create a Computer message telling that AnyFileBackup
settings folder has been successfully backed up (see the screens below) with the
following settings:
Computer name: ${COMPNAME} (this macro will be automatically substituted with
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you computer network name).
Text: ${SOURCEPATH} backup was successfully completed at ${TIME} on ${DATE}.
Condition: Success (that means that in an unlikely event of backup failure, you will
see no message).
To add an action press on the green plus button at the bottom.
Press the 'Next' button at the at the bottom when you are ready to proceed.
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Press the 'Back ' button to return to the list.

Task start
parameters

On this screen you set schedule for your task. Please select the 'Manual' mode from
the drop-down list and then press the 'Next' button to proceed.
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Common
properties

This is the final screen of the New Task Assistant. If you wish, you may change task
name and define a group the task belongs to -- all these are optional.
When you are ready to proceed, press the 'Next' button to finish working with the New
Task Assistant.
Congratulations! You have successfully created your first AnyFileBackup task!
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Locate your task in the Default group and left-click on it to select it. Then press '
Activate Task ' button and then the 'Start Task Manually' button to start the task. The
task will start immediately and you will see a successful completion message when it
is completed.

Installation
Installation wizard will guide you through the installation process. During the installation you will be asked
to accept the licence agreement and select AnyFileBackup installation folder. Follow the instructions to
complete the installation.
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Trial Version Limitations
Trial version of AnyFileBackup (any edition) has the following limitations:
Task Processor stops every 8 hours and should be re-launched manually. This means that upon Task
Processor stop all task (both running and waiting) will be automatically deactivated (stopped) and each
task must be activated manually after Task Processor is re-launched; and
Automatic activation is disabled and does not work even if selected (it works in the Manual mode
instead); all tasks must be activated manually. This does NOT affect the way tasks start -- once
activated, tasks will start automatically according to the selected schedule; and
'Activate all task s' and 'Deactivate all task s' options are disabled.

1.5

Edition Comparison Chart
AnyFileBackup is delivered in three editions:
PRO: the most advanced edition designed for complex tasks
LAN: designed for tasks within a Local Area Network
FTP: designed for downloading files from FTP servers and their distribution across LAN or upload to the
cloud

AnyFilebackup

Features
LAN Edition

FTP Edition

PRO Edition

Sources and Targets
Local / LAN folders as
Source

-

Local / LAN folders as
Target
FTP / SFTP* / FTPS* as
Source

-

FTP / SFTP* / FTPS* as
Target

-

-

Amazon S3 as Source*

-

-

-

-

-

-

Mailbox as Source

-

-

Mailbox as Target

-

-

Amazon S3 as Target*
Google Drive as Source*
Google Drive as Target*
Microsoft OneDrive as
Source*
Microsoft OneDrive as
Target*

2015 AAR Innovations (R)

Introduction
HTTP Host as Source

-

-

HTTP Host as Target

-

-

AnyFileBackup Report
File as Source

-

-

Disk Space Monitoring
System Service
Monitoring
Event Log Monitoring*
Host (PING) Monitoring
Other Options
User access control and
restrictions

-

-

LAN notifications
E-mail notifications
SMS notifications*
* Extension may be required.

1.6

System Requirements
Minimum system requirements:
OS: Windows XP (SP3) / Vista (SP2) / 7 (SP1) / 8 / 8.1 / Server 2008 and 2012
Instruction set: x32-bit / x64-bit
Memory (RAM): 32 Mb
Disk (HDD) space: 20 Mb
CPU: Intel, AMD

2

Upgrading to v.4
In this section you can read about new features v.4 brings, how it looks, and what will happen to v.3.
Current users of the following products should read this section:
AnyFileBackup v.3.X.X
File Replication Monitor v.3.X.X
FTP Replication Monitor v.3.X.X
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What's New
AnyFileBackup v.4 has been developed by a dedicated team of professionals during two years and brings
you hundreds and thousands new features and improvements the major being:
Completely new table-style interface which makes understanding and configuring tasks easy and
intuitive. Those who used version 3 may find it helpful to read the dedicated section of this help that
describes the new interface.
AnyFileBackup Task Processor has been re-build increasing overall file transfer speed and stability.
Start up time has been increased several times.
The family of AnyFileBackup products now includes three editions: PRO, LAN, and FTP. The
comparison between the editions can be found in the dedicated section of this help.
Full compatibility with Windows 8 and 8.1.
Compression extension is now a part of the default free package.
Basic price has been reduced delivering a real value for money to our customers.
Packaged upgrades will be introduced shortly after version 4 release.

2.2

Interface
Topic Content
Main Window
Task Properties
Program Settings

This sections briefly describes the most important interface changes in AnyFileBackup version 4.
Interface in version 4 has been completely rebuilt to satisfy our most demanding users. We hope that
you find it easy to understand and convenient to use. Please contact us with any suggestions and
questions about the interface.

Main Window
Main window The main window, apart from the Buttons bar (see below), has not changed much from
version 3.
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This is a self-explanatory comparison between AnyFileBackup v.3 (top) and v.4 (bottom)
button bars:

Task Properties
Task properties have changed more than anything else since version 3. In this section
you can read a very brief overview of changes made to Task Properties. Detailed
information about Task Properties window can be found in the dedicated section of this
help.
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Navigation
tree

Navigation tree has remained essentially the same. It can be used to quickly switch
between tasks, program and extension settings.

Task
Scenario

Task Scenario is a new feature of AnyFileBackup v.4. It incorporates Source,
Operations, Targets and Actions, etc sections of version 3 task settings. It has become
one single list of operations that task performs making it easy and user-friendly to
configure any task.

Properties

Almost every action in the Task Scenario has its own unique properties. These
properties now are presented in table-style interface making it easy to navigate through
hundreds of settings. Most settings are split into relevant sections (displayed in bold
font).
We did our best to remove as much third-level windows as possible leaving only those
which are rarely used and non-essential.

Program Settings
Program Settings have not really change since version 3. They now also displayed
table-style interface and divided into sections but nothing else really changed.
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This is the only new section in Program Settings. It is dedicated specifically to
AnyFileBackup mode of operation: as an ordinary Windows application or as a
Windows system service. You can read more about Task Processor in the dedicated
section of this help.

Status of v.3
The latest stable release of AnyFileBackup v.3 is version 3.8.6.1. After AnyFileBackup PRO v.4 release
AnyFileBackup v.3 was discontinued and is no longer available for public download and purchase.
Registered users who have a valid licence to AnyFileBackup v.3 may request a download link to an
appropriate version 3 covered by their licence. When contacting us please specify:
an e-mail address that was used to purchase a licence, and
your full name that was used to purchase a licence, and
a version you want to download.

3

Main Window
Topic Content
Overview
Menu and Buttons
Task Groups
Task List
Event List and Program Status

From the Main window of AnyFileBackup you can view current AnyFileBackup activity, control tasks, and
access task and program settings.
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Overview
The Main Window consists of four main areas each of which is described below:
1: Menu and Buttons
2: Task Groups
3: Task List
4: Event List and Program Status

Menu and Buttons
Menu and buttons provide full control of AnyFileBackup and access to task properties, program and
extension settings, log reports.

The 'File'
menu

The 'File' menu has the following commands:
'Task Processor': grants access to AnyFileBackup Task Processor controls:
'Start as Service': launches the Task Processor in the System Service Mode. This
item is disabled if the Task Processor is not installed as a system service.
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'Start as Application': launches the Task Processor in the Application Mode.
'Stop': stops the Task Processor which automatically causes all tasks to stop as
well.
'Terminate': forcibly stops the Task Processor in an unlikely event when it does
not respond; this will automatically cause all tasks to stop as well.
'Settings': opens the Task Processor setting window.
'Reports': opens a Report Window from where you can create new and manage the
existing reports.
'Settings': opens the Program Settings window.
'Extensions': opens the Extension Settings window.
'Exit': AnyFileBackup will be shut down and you will be prompted whether you want
the Task Processor to be stopped (only when it works in the 'Application mode').
The 'Task '
menu

The 'Task ' menu has the following commands:
'Add Task ': opens New Task Assistant that will guide you through task set up.
'Activate': activates the selected task(s).
'Start Manually': immediately starts the selected task(s).
'Deactivate': deactivates the selected task(s).
'Activate All': activates all tasks.
'Deactivate All': deactivates all tasks.
'Properties': opens Task Properties window for the selected task.

The 'Window' The 'Window' menu has the following commands:
menu
'Show Group Panel': shows / hides the Task Group panel (area No.2 on the picture
above).
'Expand Event List': expands / collapses the Event List (area No.4 on the picture
above).
'Clear Event List': removes all records from the Event List.
'Minimize to Tray': minimizes AnyFileBackup window to system tray.
'Sort Task s by': sorts tasks in ascending or descending order by name, activation time,
recent start time, recent event type, next start time, progress achieved, or status.
The 'Help'
menu

The 'Help' menu has the following commands:
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'Topics': opens this help file.
'Licence': opens License.txt file located in AnyFileBackup installation folder.
'WWW Home Page': opens AnyFileBackup internet home page [ www.any-filebackup.com ].
'Order Product or Extension': opens AnyFileBackup internet order page [ www.anyfile-backup.com/order/ ] where you purchase a licence for AnyFileBackup and
Extensions.
'Contact': opens a sub-menu with two contact options:
'by E-mail': opens your default e-mail client in a message editing mode
'via Website Form': opens AnyFileBackup internet page with a contact form [
www.any-file-backup.com/contact/ ]
'Join Us on Facebook ': opens AnyFileBackup official Facebook page [ www.
facebook.com/anyfilebackup ] where you can read latest news, leave your comments,
and subscribe to news updates by liking our page.
'Follow Us on Twitter': opens AnyFileBackup official Twitter page [ www.twitter.com/
anyfilebackup ] where you can read latest news, tweet about your AnyFileBackup
experience, and subscribe to news updates by following our page.
'About': opens the About window where you can find version and edition information,
details of the current licence owner, and subscription status.

Buttons

The following buttons are located on the main bar of the Main Window:
'Add New Task ': opens New Task Assistant that will guide you through task set up.
'Task Properties': opens Task Properties window for the selected task.
'Activate Task ': activates the selected task(s).
'Deactivate Task ': deactivates the selected task(s).
'Start Task Manually': immediately starts the selected task(s).
'Create a Report': opens a Report Window from where you can create new and
manage the existing reports.
'Program Settings': opens the Program Settings window.
'Task Processor': grants access to AnyFileBackup Task Processor controls:
'Start as Service': launches the Task Processor in the System Service Mode. This
item is disabled if the Task Processor is not installed as a system service.
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'Start as Application': launches the Task Processor in the Application Mode.
'Stop': stops the Task Processor which automatically causes all tasks to stop as
well.
'Terminate': forcibly stops the Task Processor in an unlikely event when it does
not respond; this will automatically cause all tasks to stop as well.
'Settings': opens the Task Processor setting window.
'Minimize to Tray': minimizes AnyFileBackup window to system tray.

Task Groups
This is a list of task groups. 'All task s' and 'Default group' cannot be deleted. Groups can be managed
(created, deleted, renamed, coloured, etc.) from the Navigation Tree of the Task Properties window.

Task List
This is a list of task existing within the selected group. Active tasks have their icons shown in colour;
inactive tasks have their icons shown in grey.
Sorting

By default tasks are sorted by the time of their creation. By clicking on the top of each
column tasks may be sorted in ascending or descending order by:
name,
activation time,
recent start time,
recent event type,
next start time,
progress achieved, or
status.

Colours

Each task has the colour of its group. Group colour can be changed in the group's
settings accessible from the Navigation Tree of the Task Properties window.

Event List and Program Status
This is a chronological list of evens that occurred since AnyFileBackup start. Each event has its own
colour depending on its category (see below).
Event
categories

There are four types of even log events, each has its own colour:
'Yellow': a warning event, your action may be required.
'Red': a critical, error event requiring your immediate attention.
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'Green': an informational event related to a specific task's status or performance; no
action is generally required.
'Blue': an informational event related to the Task Processor or AnyFileBackup
generally; no action is required.
Event List
detail

It is possible to choose the categories of events that are displayed in the Event List.
This can be configured in the Program Settings.

Event List
length

It is possible to set the maximum number of entries stored in the Event List. When the
limit is reached, older entries will be deleted first. This can be configured in the Program
Settings.

Event List
controls

On the right-hand side there are three control buttons:
'Expand Event List': expands / collapses the Event List.
'Clear Event List': removes all records from the Event List.
'Copy to clipboard': copy the selected Event List entry to system clipboard; multiple
entries may be selected by holding 'Ctrl' or 'Shift' key on your keyboard.

Task
Processor
status

This indicator shows the Task Processor's current status:
'On-Line': Task Processor is working. To stop the Task Processor press the 'Task
Processor' button on the Button Bar and select the 'Stop' item to stop or, if it is not
responding, the 'Terminate' item to terminate it.
'Off-Line': Task Processor does not work. To start the Task Processor press the '
Task Processor' button on the Button Bar and select an appropriate item to start it
either in the Application Mode or in the System Service Mode.

Uptime
indicator

4

Time lapsed since the Task Processor's last start.

New Task Assistant
New Task Assistant is designed to guide you through task configuration process. It helps to set up the
most basic task settings as quickly as possible.
If you need to configure your task any further, please complete all steps of the New Task Assistant and
then open Task Properties (Right-click on task and then select the 'Properties' item).
Below is the summary of steps which must be passed in different modes to complete the New Task
Assistant:
Mode
Steps
Backup

Two-Way
Sync

Monitoring

Clean-up

Scheduled
Ops

Source Type

-

Source
Properties

-
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Source 2 Type

-

-

-

-

Source 2
Properties

-

-

-

-

Source 1 and 2
Common
Properties

-

-

-

-

Backup and
Related
Actions

-

-

-

-

Common
Backup
Properties

-

-

-

-

Primary File
Filter

-

Further Actions
Task Start
Parameters
Common
Properties

5

Task Properties
Task properties is the main area for configuring tasks and navigating between them. It is divided in three
main parts:
Navigation tree

Located on the left-hand side, it is primarily used to switch between tasks without
closing the Task properties window. At also helps to switch to Program Settings or
Extension Settings.
Being hidden by default, it can be opened by clicking on the
button (located in
the bottom left corner). It can be turned permanently visible by enabling the 'Always
show navigation tree' option in the Program Settings.
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'Add task ': opens New Task Assistant that will guide you through task set up.
'Delete task ': deletes the selected task. This cannot be undone.
'Duplicate task ': creates an exact copy of the selected task. A duplicated task
will have the same name as the original ending with the word 'Copy'.
'Move': opens a window where you can select a new position for the selected
task.
'Find': opens a dialogue that helps you to find a task with the specified text.
/
Task scenario

'Show / Hide navigation tree': opens / closes the Navigation tree.

Located in the middle of Task properties, it is the task structure: task will strictly
follow the sequence of actions from top to bottom (sometimes, when convenient, we
also call them 'steps') specified in the Task Scenario. For example, task will
activate first, then it will wait for a start event, then it will transfer files from Source
to Target(s) and so on.
The following actions are always present in every task:
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Activation
Start
Source (except for Scheduled Operations)
File operation: Backup, Two-Way Synchronization, Monitoring, or Clean-up
(except for Scheduled Operations)
The above actions are permanently fixed in Task scenario and cannot be moved up/
down and deleted. Note that Backup action can have sub-actions which are all
optional; however, if there is no Target within Backup action then no real file
operation will be possible.
In some modes certain actions may be unavailable. For example, in the Monitoring
mode it is only possible to send messages and execute actions.
All other actions are optional and can be added or removed when necessary. They
can also move across task scenario almost without restrictions except that:
Activation action is always first;
nothing can be placed: between Source and Backup actions, between Source
and Two-Way Synchronization actions, between Source and Monitoring actions,
and between Source and Clean-up actions;
Delete Empty Folders action always follows after the Backup action and nothing
can be placed between them.
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'Add action': opens a drop-down menu where you can select an action you
need. Some actions are not available in every mode: for example, the 'Back up to'
and 'Other' actions exist in the Backup mode only.
'Delete action': deletes the selected action. Note that some actions cannot be
deleted (see above).
'Duplicate action': creates an exact copy of the selected action. A duplicated
action will have the same name as the original ending with the word 'Copy'.
'Move action up': moves the selected action one level up.
'Move action down': moves the selected action one level down.
'Macro assistant': opens a window with Macro Assistant.
Properties

Located on the right-hand side, it is the place where properties of the selected
action are displayed.
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The following buttons control Task properties:
'Apply': saves all changes made; after saving no changes can be undone. Saving
changes requires task to be deactivated (you will be prompted to confirm that when
you press the 'Apply' or 'Close' button), so it is not advisable to make any changes
to task properties when task is actively performing file or other operations. After
changes have been saved, task may be activated again.
'Undo': removes all changes made in task properties and task scenario (this
includes moving actions up or down task scenario, actions removed will be restored
and actions added will be removed; but this does not include [1] changes made
inside the accounts and [2] task deletion).
'Close': exits task properties; if changes have not been saved, you will be
prompted to save or discard them.

5.1

Activation
Topic Content
Activation type
Activation delay
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Initial snapshot of Source
Error Handling
Miscellaneous

This option defines whether task is active or disabled and how task becomes active.

Activation type
A 'TRIAL MODE' heading reminds that AnyFileBackup works in a trial mode. In this mode the 'Automatic
activation' option is unavailable. When AnyFileBackup is registered, this reminder will be automatically
removed and the 'Automatic activation' will be fully functional.
Automatic

Task becomes active automatically, without user's intervention, on AnyFileBackup start
up, user log on, or service log on (depending on the selected Working Mode). This
mode is unavailable in TRIAL VERSION. Even if selected in Trial version,
AnyFileBackup will work in Manual mode instead.

Manual

Task is inactive by default but can be activated manually by pressing the 'Activate Task
' button in the main window.

Disabled

Task is permanently inactive and will never start. Task cannot be activated manually
from the main window. To allow task become active, change this option to 'Automatic'
or 'Manual'.

Activation delay, sec.
Task activates with a delay which ranges between 1 and 60 seconds. This option may be useful for those
who have many tasks which are activated contemporaneously or tasks which require extensive system
resources (for example, making a new snapshot of thousands of files located on LAN).
Example:
Tasks 1-20 activate with 10 seconds delay
Tasks 21-40 activate with 20 seconds delay
Tasks 41-80 activate with 30 seconds delay
Activation needs certain system resources because it may need to make a snapshot of Source. If many
tasks start simultaneously, system core and RAM may be loaded more than usual. By delaying
activation of certain tasks you may decrease the use of system resources and prioritise your tasks
without any disadvantage to your backup and synchronization.

Initial Snapshot of Source
A snapshot is a status (that is file lists and file properties like size, timestamp, CRC, etc.) of Source at
the time of task activation. AnyFileBackup needs to make a snapshot at least ones -- before the first
task start.
Making an initial or subsequent snapshot may take a considerable amount of time. While making a
snapshot, a start event may occur. In this situation AnyFileBackup will not start task but will make a
record that conditions for task start have been satisfied and will start task immediately after a snapshot
has been made.
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If a start event occurs more than once when a snapshot is being made (for example, task is set to start
every 2 minutes), AnyFileBackup will act in the same way (that is to start task immediately after a
snapshot has been made) -- but it will NOT queue these start attempts to start task a number of times
equivalent to start events that have occurred while a snapshot has been being made.
Make a new
snapshot

Snapshot is created every time task is activated (either automatically or manually). This
may require certain system resources. When many tasks activate simultaneously and
start creating their snapshots, system may be loaded more than usual. Please
consider using the 'Activation delay' option (see above) to prevent system overloading.
It is recommended to create a new snapshot every time task is activated. This will
ensure that only relevant files are transferred.
Example: task made an initial snapshot of Source, performed properly and then was
deactivated. Then (after task was deactivated) new files were added to Source. When
this task is activated again later it will not backup these new files unless the 'Mak e a
new snapshot' option is enabled. This is simply because task knows only about files
listed in its snapshot.

Use
previously
made
snapshot

Snapshot (created at first task activation) is used every time task is activated (either
automatically or manually).

Error Handling
This group of settings defines what happens when task has produced an error.
An 'error' is generally any misbehaviour in task performance. This may be, for example, a failure to copy
a file because a Target folder was inaccessible, or lack of disk space in Target, or failure to restart or
hibernate a computer after backup completion, or interruption of connection to FTP server.
On error

This option defines how AnyFileBackup responds to any errors. Three options are
available:
'Continue task execution': Task will continue to perform ignoring the error (in other
words, as if no error has occurred). An error notification will be sent by e-mail if Error
Notification settings are configured to send it.
'Interrupt task execution': Task will stop to execute waiting for the next scheduled
start as defined in the Start settings.
'Deactivate task ': Task will be deactivated and will never start unless activated
according to its Activation rules. It will activate either when AnyFileBackup
(application or system service) starts up / logs on or when task is activated manually.

Override
common
settings

When selected, this option allows to define custom (aka 'task-specific') error handling
settings (see below) overriding common error handling properties.

Task retry
count

Before AnyFileBackup proceeds according to the 'On error' rules (see above), it may
attempt to perform an action or a step, which caused the error, again. This option
defines a number of attempts to perform this faulty action / step. If the last attempt is
unsuccessful, AnyFileBackup will proceed according to the 'On error' rules.

Task retry
interval

This option defines an interval (in minutes) between attempts to perform a faulty action /
step. While waiting, task will not proceed but wait for the next attempt to perform such
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faulty action / step.

Miscellaneous
Advanced
options

Click the 'Edit' button to access task advanced options. These options are intended to
be used in those rare situations when task needs special treatment or does not perform
properly. We do not recommend to change or use any of these settings unless
absolutely necessary.
Task Maintenance
'Keep temporary files in': A location of task temporary files. This folder may be
located on any drive, including a drive other than AnyFileBackup installation drive.
Temporary files already present in the existing temporary files folder will be
automatically deleted.
'Default temporary folder location': Press the 'Restore' button to restore the default
temporary folder location. This will be 'C:\ProgramData\AnyFileBackup\Data\[Task ID]
\'.
'Temporary files': Press the 'Remove' button to permanently delete all task temporary
files located in the task temporary folder (see above). This will delete only those files
which are related to this particular task and located in the current temporary files
folder (not in any previous temporary files folder(s), if any). Temporary files related to
other tasks will be unaffected.
'Task priority': This option defines amount of system resources allocated to a
particular task. To preserve system stability, the default value is 'Lower', which is
generally enough for efficient performance of most tasks. This also ensures that
Windows (c) system has enough resources to perform other (both AnyFileBackup
and non-AnyFileBackup) tasks and operations. Higher values may cause increased
use of system resources affecting the overall performance of your computer. However,
this will also increase the speed and efficiency of a particular task.
File Options
'Apply scenario actions to': Actions (that include file transfer, messaging, delay, etc)
may be applied either to files only or to both files and folders.
Example: consider the following 'Back up' step of the task:

Outcome 1 -- Actions apply to files and folders: when any single folder has been copied
to (=created in) Target (yet before files have been copied), a delay of 60 seconds will
occur; the same will happen after each file has been copied.
Outcome 2 -- Actions apply to files only: copying of a folder to Target does not trigger
the delay; the 60 seconds delay will only occur after a file has been copied to Target.
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This is not to suggest that if actions apply to files only, then no folders will be copied to
Target -- quite the opposite: folders will be copied as usual. The only difference is that
they (folders) will not trigger any actions and will not be caught by any actions (will not
be listed separately in the list of copied items, etc).
We generally recommend to apply actions to both files and folders.
'Size of file copy buffer': This option defines the amount of system memory allocated
to a particular task. The higher the value is, the more efficient (quicker) the copying of
larger files.
'Check sum type': when Source is Folder (for the Backup mode) or when both
Sources are Folder (for the Two-Way Synchronisation mode), a file tracking by
checksum is available in the Primary Filter (for the Incremental, Mirroring, and TwoWay Synchronisation filter types). When tracking files by checksum, AnyFileBackup
calculates files' checksum. The FULL checksum calculation method, selected by
default, is the most precise way to compare files by checksum but may take
considerable time if file size is large or a number of files is significant. To speed up
checksum calculation, use the SMART checksum method, which calculates
checksum of the last kilobyte of each file instead of calculating checksum of the
entire file. The downside of this SMART method is that changes occurred in any part
of the file other than its last kilobyte will not be tracked. We generally recommend to
use the FULL check sum calculation method.
Task Information
'Task ID': This is a unique task identifier which is randomly generated and then
assigned to every task on its creation. It is read-only and cannot be changed. Task ID
may be used as a command line parameter, or in reporting (for creating a custom
report for specific task(s)).
'Task modified': A calendar date and time when any of the properties of this task has
been changed. This value changes automatically and cannot be changed manually.
'Task created': A calendar date and time when this task was created. This value
cannot be changed.

5.2

Start
Topic Content
First Start
Schedule Type
Holidays
Conditional Start

This option defines when task starts.

First Start
According to
selected
schedule
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Immediately
after task
activation

When activated (either automatically or manually), task immediately starts to perform
designated actions (that is file copying, monitoring, etc). Defined schedule is
overridden at this stage.
When task is completed (for example, when file copying has been finished), it will
enter into a 'sleep' state waiting for the next scheduled event (for example, 8.00 PM
next day) or another instance of deactivation-activation (whichever is the earliest).
Examples when this mode may be suitable include:
a computer (where AnyFileBackup is installed) restarts unexpectedly that raises
concerns about information safety and triggers backup / synchronization;
schedule type is set to 'Manual'.
Please also read how task starts when a snapshot of Source has to be made at the
Activation stage.

Schedule Type
Certain tasks require a considerable amount of time to complete. While task is being performed, a new
start event may occur. In this situation AnyFileBackup will continue performing task (it will not interrupt
task to start it again) but will remember that conditions for task start have been satisfied and will start
task immediately after it has completed the last action in the Task Scenario.
If a start event occurs more than once when performing task (for example, task is set to start every 2
minutes), AnyFileBackup will act in the same way (that is start task immediately after it has completed
the last action in the Task Scenario) -- it will NOT queue these start attempts to start task a number of
times equivalent to start events that have occurred when task has been performing.
Periodical

Task starts at regular intervals defined by user. The interval may be set in minutes,
hours, days, months, week days or any combination of these.
Example No.1:

That means that task will start every 2nd of August at 22.45.
Example No.2:

That means that task will start every Friday which is the 2nd day of a month (for
example, 2nd of August 2013 which was Fr):
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at 00.00, 00.15, 00.30, 00.45,
and then again at 04.00, 04.15, 04.30, 04.45,
and again at 08.00, 08.15 and so on.
'Advanced mode': this mode allows to use a UNIX style time format (CRON). All time
intervals need to be entered manually. For more details about advanced time format
see the CRON time format topic.
Example No.1 in CRON:

Example No.2 in CRON:

Daily

Task starts every week at particular time on selected day. Task may run several times
a day. Number а scheduled runs is unlimited.
Example:

To add a scheduled run do the following:
enter the time of the run,
select the days on which task will run at this time, and
press the 'Add' button.
A new line will appear at the table and the '+' (plus) symbol shows on which days of
the week task will start.
To delete a line, select it and press the 'Delete' button.
To remove all entries in the table, press the 'Clear' button.
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To undo all changes, press the 'Undo' button at the bottom right corner of the Task
Properties window.

Manual

Task starts only when you press the 'Start Task Manually' button at the Main Window.

Linked

Task starts when it receives a command from another AnyFileBackup task. Thus,
there may one so-called a 'Master task' which launches a 'Dependent task' (linked
task) depending on the circumstances.
If a linked tasks, when already being performed, receives a new start request from
another task, it will finish its current activity and will start again immediately after that
(in other words, it will remember this new start request).
Example: if Master Task fails, launch 'Dependent task_1'; if 'Master Task' partly
successful, launch 'Dependent task_2'.

Real Time

Task starts every time changes occur in Source (for example, when a new file has
been created). In this mode AnyFileBackup constantly monitors Source.
A delay between the changes and task start is 2 seconds minimum (999 seconds
maximum). This is to ensure that a new file is not blocked by other application. This
mainly happens if a large file is being downloaded or saved which normally takes
some time.
Limitations of this schedule type:
only suitable for local and LAN drives and folders (please make sure that your
network is reliable and stable),
only one Source folder is permitted (the first folder in the list will be used and any
other folders will be ignored),
changes in file attributes are not considered as a 'change' in Source (for example, a
file will not be copied if it has merely become read-only).

Holidays
This options specifies whether your current task will or will not run on holidays (sometimes known as
state holidays or bank holidays).
Status

The option can have three statuses:
'Disabled': the option is turned off and a task runs strictly according to the selected
schedule.
'Run task on holidays only': a task will run on a day that is a holiday day according
to the 'Preset' settings (see below). The task will never run on any other day
regardless any other settings. In other words, this option supersedes all other
schedule options blocking task start on non-holiday days.
'Never run task on holidays': this option is direct opposite to the 'Run task on
holidays only' option described above. If selected, a task will never run on holidays.

Preset

A pre-configured set of calendar dates which are treated as holiday days. Originally
they are grouped on a per country basis reflecting country-wide state holidays only
(regional and unofficial holidays and festivals are not covered).
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You may modify presets by adding or removing dates--press the 'Configure' button
below.
Properties

Press the 'Configure' button to access the holidays editor which consists of two parts:
'Custom presets': a list of user-defined presets with calendar dates that will be
treated as holiday days. Use the 'Holidays' menu above or right-click menu to add,
modify, or remove holidays.
'Presets': a list of countries with country-wide state holidays only (regional and
unofficial holidays and festivals are not covered). These presets cannot be deleted
on modified, but they can be duplicated and a copy of respective preset will appear
in the 'Custom presets' section (see above).

Conditional Start
Sometimes in addition to standard schedule rules it is necessary to make a task start conditional upon
existence (or non-existence) of some file or directory, or a value of system variable.
This option is designed to achieve this. If any condition (that is either A or B) is satisfied, task will start. If
there is no match at all (that is both conditions are not satisfied), task will not start. If any of the fields
left blank, then this condition is not considered by AnyFileBackup.
In other words, task will only start if and only if:
Schedule event (that is time, etc.) is satisfied, and
Condition A or Condition B is satisfied.
Condition A

The first condition is existence or non existence of a file or folder.
Examples:
C:\Users\Guest\Documents\report*.xlc exists
C:\Backup\Reports does not exist

Condition B

The second condition is the value of environment variable. An environment variable is a
value which may be used by both other AnyFileBackup tasks and third party software
for quick access to certain information (for example, a working path, a filename, Task
ID to start).
Environment variables may be viewed here:
Start > Run > type 'cmd' > type 'set' in the window that appeared (do not use quotes
when typing these commands)
Right-click on My Computer > Properties > Advanced system settings >
Environment variables:
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Source
Source is an object (or location) which is monitored, backed up, synchronized with, or otherwise
observed by AnyFileBackup. Source is a starting point for most tasks: for example, changes in Source
may trigger backup or synchronization, or trigger any other event.
Every task has its Source (except for Scheduled operations). There may be only one Source with various
Targets (save for Two-Way Synchronization where there are two Sources). When your Source is Folder,
then you can have various local and LAN folders in the Source list, not just one. Source cannot be
enabled or disabled -- it is always enabled because otherwise no task can work.
Target is the opposite to Source: it is where files are transferred to. There may be unlimited number of
Targets (except for Two-Way Synchronization mode where strictly speaking there are no targets but two
sources which are synchronized).
Simply speaking, Source is a 'From' location and Target is a 'To' location.
The table below summarises which Sources are available in different modes:

Mode
Source

Backup

Two-Way
Sync

Clean Up

Monitoring

Scheduled
Actions

Folder (local /
LAN)

not applicable

FTP

not applicable
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not applicable

Microsoft
OneDrive

-

not applicable

Google Drive

-

not applicable

Mailbox

-

-

AnyFileBackup
Report File

-

-

not applicable
-

not applicable

Ping

-

-

-

not applicable

Disk (HDD)
Space

-

-

-

not applicable

System Service

-

-

-

not applicable

System Event
Log

-

-

-

not applicable

Amazon S3
Topic Content
Amazon S3 Account
Subfolders
Primary File Filter
Additional File Filter
Miscellaneous

This option defines Source properties for Amazon's (c) cloud storage -- Amazon S3.

Amazon S3 Account
Bucket name

This is another name for a folder located in Amazon S3 cloud.

Security account Select a name of a pre-configured Amazon S3 account from the drop down list. If
name
there is none, or you need to create a new one, access Amazon S3 properties as
described below.
Account
properties

Click the 'Edit' button to access the Amazon S3 manager where you can create
and configure your Amazon S3 accounts. Detailed information about this can be
found here.

Use SSL

When enabled, SSL (Secure Sockets Layer) protocol is used to exchange data
with the selected cloud storage. SSL is a secured protocol that prevents
unauthorised access to information that is being transferred. It is recommended to
enable this option unless there are very strong reasons not to do so. Secure
Protocols extension is required to use this option.

Subfolders
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Include
subfolders?

Subfolder is any folder existing in Source (but not Source itself). For example, if
Source is 'C:\Folder\', then 'C:\Folder\Temp\' and 'C:\Folder\Temp1\ABC\' are its
subfolder. Select 'No' (uncheck the checkbox) if you do not want subfolders and
their content to be backed up, synchronized, monitored, etc.
If subfolders are not included, task is likely to perform quicker.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
; (semicolon): means a delimiter which is used to separate one path from
another; no space is necessary either before or after it
The below 'Included' and 'Excluded' subfolders options work complementary.
Example No.1:

Example No.2:

Included subfolders: C:\Folder\Temp1\

Included subfolders: C:\Folder\Temp1\

Excluded subfolders: none

Excluded subfolders: C:\Folder\Temp1
\ABC\

Only the '\Temp1\' subfolder with all its
content will be included.

Only the '\Temp1\' subfolder with all its
content (except the '\ABC\' subfolder)
will be included.

Example No.3:

Example No.4:

Included subfolders: none

Included subfolders: *,C:\Folder\Temp1
\ABC\

Excluded subfolders: C:\Folder\Temp1\
Excluded subfolders: C:\Folder\Temp1\
All subfolders with all their content will
be included except the '\Temp1\' All subfolders (including the '\Temp1
subfolder.
\ABC\') with all their content will be
included except the '\Temp1\' subfolder
and its other subfolder. The asterix ('*')
symbol is necessary to include all
subfolders other than '\Temp1\ABC\'.
Included
subfolders

A list of subfolders which you want to include within the scope of task. The full path
to a subfolder is necessary.
By pressing the button at the end of the field you will open a subfolder manager.
There you may add, remove, and rearrange subfolders. You can also export and
import your subfolder lists.
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'Add subfolder': opens a folder selection window that helps to select a desired
subfolder.
'Replace subfolder': opens a folder selection window that helps to select a
desired subfolder that will replace the selected subfolder entry.
'Delete subfolder': deletes the selected subfolder from the list.
'Move up': moves the selected subfolder entry one line up the list.
'Move down': moves the selected subfolder entry one line down the list.
'Sort': sorts subfolders in the alphabetical order.
'Import subfolder list': allows to load a subfolder list from a file. The file must
have a TXT format with one subfolder path per line. No separators are necessary.
'Export subfolder list': allows to export the current subfolder list into a file. The
file with will be in a TXT format with one subfolder path per line without separators
between.
If no sobfolders are specified, all subfolders (and equally subfolders of these
subfolders and so forth) will be included. There is no need to use the asterix ('*')
sign unless you use a combination of the 'Included' and 'Excluded' subfolders
options (as demonstrated in the Example No.4 above).
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Excluded
subfolders

A list the subfolders which you do not want to include within the scope of task. It
works opposite to the 'Included subfolders' option above. Everything else is the
same.

Primary File Filter
Primary File Filter is the first among three filters that are available in AnyFileBackup. It is applied first,
before any other filter. This filter distinguishes files by their origin (combination depends on the selected
filter type):
'All': files of any origin are within task's scope. In other words, no filter is applied.
'New': a file that has appeared in (created in, copied to, etc.) Source after the most recent Source
snapshot is within task's scope. Note, that if a file has been renamed, it is also considered as 'new'
even though no other changes have happened to this file.
'Non-existent': a file that exists in Source but does not exist in Target is within task's scope. This is
different from 'New' because Source might have remained unchanged, but certain files might have been
deleted in Target. In this case these deleted files will be restored in Target by transferring them from
Source.
'Deleted': this is opposite to 'New'. A file that disappears (deleted, etc.) from Source is within task's
scope and will also be deleted from Target. Note, that as with 'New', if a file has been renamed, it is
also considered as 'deleted' even though no other changes have happened to this file.
'Changed': a file whose parameters have changed is within task's scope. The relevant parameters are:
- filename (not displayed and cannot be removed)
- timestamp
- size
Current filter

Displays the name of selected filter. To select another filter click on the button at
the end of the field and choose an appropriate filter.

Additional File Filter
Additional File Filter distinguishes files by mask.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension
; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it
Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
files being excluded.
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Example No.2:

Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'
and has a 'docx' extension will be included)
Files that will be included: file_01-01-2012.
docx, file120101.docx, file1Jan2012.docx

Included files: file??????.docx (that means
that any file that has its filename starting with a
word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
Included files

A list of file masks that describe files to be included in the scope of task.

Excluded files

A list of file masks that describe files to be excluded from the scope of task.

Miscellaneous

5.3.2

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

AnyFileBackup Report File
Topic Content
AnyFileBackup Report File
Miscellaneous

This option defines Source properties for AnyFileBackup report file which may be generated and
transferred to a specified Target.
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AnyFileBackup Report File
Report name

A name of AnyFileBackup report that will be generated and transferred to
Target. If you want to create a new report, please use the Report Manger (
Reporting extension is required to create customizable reports).

Report properties

Click the 'Edit' button to access the Report Manager. You can read how to
use the Report Manager and create customizable reports here.

Miscellaneous

5.3.3

Output report format

The format of AnyFileBackup report file that will be transferred to Target.
Currently two formats are supported: plain text (TXT) and HTML (HyperText
Markup Language).

Report file delimiter

A character separating fields in the report file generated in plain text format.
This field is not used when HTML format is selected.

Title

This is a custom name that will be displayed in the Task Scenario instead of
the default title. Press the 'Apply' button for changes to take effect.

Disk (HDD) Space
Topic Content
General
Miscellaneous

This option defines Source properties for a hard disk drive (HDD) which is being monitored for free or
occupied disk space.

General
Root folder

This is a letter assigned to a logical HDD followed by a colon or a folder path.
An actual ('physical') HDD may be divided into various logical ('virtual') HDDs.
If so divided, to monitor the entire actual HDD you need to create several
tasks. The letter is not case sensitive.
Example: C: or X: or C:\Data\

Connect through

'--': you connect to a Root folder directly.
'Remote account': access to a Root folder requires a remote computer
address, username, and password. Please read below how to select,
access, and configure your account on a remote computer.

Account name

If you connect to a root folder located on a remote computer, here you may
select your pre-configured remote account. If there is none, or you need to
create a new one, access remote account properties as described below.

Account properties

Click the 'Edit' button to access the Remote Accounts manager where you
can create and configure your remote accounts. Detailed information about
this can be found here.

Monitoring parameter

HDD space which is being monitored by AnyFileBackup:
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Free space: when free space in a Root folder is less than the specified
amount, AnyFilebackup will execute specified actions.
Occupied space: when occupied space in a Root folder exceeds the
specified amount, AnyFilebackup will execute specified actions.
Size

Amount of disk space Megabytes (a round figure without decile) those
fluctuations may trigger specified actions (as described above).

Miscellaneous
Title

5.3.4

This is a custom name that will be displayed in the Task Scenario instead of
the default title. Press the 'Apply' button for changes to take effect.

Folder (local / LAN)
Topic Content
General
Subfolders
Primary File Filter
Additional File Filter
Extended File Filter
Transfer Options
File Options
Miscellaneous

This option defines Source properties for local area network (LAN) and local folders.

General
Source folder
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A path to a local or LAN folder(s). Multiple folders must be separated by a
semicolon (';') symbol, no space is required. By pressing the button at the end of
the field you will open a Source folders manager. There you may add, remove, and
rearrange Source folders. You can also export and import your Source folder lists.
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'Add Source folder': opens a folder selection window that helps to select a
desired Source folder.
'Replace Source folder': opens a folder selection window that helps to select a
desired Source folder that will replace the selected Source folder entry.
'Delete Source folder': deletes the selected Source folder from the list.
'Move up': moves the selected Source folder entry one line up the list.
'Move down': moves the selected Source folder entry one line down the list.
'Sort': sorts Source folders in the alphabetical order.
'Import Source folder list': allows to load a Source folder list from a file. The file
must have a TXT format with one Source folder path per line. No separators are
necessary.
'Export Source folder list': allows to export the current Source folder list into a
file. The file with will be in a TXT format with one Source folder path per line without
separators between.
Connect through

'--': you connect to a Source folder directly.
'Remote account': access to a Source folder requires a remote computer
address, username, and password. Please read below how to select, access,
and configure your account on a remote computer.
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Account name

If you connect to a Source folder located on a remote computer, here you may
select your pre-configured remote account. If there is none, or you need to create a
new one, access remote account properties as described below.

Account
properties

Click the 'Edit' button to access the Remote Accounts manager where you can
create and configure your remote accounts. Detailed information about this can be
found here.

Subfolders
Include
subfolders?

Subfolder is any folder existing in Source (but not Source itself). For example, if
Source is 'C:\Folder\', then 'C:\Folder\Temp\' and 'C:\Folder\Temp1\ABC\' are its
subfolder. Select 'No' (uncheck the checkbox) if you do not want subfolders and
their content to be backed up, synchronized, monitored, etc.
If subfolders are not included, task is likely to perform quicker.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
; (semicolon): means a delimiter which is used to separate one path from
another; no space is necessary either before or after it
The below 'Included' and 'Excluded' subfolders options work complementary.
Example No.1:

Example No.2:

Included subfolders: C:\Folder\Temp1\

Included subfolders: C:\Folder\Temp1\

Excluded subfolders: none

Excluded subfolders: C:\Folder\Temp1
\ABC\

Only the '\Temp1\' subfolder with all its
content will be included.

Only the '\Temp1\' subfolder with all its
content (except the '\ABC\' subfolder)
will be included.

Example No.3:

Example No.4:

Included subfolders: none

Included subfolders: *,C:\Folder\Temp1
\ABC\

Excluded subfolders: C:\Folder\Temp1\
Excluded subfolders: C:\Folder\Temp1\
All subfolders with all their content will
be included except the '\Temp1\' All subfolders (including the '\Temp1
subfolder.
\ABC\') with all their content will be
included except the '\Temp1\' subfolder
and its other subfolder. The asterix ('*')
symbol is necessary to include all
subfolders other than '\Temp1\ABC\'.
Included
subfolders
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A list of subfolders which you want to include within the scope of task. The full path
to a subfolder is necessary.
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By pressing the button at the end of the field you will open a subfolder manager.
There you may add, remove, and rearrange subfolders. You can also export and
import your subfolder lists.

'Add subfolder': opens a folder selection window that helps to select a desired
subfolder.
'Replace subfolder': opens a folder selection window that helps to select a
desired subfolder that will replace the selected subfolder entry.
'Delete subfolder': deletes the selected subfolder from the list.
'Move up': moves the selected subfolder entry one line up the list.
'Move down': moves the selected subfolder entry one line down the list.
'Sort': sorts subfolders in the alphabetical order.
'Import subfolder list': allows to load a subfolder list from a file. The file must
have a TXT format with one subfolder path per line. No separators are necessary.
'Export subfolder list': allows to export the current subfolder list into a file. The
file with will be in a TXT format with one subfolder path per line without separators
between.
If no sobfolders are specified, all subfolders (and equally subfolders of these
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subfolders and so forth) will be included. There is no need to use the asterix ('*')
sign unless you use a combination of the 'Included' and 'Excluded' subfolders
options (as demonstrated in the Example No.4 above).
Excluded
subfolders

A list the subfolders which you do not want to include within the scope of task. It
works opposite to the 'Included subfolders' option above. Everything else is the
same.

Skip empty
folders

If enabled, a subfolder will not be transferred to Target or monitored, cleaned up,
etc. A subfolder is considered 'empty' if there are no files that can be transferred by
task. In other words, this criteria is task-specific that means that some files may be
actually there, but if none of them are within task's filters then it will be treated as
'empty'.
This also means that the same subfolder may be treated as 'empty' by one task but
as 'not empty' by another task. All depends on task filtering properties.
Example:
Subfolder content: readme.txt, video.avi
Skip empty folders: Yes
Additional File Filter -- Included files: *.docx
Outcome: subfolder will be treated as 'empty' and will not be transferred to Target.
This is because this subfolder does not contain DOCX files.

Primary File Filter
Primary File Filter is the first among three filters that are available in AnyFileBackup. It is applied first,
before any other filter. This filter distinguishes files by their origin (combination depends on the selected
filter type):
'All': files of any origin are within task's scope. In other words, no filter is applied.
'New': a file that has appeared in (created in, copied to, etc.) Source after the most recent Source
snapshot is within task's scope. Note, that if a file has been renamed, it is also considered as 'new'
even though no other changes have happened to this file.
'Non-existent': a file that exists in Source but does not exist in Target is within task's scope. This is
different from 'New' because Source might have remained unchanged, but certain files might have been
deleted in Target. In this case these deleted files will be restored in Target by transferring them from
Source.
'Deleted': this is opposite to 'New'. A file that disappears (deleted, etc.) from Source is within task's
scope and will also be deleted from Target. Note, that as with 'New', if a file has been renamed, it is
also considered as 'deleted' even though no other changes have happened to this file.
'Changed': a file whose parameters have changed is within task's scope. The relevant parameters are:
- filename (not displayed and cannot be removed)
- timestamp
- size
- attributes (System, Read only, Compressed, Hidden, Archive, Encrypted) [only if available: FAT32
does not support Compressed and Encrypted]
- checksum (it is possible to configure the checksum type in 'Activation' > 'Advanced Options'
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increasing the checksum speed calculation; not available when 'Start' > 'Schedule type' is 'Real
time')
- NTFS permissions (full control, modify, read and execute, read, write, special permission) [only if
available]
Current filter

Displays the name of selected filter. To select another filter click on the button at
the end of the field and choose an appropriate filter.

Additional File Filter
Additional File Filter distinguishes files by mask.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension
; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it
Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
files being excluded.

Example No.1:
Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'
and has a 'docx' extension will be included)
Files that will be included: file_01-01-2012.
docx, file120101.docx, file1Jan2012.docx

Example No.2:
Included files: file??????.docx (that means
that any file that has its filename starting with a
word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
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file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
Included files

A list of file masks that describe files to be included in the scope of task.

Excluded files

A list of file masks that describe files to be excluded from the scope of task.

Extended File Filter
Extended File Filter represents a set of additional parameters that allow to fine tune your file selection by
carefully choosing their characteristics. This is the third stage of file filtering: it is applied to all files that
have not been previously filtered out by the Primary File Filter and the Additional File Filter. It cannot be
applied in relation to some (not all) of these files only.
This filter works only as 'inclusive' filter (except to file attributes that may be either included or excluded).
That means that files that fall within its net are included and all other files are excluded.
The below table represents a brief summary of this filter.
File characteristics

Value 1

Value 2 (if applicable)

File date

Older than
Not older than

Minute(s)
Hour(s)
Day(s)
Week(s)
Month(s) (always equal to 30
calendar days)
Year(s) (always equal to 365
calendar days)

File date between

[Any calendar date 1]

[Any calendar date 2]
May be equal or later than the
calendar date 1. If equal, then
file created / changed on that
particular date only will be
included.

File time between

[Any time 1]

[Any time 2]
May be equal or later than the
time 1. If equal, then file created
/ changed on that particular time
only will be included (including
seconds).

File size

Less than
Equal
Greater than

Byte(s)
Kilobyte(s)
Megabyte(s)
Gigabyte(s)

Include only files with attributes

System
Read only
Compressed
Hidden

not applicable
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Archive
Encrypted
Skip files with attributes (these
files will be excluded)

System
Read only
Compressed
Hidden
Archive
Encrypted

not applicable

Enable extended If enabled, the Extended File Filter will be active and apply to all files that are
filter
processed by AnyFileBackup within this Source.
Extended filter
properties

Press the 'Configure' button to access the Extended File Filter properties.

Transfer Options
This group of options defines outgoing file transfer options for Source. That is how all files are being
distributed from Source. Analogues incoming transfer options may be set for each individual Target and
may differ from that set up for Source.
Maximum
transfer speed

This is the maximum outgoing speed of file transfer from Source set in bytes per
second. When left blank, the speed is unlimited. You can also configure incoming
speed of file transfer to any individual Target in the Target settings.

If file is in use or
locked

This is a more straight forward name for VSS (Volume Shadow Copy). It defines
AnyFileBackup behaviour when it cannot access file because it is in use or locked
by other software or by any other reason.
These settings override task error handling behaviour.
The following options are available:
'Treat as error': the whole situation is treated as an ordinary error and task follows
task error handling rules.
'Sk ip file and continue': locked file, or file that is in use, is not transferred and
task continues as usual; this is not treated as error.
'Copy file snapshot': this options only works on 32 bit operating systems.
AnyFileBackup creates a snapshot of file and that snapshot is transferred to
Target; this is not treated as error.

File Options
Files in Source may have certain properties like NTFS permissions and file attributes. These properties
may be or may be not inherited when these files are transferred to Target(s). This group of options
defines which properties will be inherited by Target files from their Source originals.
Please note, that FTP supports neither of these properties and FAT/FAT32 does not support NTFS
permissions. Therefore, Target FTPs and folders with FAT/FAT32 file system will not inherit respective
properties.
Copy NTFS
permissions

NTFS permissions are special rights of file access set by either by a computer
administrator or Windows system itself for other users. These are full control,
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modify, read and execute, read, write, special permission.
If any of these parameters are set at Source (they must be located at a hard drive
with NTFS file system) and may be preserved by Target (in other words, Target hard
drive supports NTFS file system), then these permissions will be transferred if the
checkbox is checked.
Administrator's rights may be required to set NTFS permissions at Target.
Copy file
attributes

If a file in Source has the following attributes (see below), an identical file in Target
will have exactly the same attributes (all of them):
'Hidden'
'Read only'
'System'

Reset 'Archive'
attribute

'Archive' attribute is automatically set for each file that is created in or copied to a
folder. It indicates that it is ready for backup by Windows (c) Backup.
When file with an 'Archive' attribute is being backed up by AnyFileBackup, this
attribute may be removed by AnyFileBackup after successful backup to indicate
that this file no longer needs backup up.

Miscellaneous
Notify if Source
is inaccessible

If AnyFileBackup cannot read the Source's content for whatever reason (e.g.,
Source does not exist, access to Source is blocked by a firewall policies, etc),
AnyFileBackup can notify you about this error by e-mail.
Notification settings can be set up in 'Program Settings' > 'Error Handling'.

Title

5.3.5

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

FTP
Topic Content
FTP Account
Subfolders
Primary Filter
Additional File Filter
Extended File Filter
Transfer Options
Miscellaneous

This option defines Source properties for FTP (file transport protocol) servers and folders.

FTP Account
Account name
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described below.

Account
properties

Click the 'Edit' button to access the FTP Accounts manager where you can create
and configure your FTP accounts. Detailed information about this can be found here
.

Source folder

a name of the FTP server directory, where Source files are located.
That should be a full path from the server's root but excluding the FTP server
address.
Example: /FTP/IN/DATA/
A note on VMS FTP servers:
Notation: AnyFileBackup recognises whether a remote server runs VMS and
automatically converts UNIX/Linux notation into appropriate VMS notation.
Therefore, you must use usual UNIX/Linux notation for pointing to the remote
directory ('/FTP/IN/DATA/') instead of VMS notation ('[FTP.IN.DATA]').
Passive mode: use FTP passive mode when connecting to a VMS-based FTP
server.

Subfolders
Include
subfolders?

Subfolder is any folder existing in Source (but not Source itself). For example, if
Source is 'C:\Folder\', then 'C:\Folder\Temp\' and 'C:\Folder\Temp1\ABC\' are its
subfolder. Select 'No' (uncheck the checkbox) if you do not want subfolders and
their content to be backed up, synchronized, monitored, etc.
If subfolders are not included, task is likely to perform quicker.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
; (semicolon): means a delimiter which is used to separate one path from
another; no space is necessary either before or after it
The below 'Included' and 'Excluded' subfolders options work complementary.
Example No.1:

Example No.2:

Included subfolders: C:\Folder\Temp1\

Included subfolders: C:\Folder\Temp1\

Excluded subfolders: none

Excluded subfolders: C:\Folder\Temp1
\ABC\

Only the '\Temp1\' subfolder with all its
content will be included.

Example No.3:

Only the '\Temp1\' subfolder with all its
content (except the '\ABC\' subfolder)
will be included.
Example No.4:
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Included subfolders: *,C:\Folder\Temp1
\ABC\

Excluded subfolders: C:\Folder\Temp1\
Excluded subfolders: C:\Folder\Temp1\
All subfolders with all their content will
be included except the '\Temp1\' All subfolders (including the '\Temp1
subfolder.
\ABC\') with all their content will be
included except the '\Temp1\' subfolder
and its other subfolder. The asterix ('*')
symbol is necessary to include all
subfolders other than '\Temp1\ABC\'.
Included
subfolders

A list of subfolders which you want to include within the scope of task. The full path
to a subfolder is necessary.
By pressing the button at the end of the field you will open a subfolder manager.
There you may add, remove, and rearrange subfolders. You can also export and
import your subfolder lists.

'Add subfolder': opens a folder selection window that helps to select a desired
subfolder.
'Replace subfolder': opens a folder selection window that helps to select a
desired subfolder that will replace the selected subfolder entry.
'Delete subfolder': deletes the selected subfolder from the list.
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'Move up': moves the selected subfolder entry one line up the list.
'Move down': moves the selected subfolder entry one line down the list.
'Sort': sorts subfolders in the alphabetical order.
'Import subfolder list': allows to load a subfolder list from a file. The file must
have a TXT format with one subfolder path per line. No separators are necessary.
'Export subfolder list': allows to export the current subfolder list into a file. The
file with will be in a TXT format with one subfolder path per line without separators
between.
If no sobfolders are specified, all subfolders (and equally subfolders of these
subfolders and so forth) will be included. There is no need to use the asterix ('*')
sign unless you use a combination of the 'Included' and 'Excluded' subfolders
options (as demonstrated in the Example No.4 above).

Excluded
subfolders

A list the subfolders which you do not want to include within the scope of task. It
works opposite to the 'Included subfolders' option above. Everything else is the
same.

Primary File Filter
Primary File Filter is the first among three filters that are available in AnyFileBackup. It is applied first,
before any other filter. This filter distinguishes files by their origin (combination depends on the selected
filter type):
'All': files of any origin are within task's scope. In other words, no filter is applied.
'New': a file that has appeared in (created in, copied to, etc.) Source after the most recent Source
snapshot is within task's scope. Note, that if a file has been renamed, it is also considered as 'new'
even though no other changes have happened to this file.
'Non-existent': a file that exists in Source but does not exist in Target is within task's scope. This is
different from 'New' because Source might have remained unchanged, but certain files might have been
deleted in Target. In this case these deleted files will be restored in Target by transferring them from
Source.
'Deleted': this is opposite to 'New'. A file that disappears (deleted, etc.) from Source is within task's
scope and will also be deleted from Target. Note, that as with 'New', if a file has been renamed, it is
also considered as 'deleted' even though no other changes have happened to this file.
'Changed': a file whose parameters have changed is within task's scope. The relevant parameters are:
- filename (not displayed and cannot be removed)
- timestamp
- size
Current filter

Displays the name of selected filter. To select another filter click on the button at
the end of the field and choose an appropriate filter.

Additional File Filter
Additional File Filter distinguishes files by mask.
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The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension
; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it
Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
files being excluded.

Example No.1:

Example No.2:

Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'
and has a 'docx' extension will be included)
Files that will be included: file_01-01-2012.
docx, file120101.docx, file1Jan2012.docx

Included files: file??????.docx (that means
that any file that has its filename starting with a
word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
Included files

A list of file masks that describe files to be included in the scope of task.

Excluded files

A list of file masks that describe files to be excluded from the scope of task.

Extended File Filter
Extended File Filter represents a set of additional parameters that allow to fine tune your file selection by
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carefully choosing their characteristics. This is the third stage of file filtering: it is applied to all files that
have not been previously filtered out by the Primary File Filter and the Additional File Filter. It cannot be
applied in relation to some (not all) of these files only.
This filter works only as 'inclusive' filter (except to file attributes that may be either included or excluded).
That means that files that fall within its net are included and all other files are excluded.
The below table represents a brief summary of this filter.
File characteristics

Value 1

Value 2 (if applicable)

File date

Older than
Not older than

Minute(s)
Hour(s)
Day(s)
Week(s)
Month(s) (always equal to 30
calendar days)
Year(s) (always equal to 365
calendar days)

File date between

[Any calendar date 1]

[Any calendar date 2]
May be equal or later than the
calendar date 1. If equal, then
file created / changed on that
particular date only will be
included.

File time between

[Any time 1]

[Any time 2]
May be equal or later than the
time 1. If equal, then file created
/ changed on that particular time
only will be included (including
seconds).

File size

Less than
Equal
Greater than

Byte(s)
Kilobyte(s)
Megabyte(s)
Gigabyte(s)

Enable extended If enabled, the Extended File Filter will be active and apply to all files that are
filter
processed by AnyFileBackup within this Source.
Extended filter
properties

Press the 'Configure' button to access the Extended File Filter properties.

Transfer Options
This group of options defines outgoing file transfer options for Source. That is how all files are being
distributed from Source. Analogues incoming transfer options may be set for each individual Target and
may differ from that set up for Source.
Skip locked or
inaccessible
files

When enabled, AnyFileBackup will skip files that cannot be accessed for whatever
reason. These files will be marked as not copied and AnyFileBackup will attempt to
transfer them during the next scheduled task execution.
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When disabled, the whole situation will be considered as an error. What will happen
next depends on default and task-specific Error handling rules. The task will either:
continue execution (the default setting), or
stop until the next scheduled start, or
deactivate until the next Task Processor restart or manual task activation.
This option is incompatible with the following:
Two-Way Synchronization mode, and
Differential mode of the Primary File Filter.
Use FTP
compression
(MODE Z)

When enabled, activates compression of any traffic transmitted between
AnyFileBackup and FTP server. This reduces overall file transfer time.

Maximum
transfer speed

This is the maximum outgoing speed of file transfer from Source set in bytes per
second. When left blank, the speed is unlimited. You can also configure incoming
speed of file transfer to any individual Target in the Target settings.

Miscellaneous
Notify if server is
inaccessible

If AnyFileBackup cannot read the Source's content for whatever reason (e.g.,
Source does not exist, access to Source is blocked by a firewall policies, etc),
AnyFileBackup can notify you about this error by e-mail.
Notification settings can be set up in 'Program Settings' > 'Error Handling'.

5.3.6

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Google Drive
Topic Content
Google Drive Account
Subfolders
Primary File Filter
Additional File Filter
Miscellaneous

This option defines Source properties for Google's (c) cloud storage -- Google Drive.

Google Drive Account
Source folder
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Account name

Select a name of a pre-configured Google Drive account from the drop down list. If
there is none, or you need to create a new one, access Google Drive properties as
described below.

Account
properties

Click the 'Edit' button to access the Google Drive manager where you can create
and configure your Google Drive accounts. Detailed information about this can be
found here.

Subfolders
Include
subfolders?

Subfolder is any folder existing in Source (but not Source itself). For example, if
Source is 'C:\Folder\', then 'C:\Folder\Temp\' and 'C:\Folder\Temp1\ABC\' are its
subfolder. Select 'No' (uncheck the checkbox) if you do not want subfolders and
their content to be backed up, synchronized, monitored, etc.
If subfolders are not included, task is likely to perform quicker.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
; (semicolon): means a delimiter which is used to separate one path from
another; no space is necessary either before or after it
The below 'Included' and 'Excluded' subfolders options work complementary.
Example No.1:

Example No.2:

Included subfolders: C:\Folder\Temp1\

Included subfolders: C:\Folder\Temp1\

Excluded subfolders: none

Excluded subfolders: C:\Folder\Temp1
\ABC\

Only the '\Temp1\' subfolder with all its
content will be included.

Only the '\Temp1\' subfolder with all its
content (except the '\ABC\' subfolder)
will be included.

Example No.3:

Example No.4:

Included subfolders: none

Included subfolders: *,C:\Folder\Temp1
\ABC\

Excluded subfolders: C:\Folder\Temp1\
Excluded subfolders: C:\Folder\Temp1\
All subfolders with all their content will
be included except the '\Temp1\' All subfolders (including the '\Temp1
subfolder.
\ABC\') with all their content will be
included except the '\Temp1\' subfolder
and its other subfolder. The asterix ('*')
symbol is necessary to include all
subfolders other than '\Temp1\ABC\'.
Included
subfolders

A list of subfolders which you want to include within the scope of task. The full path
to a subfolder is necessary.
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By pressing the button at the end of the field you will open a subfolder manager.
There you may add, remove, and rearrange subfolders. You can also export and
import your subfolder lists.

'Add subfolder': opens a folder selection window that helps to select a desired
subfolder.
'Replace subfolder': opens a folder selection window that helps to select a
desired subfolder that will replace the selected subfolder entry.
'Delete subfolder': deletes the selected subfolder from the list.
'Move up': moves the selected subfolder entry one line up the list.
'Move down': moves the selected subfolder entry one line down the list.
'Sort': sorts subfolders in the alphabetical order.
'Import subfolder list': allows to load a subfolder list from a file. The file must
have a TXT format with one subfolder path per line. No separators are necessary.
'Export subfolder list': allows to export the current subfolder list into a file. The
file with will be in a TXT format with one subfolder path per line without separators
between.
If no sobfolders are specified, all subfolders (and equally subfolders of these
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subfolders and so forth) will be included. There is no need to use the asterix ('*')
sign unless you use a combination of the 'Included' and 'Excluded' subfolders
options (as demonstrated in the Example No.4 above).

Excluded
subfolders

A list the subfolders which you do not want to include within the scope of task. It
works opposite to the 'Included subfolders' option above. Everything else is the
same.

Primary File Filter
Primary File Filter is the first among three filters that are available in AnyFileBackup. It is applied first,
before any other filter. This filter distinguishes files by their origin (combination depends on the selected
filter type):
'All': files of any origin are within task's scope. In other words, no filter is applied.
'New': a file that has appeared in (created in, copied to, etc.) Source after the most recent Source
snapshot is within task's scope. Note, that if a file has been renamed, it is also considered as 'new'
even though no other changes have happened to this file.
'Non-existent': a file that exists in Source but does not exist in Target is within task's scope. This is
different from 'New' because Source might have remained unchanged, but certain files might have been
deleted in Target. In this case these deleted files will be restored in Target by transferring them from
Source.
'Deleted': this is opposite to 'New'. A file that disappears (deleted, etc.) from Source is within task's
scope and will also be deleted from Target. Note, that as with 'New', if a file has been renamed, it is
also considered as 'deleted' even though no other changes have happened to this file.
'Changed': a file whose parameters have changed is within task's scope. The relevant parameters are:
- filename (not displayed and cannot be removed)
- timestamp
- size
Current filter

Displays the name of selected filter. To select another filter click on the button at
the end of the field and choose an appropriate filter.

Additional File Filter
Additional File Filter distinguishes files by mask.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension
; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it
Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
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files being excluded.

Example No.1:

Example No.2:

Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'
and has a 'docx' extension will be included)
Files that will be included: file_01-01-2012.
docx, file120101.docx, file1Jan2012.docx

Included files: file??????.docx (that means
that any file that has its filename starting with a
word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
Included files

A list of file masks that describe files to be included in the scope of task.

Excluded files

A list of file masks that describe files to be excluded from the scope of task.

Miscellaneous

5.3.7

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

HTTP
Topic Content
HTTP Account
Primary File Filter
Additional File Filter
Miscellaneous
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This option defines Source properties for HTTP (Hypertext Transfer Protocol) pages and files.

HTTP Account
Account name

Select a name of a pre-configured HTTP account from the drop down list. If there is
none, or you need to create a new one, access HTTP account properties as
described below.

Account
properties

Click the 'Edit' button to access the HTTP Accounts manager where you can create
and configure your HTTP accounts. Detailed information about this can be found
here.

Primary File Filter
Primary File Filter is the first among three filters that are available in AnyFileBackup. It is applied first,
before any other filter. This filter distinguishes files by their origin (combination depends on the selected
filter type):
'All': files of any origin are within task's scope. In other words, no filter is applied.
'New': a file that has appeared in (created in, copied to, etc.) Source after the most recent Source
snapshot is within task's scope. Note, that if a file has been renamed, it is also considered as 'new'
even though no other changes have happened to this file.
'Non-existent': a file that exists in Source but does not exist in Target is within task's scope. This is
different from 'New' because Source might have remained unchanged, but certain files might have been
deleted in Target. In this case these deleted files will be restored in Target by transferring them from
Source.
'Deleted': this is opposite to 'New'. A file that disappears (deleted, etc.) from Source is within task's
scope and will also be deleted from Target. Note, that as with 'New', if a file has been renamed, it is
also considered as 'deleted' even though no other changes have happened to this file.
'Changed': a file whose parameters have changed is within task's scope. The relevant parameters are:
- filename (not displayed and cannot be removed)
- size
- checksum [only if available] (Not available when 'Start' > 'Schedule type' is 'Real time')
Current filter

Displays the name of selected filter. To select another filter click on the button at
the end of the field and choose an appropriate filter.

Additional File Filter
Additional File Filter distinguishes files by mask.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension

2015 AAR Innovations (R)

Task Properties

67

; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it
Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
files being excluded.

Example No.1:

Example No.2:

Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'
and has a 'docx' extension will be included)
Files that will be included: file_01-01-2012.
docx, file120101.docx, file1Jan2012.docx

Included files: file??????.docx (that means
that any file that has its filename starting with a
word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
Page of file
name

The name of a page or file on a website (Source). If the name is not specified, the
default site document is returned by the website.

Local file name

The name of a page or file in Target. Leave blank if you want to keep the original
filename.

Miscellaneous
Notify if Source
is inaccessible

If AnyFileBackup cannot read the Source's content for whatever reason (e.g.,
Source does not exist, access to Source is blocked by a firewall policies, etc),
AnyFileBackup can notify you about this error by e-mail.
Notification settings can be set up in 'Program Settings' > 'Error Handling'.

Verify settings
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This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Title

5.3.8

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Mailbox
Topic Content
Incoming E-mail Server Account
Primary File Filter
Look for E-mails with the Following Content
Miscellaneous

This option defines Source properties for a mailbox (also known as an e-mail account) located on server
or web.

Incoming E-mail Server Account
Account name

Select a name of a pre-configured E-mail server account from the drop down
list. If there is none, or you need to create a new one, access E-mail account
properties as described below.

Account properties

Click the 'Edit' button to access the Incoming E-mail Accounts manager
where you can create and configure your e-mail accounts. Detailed
information about this can be found here.

Primary File Filter
Introduction

Due to the nature of the mailbox, only all and new files can be covered. Other
types the Primary File Filter are not supported.

Current filter

Displays the name of selected filter. To select another filter click on the button
at the end of the field and choose an appropriate filter.

Look for E-mails with the Following Content
This filter is an e-mail equivalent of the Additional File Filter. Operators and wildcards (asterix ('*') and
question mark ('?') only) can be used in this filed. You may read more about this here.
This filter works only as 'inclusive' filter. That means that e-mail that fall within its net are included and all
other e-mails are excluded.
Header name

One of the following headers of e-mail correspondence may be monitored for a
specified content:
'From' field: e-mail address and, if any, a name of the sender is normally
contained here.
'Subject' field: the subject matter of e-mail correspondence is normally
described here.
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'To' field: e-mail address and, if any, a name of the recipient is normally
contained here. Sometimes all recipients are listed in a carbon copy (CC)
or even a blind carbon copy (BCC) field. In this case such e-mail will not be
caught by this filter.
Contains

Words and phrases specified in this field will be searched for in the selected
header. Text is case sensitive.

Miscellaneous

5.3.9

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this
action. This will verify whether all above settings were entered correctly; all
errors, if any, will be displayed in a log window.

Title

This is a custom name that will be displayed in the Task Scenario instead of
the default title. Press the 'Apply' button for changes to take effect.

Microsoft OneDrive
Topic Content
OneDrive Account
Subfolders
Primary File Filter
Additional File Filter
Miscellaneous

This option defines Source properties for Microsoft's (c) cloud storage -- OneDrive.

OneDrive Account
Source folder

A name of a folder located in OneDrive cloud.

Account name

Select a name of a pre-configured OneDrive account from the drop down list. If there
is none, or you need to create a new one, access OneDrive properties as described
below.

Account
properties

Click the 'Edit' button to access the OneDrive manager where you can create and
configure your OneDrive accounts. Detailed information about this can be found
here.

Subfolders
Include
subfolders?

Subfolder is any folder existing in Source (but not Source itself). For example, if
Source is 'C:\Folder\', then 'C:\Folder\Temp\' and 'C:\Folder\Temp1\ABC\' are its
subfolder. Select 'No' (uncheck the checkbox) if you do not want subfolders and
their content to be backed up, synchronized, monitored, etc.
If subfolders are not included, task is likely to perform quicker.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
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? (question mark): means ANY SINGLE ONE symbol
; (semicolon): means a delimiter which is used to separate one path from
another; no space is necessary either before or after it
The below 'Included' and 'Excluded' subfolders options work complementary.
Example No.1:

Example No.2:

Included subfolders: C:\Folder\Temp1\

Included subfolders: C:\Folder\Temp1\

Excluded subfolders: none

Excluded subfolders: C:\Folder\Temp1
\ABC\

Only the '\Temp1\' subfolder with all its
content will be included.

Only the '\Temp1\' subfolder with all its
content (except the '\ABC\' subfolder)
will be included.

Example No.3:

Example No.4:

Included subfolders: none

Included subfolders: *,C:\Folder\Temp1
\ABC\

Excluded subfolders: C:\Folder\Temp1\
Excluded subfolders: C:\Folder\Temp1\
All subfolders with all their content will
be included except the '\Temp1\' All subfolders (including the '\Temp1
subfolder.
\ABC\') with all their content will be
included except the '\Temp1\' subfolder
and its other subfolder. The asterix ('*')
symbol is necessary to include all
subfolders other than '\Temp1\ABC\'.
Included
subfolders

A list of subfolders which you want to include within the scope of task. The full path
to a subfolder is necessary.
By pressing the button at the end of the field you will open a subfolder manager.
There you may add, remove, and rearrange subfolders. You can also export and
import your subfolder lists.
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'Add subfolder': opens a folder selection window that helps to select a desired
subfolder.
'Replace subfolder': opens a folder selection window that helps to select a
desired subfolder that will replace the selected subfolder entry.
'Delete subfolder': deletes the selected subfolder from the list.
'Move up': moves the selected subfolder entry one line up the list.
'Move down': moves the selected subfolder entry one line down the list.
'Sort': sorts subfolders in the alphabetical order.
'Import subfolder list': allows to load a subfolder list from a file. The file must
have a TXT format with one subfolder path per line. No separators are necessary.
'Export subfolder list': allows to export the current subfolder list into a file. The
file with will be in a TXT format with one subfolder path per line without separators
between.
If no sobfolders are specified, all subfolders (and equally subfolders of these
subfolders and so forth) will be included. There is no need to use the asterix ('*')
sign unless you use a combination of the 'Included' and 'Excluded' subfolders
options (as demonstrated in the Example No.4 above).
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Excluded
subfolders

A list the subfolders which you do not want to include within the scope of task. It
works opposite to the 'Included subfolders' option above. Everything else is the
same.

Primary File Filter
Primary File Filter is the first among three filters that are available in AnyFileBackup. It is applied first,
before any other filter. This filter distinguishes files by their origin (combination depends on the selected
filter type):
'All': files of any origin are within task's scope. In other words, no filter is applied.
'New': a file that has appeared in (created in, copied to, etc.) Source after the most recent Source
snapshot is within task's scope. Note, that if a file has been renamed, it is also considered as 'new'
even though no other changes have happened to this file.
'Non-existent': a file that exists in Source but does not exist in Target is within task's scope. This is
different from 'New' because Source might have remained unchanged, but certain files might have been
deleted in Target. In this case these deleted files will be restored in Target by transferring them from
Source.
'Deleted': this is opposite to 'New'. A file that disappears (deleted, etc.) from Source is within task's
scope and will also be deleted from Target. Note, that as with 'New', if a file has been renamed, it is
also considered as 'deleted' even though no other changes have happened to this file.
'Changed': a file whose parameters have changed is within task's scope. The relevant parameters are:
- filename (not displayed and cannot be removed)
- timestamp
- size
Current filter

Displays the name of selected filter. To select another filter click on the button at
the end of the field and choose an appropriate filter.

Additional File Filter
Additional File Filter distinguishes files by mask.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension
; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it
Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
files being excluded.
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Example No.2:

Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'
and has a 'docx' extension will be included)
Files that will be included: file_01-01-2012.
docx, file120101.docx, file1Jan2012.docx

Included files: file??????.docx (that means
that any file that has its filename starting with a
word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
Included files

A list of file masks that describe files to be included in the scope of task.

Excluded files

A list of file masks that describe files to be excluded from the scope of task.

Miscellaneous
Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

5.3.10 Ping
Topic Content
PING Account
Miscellaneous

This option defines Source properties for a remote server which is being monitored by sending ping
requests.
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PING Account
Account name

Select a name of a pre-defined remote server address from the drop down list.
If there is none, or you need to create a new one, access server account
properties as described below.

Account properties

Click the 'Edit' button to access the PING (ICMP) Accounts manager where
you can create and configure your remote server address. Detailed information
about this can be found here.

Miscellaneous
Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this
action. This will verify whether all above settings were entered correctly; all
errors, if any, will be displayed in a log window.

Title

This is a custom name that will be displayed in the Task Scenario instead of
the default title. Press the 'Apply' button for changes to take effect.

5.3.11 System Service
Topic Content
System Service
Miscellaneous

This option defines Source properties for a system service.

System Service
Service name

A name of a system service that is being monitored. To select a different
system service, please use a drop down list and scroll up or down as may be
necessary.

Service list

If a desired system service is not present in the system service list mentioned
above, it may be because it has started recently and has not been added to
the list. To update the list, click the 'Refresh' button.

Connect through

'--': you connect to a system service directly.
'Remote account': access to a system service requires a remote computer
address, username, and password. Please read below how to select,
access, and configure your account on a remote computer.

Account name

If you connect to a system service located on a remote computer, here you
may select your pre-configured remote account. If there is none, or you need
to create a new one, access remote account properties as described below.

Account properties

Click the 'Edit' button to access the Remote Accounts manager where you
can create and configure your remote accounts. Detailed information about
this can be found here.

Miscellaneous
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This is a custom name that will be displayed in the Task Scenario instead of
the default title. Press the 'Apply' button for changes to take effect.

5.3.12 Windows Event Log
Topic Content
System Event Log
Event Level
Event Parameter
Miscellaneous

This option defines Source properties for Windows Event Log.

System Event Log
Log name

A name of a log in Windows Event Log that is being monitored. To select a
different log, please use a drop down list and scroll up or down as may be
necessary.

Log list

If a desired log is not present in Windows Event Log list mentioned above,
click the 'Refresh' button to update the list.

Connect through

'--': you connect to a system event log directly.
'Remote account': access to a system event log requires a remote
computer address, username, and password. Please read below how to
select, access, and configure your account on a remote computer.

Account name

If you connect to a log in Windows Event Log located on a remote computer,
here you may select your pre-configured remote account. If there is none, or
you need to create a new one, access remote account properties as
described below.

Account properties

Click the 'Edit' button to access the Remote Accounts manager where you
can create and configure your remote accounts. Detailed information about
this can be found here.

Event Level
This is the category of events to be monitored. They are known as 'Levels' in Windows 7 / 8 and as
'Types' in Windows XP.
Error

Indicates an existence of a serious problem that might affect functionality of
the application that triggered the event and that is external to that application.

Warning

Indicates an existence of an issue that can affect the stability of some
application(s) or the system generally if no prompt action is taken.

Information

Indicates that some change has occurred and serves for information
purposes. No action is generally required.

Audit success

Indicates that a user has successfully exercised his or her right.

Audit failure

Indicates that a user has been unsuccessful in exercising his or her right.
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Event Parameter
Type

Each Windows Even Log event has certain fields with parameters each of
which can be monitored. The following fields are supported:
'ANY': means that AnyFileBackup will search for the selected value (see
below) in the Event ID, Task Category, and Source fields of a Windows
Even Log event.
'EVENTID': means the Event ID field of a Windows Even Log event.
'TASKCATEGORY': means the Task Category field of a Windows Even Log
event.
'SOURCE': means the Source field of a Windows Even Log event.

Value

The value of the parameter selected above. AnyFileBackup will search for this
value and notify when the relevant one is noticed.
If this filed is blank, it will be considered by AnyFileBackup as 'any value' that
is just another way to say that event parameter will be disregarded for filtering
purposes: if a system event falls within the defined event level, then it will be
reported.

Miscellaneous
Title

5.4

This is a custom name that will be displayed in the Task Scenario instead of
the default title. Press the 'Apply' button for changes to take effect.

Backup
Topic Content
General
Unconditional Renaming of Files Transferred to Target
Conflict Resolution Rules

This option defines properties for File Transfer -- a key stage of Backup mode. During this stage files are
being copied or moved from Source to Target(s) and other defined actions are performed.
File Transfer has certain sub-events (Targets and Actions) which reflect how File Transfer actually works.
In brief, every sub-event within File Transfer happens to every file that is within the task scope. This may
be illustrated by the following example.
Example: consider the following situation

Source content

Task Scenario Settings
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The order in which AnyFileBackup will proceed
1. Copy 'document.doc' to \\server\Backup\
2. Send SMS message that 'document.doc' has been copied
3. Pause copying for 60 seconds
4. Copy 'readme.txt' to \\server\Backup\
5. Send SMS message that 'readme.txt' has been copied
6. Pause copying for 60 seconds
7. Copy 'video.avi' to \\server\Backup\
8. Send SMS message that 'video.avi' has been copied
9. Pause copying for 60 seconds
10.Proceed to the next step (that is sending a LAN message to admin about copying status)

General
This group of settings defines the basics of file transfers between Source and Target locations. Proper
configuration of this settings is essential for successful backup and synchronization.
File operation

This is the way files are being transferred from Source to Target location.
Three options are possible:
'Copy files from Source to Target': files that are being transferred from
Source to Target will be created in Target and will also remain in Source.
'Move files from Source to Target': files that are being transferred from
Source to Target will be created in Target and them will be removed from
Source.
'Virtual mode': this is a test mode which is designed to test whether files
can be transferred between Source and Target locations. In reality no files
are actually transferred to Target but AnyFileBackup imitates copying
checking that Source and Target exist, that sufficient permissions are in
place to permit file transfers, etc. However, other actions (for example,
sending e-mails, etc.) will be performed in a usual ('real') manner. It is
recommended to use this mode if you need to test a connection,
permissions, etc.

Copy order

This is the order of priority in which files are transferred to Target. The
following options are available:
'Any': files are copied in a random order.
'By name (A ... Z)': files are copied in a usual alphabetical order with files
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starting with letter 'A' first and so forth.
'By name (Z ... A)': files are copied in a reverse alphabetical order with files
starting with letter 'Z' first and so forth.
'Older files first': files are copied in an order of creation (determined by date
and time) with files that have been created earlier in time first and so forth.
Files created exactly in the same time will be copied in alphabetical order.
Example: files created in 2005 first, then files created in 2009, and finally
followed by files created in 2014.
'Newer files first': files are copied in an order of creation (determined by date
and time) with files that have been created later in time first and so forth.
Files created exactly in the same time will be copied in alphabetical order.
Example: files created in 2014 first, then files created in 2009, and finally
followed by files created in 2005.
'Smaller files first': files are copied in a order their size increase with files
that have the smallest size first and so forth. Files with exactly the same
size will be copied in alphabetical order.
'Larger files first': files are copied in a order their size decrease with files
that have the largest size first and so forth. Files with exactly the same size
will be copied in alphabetical order.

Unconditional Renaming of Files Transferred to Target
This group of settings configures the rules for renaming files that are backed up to all Targets. This
renaming happens when the 'Match pattern' fits the Source file's name and, consequently, in Target this
file will have a different name, that matches the 'Replace pattern' settings.
This option utilizes powerful 'regular expressions'. Good explanation and examples of usage can be found
at this Wikipedia page: https://en.wikipedia.org/wiki/Regular_expression#Examples
Enabled

If enabled, the Unconditional Renaming will be active and apply to all files that
are transferred by AnyFileBackup to all Targets (but if, and only if, the file
name matches the 'Match pattern' settings; if there is no match, then no
renaming will be made).

Match pattern

An expression (aka 'mask') that is used to define which filenames or part(s) of
filenames are to be renamed when they are transferred to Targets, so in
Targets these files will have new names as set by the 'Replacement pattern'
rules.

Replace pattern

An expression (aka 'mask') that is used to define a new filename for a Target
file.

Conflict Resolution Rules
This group of settings defines what happens to a file in a Target location if a file with the same name is
being transferred to that Target location from a Source location.
If target file exists

This defines what will happen to any file in Target if a file with exactly the
same name is being transferred to that Target location from a Source location.
The following options are available:
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'Replace always': a file in Target will always be replaced with a file from
Source.
'Replace older file': if a file in Target is older (determined by date and time)
than a file from Source that is being transferred to Target, then this file in
Target will be replaced (deleted) with the newer file from Source. In other
words, a newer file from Source always replaces an older file in Target.
'Rename': one of the files that conflict can be renamed according to the
rules explained immediately below.
'Append': new content of a Source file is added to the end of a Target file.
This may mode is compatible with Folder (local / LAN) and FTP only.
'Update changed parts': This option must be used with caution. First,
Source file and Target file are compared. Secondly, if any part of the Source
file is different from a corresponding part of the Target file, this part part is
replaced in the Target file.
The following is essential when you consider using the 'Update changed
parts' mode:
-- a Target file does not exist: a Source file will be transferred to Target in
full;
-- a Target file is longer than a Source file: the Target file will be truncated
(that means that certain changed parts will be cut out as appropriate);
-- Source files and AnyFileBackup are located on different computers: this
may significantly increase file transfer time and it is recommended to use
this mode only when Source files and AnyFileBackup are located on the
same computer;
-- Source files are large: this may significantly increase file transfer time
and it is suggested to consider other mode.
'Sk ip copying': a file from Source will not be copied to Target if there is a file
with identical name.
Some of these rules are not compatible with certain Targets, namely:
HTTP: 'Rename', 'Sk ip copying', 'Replace older file', 'Append', and 'Update
changed parts' are not supported.
Cloud: 'Rename' (for 'File in Target' option only), 'Append', and 'Update
changed parts' are not supported.
E-mail: 'Conflict resolution rules' are not supported.
File to rename

This option activates when the 'Rename' option is selected in the 'If target file
exists' field above. The following files may be renamed:
'File from Source': file that is being transferred from Source will be renamed.
'File in Target': file that exists in Target will be renamed.

Rename template
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Amazon S3
Topic Content
Cloud Account
Additional File Filter
Modify Files Before Transfer to This Target
Miscellaneous

This option defines Target properties for Amazon's (c) cloud storage -- Amazon S3.

Cloud Account
Bucket name

This is another name for a folder located in Amazon S3 cloud.

Security account Select a name of a pre-configured Amazon S3 account from the drop down list. If
name
there is none, or you need to create a new one, access Amazon S3 properties as
described below.
Account
properties

Click the 'Edit' button to access the Amazon S3 manager where you can create
and configure your Amazon S3 accounts. Detailed information about this can be
found here.

Use SSL

When enabled, SSL (Secure Sockets Layer) protocol is used to exchange data
with the selected cloud storage. SSL is a secured protocol that prevents
unauthorised access to information that is being transferred. It is recommended to
enable this option unless there are very strong reasons not to do so. Secure
Protocols extension is required to use this option.

Additional File Filter
Additional File Filter distinguishes files by mask.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension
; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it
Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
files being excluded.

Example No.1:
Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'

Example No.2:
Included files: file??????.docx (that means
that any file that has its filename starting with a
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word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
Included files

A list of file masks that describe files to be transferred to this particular Target.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, no files will be transferred to this Target.

Excluded files

A list of file masks that describe files not to be transferred to this particular Target.

Modify Files Before Transfer to This Target
This option (previously known as 'Pre-processing') applies to all files before they are transferred to this
Target.
The underlying idea is that files may be transferred to some Targets as usual (without any modifications:
compression, encryption, etc), and to other Targets (for which this option is enabled) in compressed and
(or) encrypted form. Equally, if files are already compressed and (or) encrypted, they may be
uncompressed and (or) decrypted before being transferred to Target(s).
File modification may take additional time when large files or significant number of files are processed.
Modification type A type of modification that is applied to each file before it is transferred to Target.
The following options are available:
'Compress': compress each file reducing its size using ZIP compression
algorithm. Compression options can be configured in the Modification options
window (described below). File Compression extension is required to use this
option.
'Uncompress': extract each file from an archive using ZIP compression algorithm.
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It has no options. File Compression extension is required to use this option.
'Encrypt': encrypt each file using an encryption algorithm and password selected
in the Modification options window (described below). File Encryption extension
is required to use this option.
'Decrypt': decrypt each file using an encryption algorithm and password selected
in the Modification options window (described below). File Encryption extension
is required to use this option.
'Compress and encrypt': this option combines the compression and encryption
functions. First, AnyFileBackup compresses a file using ZIP algorithm and then,
secondly, encrypts the compressed file with a supported encryption algorithm.
Additional compression and encryption options can be configured in the
Modification options window (described below). File Compression and File
Encryption extensions are required to use this option
'Decrypt and uncompressed': performs decryption and uncompression operations
in a manner described in the 'Compress and encrypt' option above but in a reverse
order.

Modification
options

Click the 'Configure' button to access the Modification Options.
Encryption / Decryption Options
'Encryption type': An encryption method that is used to encrypt or decrypt files.
The following types are currently available: AES, Blowfish, DES, PGP, TripleDES, and ZIP.
'Account name': A name of a pre-configured account that contains a password
(for AES, Blowfish, DES, Triple-DES, and ZIP encryption types) or a PGP key
with password (for a PGP encryption type).
'Account properties': Opens a properties window for the selected account. If no
account is selected, the Account Manager window that fits the selected
encryption type will be opened.
Compression Options
'Store paths':
'--' (=none): file will be archived 'as is', without any folders;
'Relative': file will be archived with folder where it is located;
'Full': file will be archived with full path (but excluding drive and server
names).
'Mak e timestamp of archive and file the same': if enabled, an archive will have
timestamp identical to that of a file inside of it.
'To a single archive': if enabled, all files that are within task's scope will be
packed into a single archive file. The archive's filename can be set in the 'Archive
name' field below.
'Archive name': a name of a single archive into which all Source files are packed.
If left blank, the default template will be used which is ${DATE=yyyy.mm.dd}_${
TIME=hh-nn-ss} and the resulting archive filename will look like
'2014.05.25_10.30.00.zip'. You may use both macros and other symbols to
define the archive name.
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Miscellaneous
Create download
URLs

AnyFileBackup can create a direct URL to each file to enable other users to directly
download this file. When created, this URL can be distributed to other users via email, computer message or otherwise. URLs may distributed individually (one URL
per e-mail using ${AMAZON_S3_FILEURL} macro) or collectively (using ${
AMAZON_S3_URLS} macro). You can read about Macro string here.

URL validity time If URLs were generated, they may cease to be valid after a defined period of time
(full hours without decile). If this filed left blank, then a default value is automatically
set to 1 hour. The maximum permitted value is 10 000 hours.

5.4.2

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

E-mail
Topic Content
Recipients
Outgoing E-mail Server Account
Additional File Filter
Modify Files Before Transfer to This Target
Message
Miscellaneous

This option defines Target properties for a mailbox (also known as an e-mail account) located on server or
web.

Recipients
Recipient list

Select a name or multiple names of pre-configured Recipient List(s) by checking
appropriate items. If there is none, or you need to create a new one, access
Recipient List account properties as described below.

Account
properities

Click the 'Configure' button to access the Recipient List manager where you can
create and configure your recipient lists. Detailed information about this can be
found here.

Outgoing E-mail Server Account
Account name
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Account
properties

Click the 'Configure' button to access the Outgoing E-mail Accounts manager
where you can create and configure your e-mail accounts. Detailed information
about this can be found here.

Additional File Filter
Additional File Filter distinguishes files by mask.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension
; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it
Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
files being excluded.

Example No.1:
Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'
and has a 'docx' extension will be included)
Files that will be included: file_01-01-2012.
docx, file120101.docx, file1Jan2012.docx

Example No.2:
Included files: file??????.docx (that means
that any file that has its filename starting with a
word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
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A list of file masks that describe files to be transferred to this particular Target.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, no files will be transferred to this Target.

Excluded files

A list of file masks that describe files not to be transferred to this particular Target.

Modify Files Before Transfer to This Target
This option (previously known as 'Pre-processing') applies to all files before they are transferred to this
Target.
The underlying idea is that files may be transferred to some Targets as usual (without any modifications:
compression, encryption, etc), and to other Targets (for which this option is enabled) in compressed and
(or) encrypted form. Equally, if files are already compressed and (or) encrypted, they may be
uncompressed and (or) decrypted before being transferred to Target(s).
File modification may take additional time when large files or significant number of files are processed.
Modification type A type of modification that is applied to each file before it is transferred to Target.
The following options are available:
'Compress': compress each file reducing its size using ZIP compression
algorithm. Compression options can be configured in the Modification options
window (described below). File Compression extension is required to use this
option.
'Uncompress': extract each file from an archive using ZIP compression algorithm.
It has no options. File Compression extension is required to use this option.
'Encrypt': encrypt each file using an encryption algorithm and password selected
in the Modification options window (described below). File Encryption extension
is required to use this option.
'Decrypt': decrypt each file using an encryption algorithm and password selected
in the Modification options window (described below). File Encryption extension
is required to use this option.
'Compress and encrypt': this option combines the compression and encryption
functions. First, AnyFileBackup compresses a file using ZIP algorithm and then,
secondly, encrypts the compressed file with a supported encryption algorithm.
Additional compression and encryption options can be configured in the
Modification options window (described below). File Compression and File
Encryption extensions are required to use this option
'Decrypt and uncompressed': performs decryption and uncompression operations
in a manner described in the 'Compress and encrypt' option above but in a reverse
order.
Modification
options

Click the 'Configure' button to access the Modification Options.
Encryption / Decryption Options
'Encryption type': An encryption method that is used to encrypt or decrypt files.
The following types are currently available: AES, Blowfish, DES, PGP, Triple-
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DES, and ZIP.
'Account name': A name of a pre-configured account that contains a password
(for AES, Blowfish, DES, Triple-DES, and ZIP encryption types) or a PGP key
with password (for a PGP encryption type).
'Account properties': Opens a properties window for the selected account. If no
account is selected, the Account Manager window that fits the selected
encryption type will be opened.
Compression Options
'Store paths':
'--' (=none): file will be archived 'as is', without any folders;
'Relative': file will be archived with folder where it is located;
'Full': file will be archived with full path (but excluding drive and server
names).
'Mak e timestamp of archive and file the same': if enabled, an archive will have
timestamp identical to that of a file inside of it.
'To a single archive': if enabled, all files that are within task's scope will be
packed into a single archive file. The archive's filename can be set in the 'Archive
name' field below.
'Archive name': a name of a single archive into which all Source files are packed.
If left blank, the default template will be used which is ${DATE=yyyy.mm.dd}_${
TIME=hh-nn-ss} and the resulting archive filename will look like
'2014.05.25_10.30.00.zip'. You may use both macros and other symbols to
define the archive name.

Message
This group of options allows to set custom values for subject and text fields of e-mails. These values are
'custom' because they override the default values set in the Recipient List and apply to this Target only. If
any of these fields left blank, the values from the Recipient List will be used.
Subject

The subject matter of the e-mail. You may use Macro strings in this field.

Text

The body of the e-mail. You may use Macro strings in this field.

Miscellaneous
Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.
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Folder (local / LAN)
Topic Content
General
Additional File Filter
Modify Files Before Transfer to This Target
Transfer Options
File Options
Miscellaneous

This option defines Target properties for local area network (LAN) and local folders.

General
Target folder

A path to a local or LAN folder.

Modify Target
path

When AnyFileBackup transfers Source files to Target, it does not create a Source
folder itself in Target. However, this may be changed. A simple example will
illustrate the difference.
Example:
Source and its content: C:\Data\readme.txt
Target and its content after file transfer:
-- Outcome 1 (Target path is not modified): D:\Backup\readme.txt
-- Outcome 2 (Target path is modified by adding the Source folder name): D:
\Backup\Data\readme.txt
Modifying Target path may be necessary when multiple Source folders are being
transferred to a single Target.

Connect through

'--': you connect to a Source folder directly.
'Remote account': access to a Source folder requires a remote computer
address, username, and password. Please read below how to select, access,
and configure your account on a remote computer.

Account name

If you connect to a Target folder located on a remote computer, here you may
select your pre-configured remote account. If there is none, or you need to create a
new one, access remote account properties as described below.

Account
properties

Click the 'Edit' button to access the Remote Accounts manager where you can
create and configure your remote accounts. Detailed information about this can be
found here.

Additional File Filter
Additional File Filter distinguishes files by mask.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
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? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension
; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it
Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
files being excluded.

Example No.1:

Example No.2:

Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'
and has a 'docx' extension will be included)
Files that will be included: file_01-01-2012.
docx, file120101.docx, file1Jan2012.docx

Included files: file??????.docx (that means
that any file that has its filename starting with a
word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
Included files

A list of file masks that describe files to be transferred to this particular Target.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, no files will be transferred to this Target.

Excluded files

A list of file masks that describe files not to be transferred to this particular Target.

Modify Files Before Transfer to This Target
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This option (previously known as 'Pre-processing') applies to all files before they are transferred to this
Target.
The underlying idea is that files may be transferred to some Targets as usual (without any modifications:
compression, encryption, etc), and to other Targets (for which this option is enabled) in compressed and
(or) encrypted form. Equally, if files are already compressed and (or) encrypted, they may be
uncompressed and (or) decrypted before being transferred to Target(s).
File modification may take additional time when large files or significant number of files are processed.
Modification type A type of modification that is applied to each file before it is transferred to Target.
The following options are available:
'Compress': compress each file reducing its size using ZIP compression
algorithm. Compression options can be configured in the Modification options
window (described below). File Compression extension is required to use this
option.
'Uncompress': extract each file from an archive using ZIP compression algorithm.
It has no options. File Compression extension is required to use this option.
'Encrypt': encrypt each file using an encryption algorithm and password selected
in the Modification options window (described below). File Encryption extension
is required to use this option.
'Decrypt': decrypt each file using an encryption algorithm and password selected
in the Modification options window (described below). File Encryption extension
is required to use this option.
'Compress and encrypt': this option combines the compression and encryption
functions. First, AnyFileBackup compresses a file using ZIP algorithm and then,
secondly, encrypts the compressed file with a supported encryption algorithm.
Additional compression and encryption options can be configured in the
Modification options window (described below). File Compression and File
Encryption extensions are required to use this option
'Decrypt and uncompressed': performs decryption and uncompression operations
in a manner described in the 'Compress and encrypt' option above but in a reverse
order.
Modification
options

Click the 'Configure' button to access the Modification Options.
Encryption / Decryption Options
'Encryption type': An encryption method that is used to encrypt or decrypt files.
The following types are currently available: AES, Blowfish, DES, PGP, TripleDES, and ZIP.
'Account name': A name of a pre-configured account that contains a password
(for AES, Blowfish, DES, Triple-DES, and ZIP encryption types) or a PGP key
with password (for a PGP encryption type).
'Account properties': Opens a properties window for the selected account. If no
account is selected, the Account Manager window that fits the selected
encryption type will be opened.
Compression Options
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'Store paths':
'--' (=none): file will be archived 'as is', without any folders;
'Relative': file will be archived with folder where it is located;
'Full': file will be archived with full path (but excluding drive and server
names).
'Mak e timestamp of archive and file the same': if enabled, an archive will have
timestamp identical to that of a file inside of it.
'To a single archive': if enabled, all files that are within task's scope will be
packed into a single archive file. The archive's filename can be set in the 'Archive
name' field below.
'Archive name': a name of a single archive into which all Source files are packed.
If left blank, the default template will be used which is ${DATE=yyyy.mm.dd}_${
TIME=hh-nn-ss} and the resulting archive filename will look like
'2014.05.25_10.30.00.zip'. You may use both macros and other symbols to
define the archive name.

Transfer Options
Safe transfer

When transferring large files with identical filenames from Source to Target(s),
AnyFileBackup can ensure that a file in Target will not be replaced by a file from
Source until such Source file is fully transferred to Target. This file transfer method
is known as a 'safe transfer'.
This is achieved in the following way. First, the Source file is transferred to Target
with a temporary name (different from that of the Target file). Secondly, when the
Source file is fully transferred to Target, its filename is changed to its proper
[Source] name replacing the Target file.
The main advantage of this method is full protection from accidental interruptions
during file transfer process which otherwise may cause only partial transfer of files.
This method of transfer also has certain disadvantages:
it reduces AnyFileBackup overall performance because of additional copying and
renaming operations, and
it can not be used with the 'Append' and 'Update changed parts' types of the
Conflict Resolution Rules.

Maximum
transfer speed

This is the maximum incoming speed of file transfer to Target set in bytes per
second. When left blank, the speed is unlimited. You can also configure outgoing
speed of file transfer from Source in the Source settings.

Overwrite 'ReadOnly' files

If enabled, a Target file that has read-only attribute will be overwritten with a Source
file. If disabled, this Target file will be kept intact but this will be considered as error
and common and task error handling rules will apply.

File Options
Restore
directory tree

If enabled, Source full subfolder structure will be transferred to Target with Source
files allocated to their respective subfolders. If disabled, all Source files will
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transferred to Target as if Source files were in one single folder; no subfolders are
transferred to Target.
Set original file
timestamp

If enabled, Target file will have exactly the same timestamp as its Source
counterpart. If disabled, Target file will have timestamp that reflects time of its
transfer to Target.

CRC smart
verification

If enabled, AnyFileBackup will calculate and compare a Source file's CRC (Cyclic
Redundancy Check) (that is a file's checksum) with a Target file's CRC after a
particular files has been transferred from Source to Target.
Generally, operating systems automatically check file consistency after coping that
is enough in most circumstances. This option is an additional guarantee that the file
from Source is identical to the file transferred to Target. We recommend to use this
option only when a critical data is being back ed up.
A CRC calculation of large files may be time-consuming, so we invented a special
'smart verification' that significantly speeds up this operation (though copying
becomes slightly longer). AnyFileBackup uses last kilobyte of each files (from
Source and from Target) to calculate and compare their CRCs. This is generally
sufficient to prevent a very unlikely event when files are not identical after back up.
If CRC verification fails and files are not identical, AnyFileBackup will treat this as
an error and will proceed according to the Common Error Handling Rules or TaskSpecific Error Handling Rules.

Miscellaneous

5.4.4

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

FTP
Topic Content
FTP Account
Additional File Filter
Modify Files Before Transfer to This Target
Transfer Options
File Options
Miscellaneous

This option defines Target properties for FTP (file transport protocol) servers and folders.

FTP Account
Account name
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Account
properties

Click the 'Edit' button to access the FTP Accounts manager where you can create
and configure your FTP accounts. Detailed information about this can be found here
.

Target folder

a name of the FTP server directory, where files from Source are to be transferred to.
That should be a full path from the server's root but excluding the FTP server
address.
Example: /FTP/IN/DATA/
A note on VMS FTP servers:
Notation: AnyFileBackup recognises whether a remote server runs VMS and
automatically converts UNIX/Linux notation into appropriate VMS notation.
Therefore, you must use usual UNIX/Linux notation for pointing to the remote
directory ('/FTP/IN/DATA/') instead of VMS notation ('[FTP.IN.DATA]').
Passive mode: use FTP passive mode when connecting to a VMS-based FTP
server.

Modify Target
path

When AnyFileBackup transfers Source files to Target, it does not create a Source
folder itself in Target. However, this may be changed. A simple example will
illustrate the difference.
Example:
Source and its content: C:\Data\readme.txt
Target and its content after file transfer:
-- Outcome 1 (Target path is not modified): D:\Backup\readme.txt
-- Outcome 2 (Target path is modified by adding the Source folder name): D:
\Backup\Data\readme.txt
Modifying Target path may be necessary when multiple Source folders are being
transferred to a single Target.

Additional File Filter
Additional File Filter distinguishes files by mask.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension
; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it
Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
files being excluded.
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Example No.2:

Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'
and has a 'docx' extension will be included)
Files that will be included: file_01-01-2012.
docx, file120101.docx, file1Jan2012.docx

Included files: file??????.docx (that means
that any file that has its filename starting with a
word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
Included files

A list of file masks that describe files to be transferred to this particular Target.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, no files will be transferred to this Target.

Excluded files

A list of file masks that describe files not to be transferred to this particular Target.

Modify Files Before Transfer to This Target
This option (previously known as 'Pre-processing') applies to all files before they are transferred to this
Target.
The underlying idea is that files may be transferred to some Targets as usual (without any modifications:
compression, encryption, etc), and to other Targets (for which this option is enabled) in compressed and
(or) encrypted form. Equally, if files are already compressed and (or) encrypted, they may be
uncompressed and (or) decrypted before being transferred to Target(s).
File modification may take additional time when large files or significant number of files are processed.
Modification type A type of modification that is applied to each file before it is transferred to Target.
The following options are available:
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'Compress': compress each file reducing its size using ZIP compression
algorithm. Compression options can be configured in the Modification options
window (described below). File Compression extension is required to use this
option.
'Uncompress': extract each file from an archive using ZIP compression algorithm.
It has no options. File Compression extension is required to use this option.
'Encrypt': encrypt each file using an encryption algorithm and password selected
in the Modification options window (described below). File Encryption extension
is required to use this option.
'Decrypt': decrypt each file using an encryption algorithm and password selected
in the Modification options window (described below). File Encryption extension
is required to use this option.
'Compress and encrypt': this option combines the compression and encryption
functions. First, AnyFileBackup compresses a file using ZIP algorithm and then,
secondly, encrypts the compressed file with a supported encryption algorithm.
Additional compression and encryption options can be configured in the
Modification options window (described below). File Compression and File
Encryption extensions are required to use this option
'Decrypt and uncompressed': performs decryption and uncompression operations
in a manner described in the 'Compress and encrypt' option above but in a reverse
order.

Modification
options

Click the 'Configure' button to access the Modification Options.
Encryption / Decryption Options
'Encryption type': An encryption method that is used to encrypt or decrypt files.
The following types are currently available: AES, Blowfish, DES, PGP, TripleDES, and ZIP.
'Account name': A name of a pre-configured account that contains a password
(for AES, Blowfish, DES, Triple-DES, and ZIP encryption types) or a PGP key
with password (for a PGP encryption type).
'Account properties': Opens a properties window for the selected account. If no
account is selected, the Account Manager window that fits the selected
encryption type will be opened.
Compression Options
'Store paths':
'--' (=none): file will be archived 'as is', without any folders;
'Relative': file will be archived with folder where it is located;
'Full': file will be archived with full path (but excluding drive and server
names).
'Mak e timestamp of archive and file the same': if enabled, an archive will have
timestamp identical to that of a file inside of it.
'To a single archive': if enabled, all files that are within task's scope will be
packed into a single archive file. The archive's filename can be set in the 'Archive
name' field below.
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'Archive name': a name of a single archive into which all Source files are packed.
If left blank, the default template will be used which is ${DATE=yyyy.mm.dd}_${
TIME=hh-nn-ss} and the resulting archive filename will look like
'2014.05.25_10.30.00.zip'. You may use both macros and other symbols to
define the archive name.

Transfer Options
Skip locked or
inaccessible
files

When enabled, AnyFileBackup will skip files that cannot be accessed for whatever
reason. These files will be marked as not copied and AnyFileBackup will attempt to
transfer them during the next scheduled task execution.
When disabled, the whole situation will be considered as an error. What will happen
next depends on default and task-specific Error handling rules. The task will either:
continue execution (the default setting), or
stop until the next scheduled start, or
deactivate until the next Task Processor restart or manual task activation.
This option is incompatible with Two-Way Synchronization mode.

Use FTP
compression
(MODE Z)

When enabled, activates compression of any traffic transmitted between
AnyFileBackup and FTP server. This reduces overall file transfer time.

Maximum
transfer speed

This is the maximum incoming speed of file transfer to Target set in bytes per
second. When left blank, the speed is unlimited. You can also configure outgoing
speed of file transfer from Source in the Source settings.

Safe transfer

When transferring large files with identical filenames from Source to Target(s),
AnyFileBackup can ensure that a file in Target will not be replaced by a file from
Source until such Source file is fully transferred to Target. This file transfer method
is known as a 'safe transfer' and, when FTP is concerned, it can work in either of
two modes:
'Type 1': First, the Source file is transferred to Target with a temporary name
(different from that of the Target file). Secondly, when the Source file is fully
transferred to Target, its filename is changed to its proper [Source] name
replacing the Target file.
'Type 2': First, the Source file is transferred to Target with a temporary name
(different from that of the Target file). Secondly, when the Source file is fully
transferred to Target, the Target file is deleted (this may be necessary due to
permissions' restriction on file renaming). Thirdly, and finally, the Source file's
name is changed to its proper [Source] name.
Select 'None' to disable safe transfer.
The main advantage of this method is full protection from accidental interruptions
during file transfer process which otherwise may cause only partial transfer of files.
This method of transfer also has certain disadvantages:
it reduces AnyFileBackup overall performance because of additional copying and
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renaming operations, and
it can not be used with the 'Append' and 'Update changed parts' types of the
Conflict Resolution Rules.

On upload error

This option defines what happens to files that have been uploading to FTP sever but
have not been uploaded because of connection interruption.
'Re-upload (restart upload)': after interruption files will be uploaded again from the
beginning. It is recommended to use this option for binary files.
'Restore (resume upload)': after connection the upload will resume and those
parts of files that [parts] have already been uploaded will not be uploaded again.
This option may save upload time and traffic.

Use server-toserver transfer

This data transfer method connects two FTP servers with another another without
routing data through the client computer / server. The advantage is avoiding time
losses and maximizing transfer speed which [speed] does not depend on the client
connection speed limit but only on the connection speed between the two FTP
servers.
The requirements of these method are that both FTP servers:
support PASV (passive) mode
allow PORT command for foreign hosts
This transfer method can NOT be used with either of these:
VMS FTP servers
Secure Protocol Extension
Safe transfer option
FTP compression
FTP restore
Byte replication

File Options
Convert filename

When enabled, changes the filename case in Target as follows:
- (=none): no changes to the filename, or
to upper case, or
to lower lower case.
All letters in both the filename and extension will be converted to upper or lower
case as the case may be.

Set original file
timestamp

If enabled, Target file will have exactly the same timestamp as its Source
counterpart. If disabled, Target file will have timestamp that reflects time of its
transfer to Target.

2015 AAR Innovations (R)

Task Properties

97

Restore
directory tree

If enabled, Source full subfolder structure will be transferred to Target with Source
files allocated to their respective subfolders. If disabled, all Source files will
transferred to Target as if Source files were in one single folder; no subfolders are
transferred to Target.

Copy file
permissions

This option is visible only when Source is also FTP. If enabled, FTP file permissions
set for a Source file will be set for a Target file. If disabled, Target FTP default
permissions will apply which depend on the configuration of Target FTP server.

Set file
permissions

This options allows to set file permissions in numeric format for users of FTP
Target. The following combinations are most common:
0000

no permissions

0111

execute

0222

write

0333

write & execute

0444

read

0555

read & execute

0666

read & write

0777

read, write, & execute

For more information please read a very helpful article on Wikipedia.

Miscellaneous
Notify if server is
inaccessible

If AnyFileBackup cannot read the Source's content for whatever reason (e.g.,
Source does not exist, access to Source is blocked by a firewall policies, etc),
AnyFileBackup can notify you about this error by e-mail.
Notification settings can be set up in 'Program Settings' > 'Error Handling'.

5.4.5

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Google Drive
Topic Content
Google Drive Account
Additional File Filter
Modify Files Before Transfer to This Target
Miscellaneous
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This option defines Target properties for Google's (c) cloud storage -- Google Drive.

Google Drive Account
Target folder

A name of a folder located in Google Drive cloud.

Account name

Select a name of a pre-configured Google Drive account from the drop down list. If
there is none, or you need to create a new one, access Google Drive properties as
described below.

Account
properties

Click the 'Edit' button to access the Google Drive manager where you can create
and configure your Google Drive accounts. Detailed information about this can be
found here.

Additional File Filter
Additional File Filter distinguishes files by mask.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension
; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it
Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
files being excluded.

Example No.1:
Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'
and has a 'docx' extension will be included)
Files that will be included: file_01-01-2012.
docx, file120101.docx, file1Jan2012.docx

Example No.2:
Included files: file??????.docx (that means
that any file that has its filename starting with a
word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
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between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
Included files

A list of file masks that describe files to be transferred to this particular Target.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, no files will be transferred to this Target.

Excluded files

A list of file masks that describe files not to be transferred to this particular Target.

Modify Files Before Transfer to This Target
This option (previously known as 'Pre-processing') applies to all files before they are transferred to this
Target.
The underlying idea is that files may be transferred to some Targets as usual (without any modifications:
compression, encryption, etc), and to other Targets (for which this option is enabled) in compressed and
(or) encrypted form. Equally, if files are already compressed and (or) encrypted, they may be
uncompressed and (or) decrypted before being transferred to Target(s).
File modification may take additional time when large files or significant number of files are processed.
Modification type A type of modification that is applied to each file before it is transferred to Target.
The following options are available:
'Compress': compress each file reducing its size using ZIP compression
algorithm. Compression options can be configured in the Modification options
window (described below). File Compression extension is required to use this
option.
'Uncompress': extract each file from an archive using ZIP compression algorithm.
It has no options. File Compression extension is required to use this option.
'Encrypt': encrypt each file using an encryption algorithm and password selected
in the Modification options window (described below). File Encryption extension
is required to use this option.
'Decrypt': decrypt each file using an encryption algorithm and password selected
in the Modification options window (described below). File Encryption extension
is required to use this option.
'Compress and encrypt': this option combines the compression and encryption
functions. First, AnyFileBackup compresses a file using ZIP algorithm and then,
secondly, encrypts the compressed file with a supported encryption algorithm.
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Additional compression and encryption options can be configured in the
Modification options window (described below). File Compression and File
Encryption extensions are required to use this option
'Decrypt and uncompressed': performs decryption and uncompression operations
in a manner described in the 'Compress and encrypt' option above but in a reverse
order.

Modification
options

Click the 'Configure' button to access the Modification Options.
Encryption / Decryption Options
'Encryption type': An encryption method that is used to encrypt or decrypt files.
The following types are currently available: AES, Blowfish, DES, PGP, TripleDES, and ZIP.
'Account name': A name of a pre-configured account that contains a password
(for AES, Blowfish, DES, Triple-DES, and ZIP encryption types) or a PGP key
with password (for a PGP encryption type).
'Account properties': Opens a properties window for the selected account. If no
account is selected, the Account Manager window that fits the selected
encryption type will be opened.
Compression Options
'Store paths':
'--' (=none): file will be archived 'as is', without any folders;
'Relative': file will be archived with folder where it is located;
'Full': file will be archived with full path (but excluding drive and server
names).
'Mak e timestamp of archive and file the same': if enabled, an archive will have
timestamp identical to that of a file inside of it.
'To a single archive': if enabled, all files that are within task's scope will be
packed into a single archive file. The archive's filename can be set in the 'Archive
name' field below.
'Archive name': a name of a single archive into which all Source files are packed.
If left blank, the default template will be used which is ${DATE=yyyy.mm.dd}_${
TIME=hh-nn-ss} and the resulting archive filename will look like
'2014.05.25_10.30.00.zip'. You may use both macros and other symbols to
define the archive name.

Miscellaneous
Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.
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HTTP
Topic Content
HTTP Account
Miscellaneous

This option defines Target properties for HTTP (Hypertext Transfer Protocol) pages and files.

HTTP Account
Account name

Select a name of a pre-configured HTTP account from the drop down list. If there is
none, or you need to create a new one, access HTTP account properties as
described below.

Account
properties

Click the 'Edit' button to access the HTTP Accounts manager where you can create
and configure your HTTP accounts. Detailed information about this can be found
here.

Miscellaneous

5.4.7

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Microsoft OneDrive
Topic Content
OneDrive Account
Additional File Filter
Modify Files Before Transfer to This Target
Miscellaneous

This option defines Target properties for Microsoft's (c) cloud storage -- OneDrive.

OneDrive Account
Target folder

A name of a folder located in OneDrive cloud.

Account name

Select a name of a pre-configured OneDrive account from the drop down list. If there
is none, or you need to create a new one, access OneDrive properties as described
below.

Account
properties

Click the 'Edit' button to access the OneDrive manager where you can create and
configure your OneDrive accounts. Detailed information about this can be found
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Additional File Filter
Additional File Filter distinguishes files by mask.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension
; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it
Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
files being excluded.

Example No.1:

Example No.2:

Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'
and has a 'docx' extension will be included)
Files that will be included: file_01-01-2012.
docx, file120101.docx, file1Jan2012.docx

Included files: file??????.docx (that means
that any file that has its filename starting with a
word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
Included files

A list of file masks that describe files to be transferred to this particular Target.
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Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, no files will be transferred to this Target.
Excluded files

A list of file masks that describe files not to be transferred to this particular Target.

Modify Files Before Transfer to This Target
This option (previously known as 'Pre-processing') applies to all files before they are transferred to this
Target.
The underlying idea is that files may be transferred to some Targets as usual (without any modifications:
compression, encryption, etc), and to other Targets (for which this option is enabled) in compressed and
(or) encrypted form. Equally, if files are already compressed and (or) encrypted, they may be
uncompressed and (or) decrypted before being transferred to Target(s).
File modification may take additional time when large files or significant number of files are processed.
Modification type A type of modification that is applied to each file before it is transferred to Target.
The following options are available:
'Compress': compress each file reducing its size using ZIP compression
algorithm. Compression options can be configured in the Modification options
window (described below). File Compression extension is required to use this
option.
'Uncompress': extract each file from an archive using ZIP compression algorithm.
It has no options. File Compression extension is required to use this option.
'Encrypt': encrypt each file using an encryption algorithm and password selected
in the Modification options window (described below). File Encryption extension
is required to use this option.
'Decrypt': decrypt each file using an encryption algorithm and password selected
in the Modification options window (described below). File Encryption extension
is required to use this option.
'Compress and encrypt': this option combines the compression and encryption
functions. First, AnyFileBackup compresses a file using ZIP algorithm and then,
secondly, encrypts the compressed file with a supported encryption algorithm.
Additional compression and encryption options can be configured in the
Modification options window (described below). File Compression and File
Encryption extensions are required to use this option
'Decrypt and uncompressed': performs decryption and uncompression operations
in a manner described in the 'Compress and encrypt' option above but in a reverse
order.
Modification
options

Click the 'Configure' button to access the Modification Options.
Encryption / Decryption Options
'Encryption type': An encryption method that is used to encrypt or decrypt files.
The following types are currently available: AES, Blowfish, DES, PGP, TripleDES, and ZIP.
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'Account name': A name of a pre-configured account that contains a password
(for AES, Blowfish, DES, Triple-DES, and ZIP encryption types) or a PGP key
with password (for a PGP encryption type).
'Account properties': Opens a properties window for the selected account. If no
account is selected, the Account Manager window that fits the selected
encryption type will be opened.
Compression Options
'Store paths':
'--' (=none): file will be archived 'as is', without any folders;
'Relative': file will be archived with folder where it is located;
'Full': file will be archived with full path (but excluding drive and server
names).
'Mak e timestamp of archive and file the same': if enabled, an archive will have
timestamp identical to that of a file inside of it.
'To a single archive': if enabled, all files that are within task's scope will be
packed into a single archive file. The archive's filename can be set in the 'Archive
name' field below.
'Archive name': a name of a single archive into which all Source files are packed.
If left blank, the default template will be used which is ${DATE=yyyy.mm.dd}_${
TIME=hh-nn-ss} and the resulting archive filename will look like
'2014.05.25_10.30.00.zip'. You may use both macros and other symbols to
define the archive name.

Miscellaneous

5.5

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Synchronisation
Topic Content
Subfolders
Primary File Filter
Additional File Filter
Transfer Options
File Options
Miscellaneous
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This option defines various properties relevant to Two-Way Synchronization Mode. This mode is unique
because its main purpose is to make content of two locations identical (to create exact copies by
mirroring any changes inside them). We call these locations Source 1 and Source 2. However, in fact
each location serves as both Source and Target at the same time. Therefore, any references below to
Source and Target should be read as references to Source 1 and Source 2 respectively.

Subfolders
Include
subfolders?

Subfolder is any folder existing in Source (but not Source itself). For example, if
Source is 'C:\Folder\', then 'C:\Folder\Temp\' and 'C:\Folder\Temp1\ABC\' are its
subfolder. Select 'No' (uncheck the checkbox) if you do not want subfolders and
their content to be backed up, synchronized, monitored, etc.

Primary File Filter
Primary File Filter is the first among two filters that are available in Two-Way Synchronization mode. It is
applied first, before Additional File Filter. This filter distinguishes files by their origin and catches the
following types of files (all of them):
'New': a file that has have appeared in (created in, copied to, etc.) Source after the most recent Source
snapshot is within task's scope. Note, that if a file has been renamed, it is also considered as 'new'
even though no other changes have happened to this file.
'Deleted': this is opposite to 'New'. A file that disappears (deleted, etc.) from Source is within task's
scope and will also be deleted from Target. Note, that as with 'New', if a file has been renamed, it is
also considered as 'deleted' even though no other changes have happened to this file.
'Changed': a file whose parameters have changed is within task's scope. The relevant parameters are:
- filename
- timestamp
- size
- attributes (System, Read only, Compressed, Hidden, Archive, Encrypted) [only if available: FAT32
does not support Compressed and Encrypted]
- checksum [only available if both Source 1 and Source 2 are folders] (it is possible to configure the
checksum type in 'Activation' > 'Advanced Options' increasing the checksum speed calculation)
- NTFS permissions (full control, modify, read and execute, read, write, special permission) [only if
available]
Current filter

Displays the name of selected filter. To select another filter click on the button at
the end of the field and choose an appropriate filter.

Additional File Filter
Additional File Filter distinguishes files by mask.
The following operators and wildcards may be used:
* (asterix): means ANY number of ANY symbols
? (question mark): means ANY SINGLE ONE symbol
. (dot): means a delimiter which is normally used to separate a filename and a file extension
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; (semicolon): means a delimiter which is used to separate one file mask from another; no space is
necessary either before or after it

Combinations of the above are also allowed: see Example No.3 below.
The below examples describe a situation of a file being included. All these equally work in relation to
files being excluded.

Example No.1:

Example No.2:

Included files: file*.docx (that means that any
file that has its filename starting with a word 'file'
and has a 'docx' extension will be included)
Files that will be included: file_01-01-2012.
docx, file120101.docx, file1Jan2012.docx

Included files: file??????.docx (that means
that any file that has its filename starting with a
word 'file', has a 'docx' extension and has any
six symbols between a ford 'file' and a dot will
be included)
Files that will be included: file120101.docx

Files that will NOT be included: file01.01.12.
doc

Files that will NOT be included: file_01-01-2012.
docx, file1Jan2012.docx, file01.01.12.doc

Example No.3:
file????2012.* : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has any extension will be included (note that if a file has neither
an extension nor a dot after '2012' it will NOT be included because a dot ('.') symbol is an essential
part of its filename).
file*201?.* : any file that has its filename starting with a word 'file', has any number of symbols
between a word 'file' and '201', ends with any one undefined symbol and has any extension will be
included (note that if a file has neither an extension nor a dot after '201[ANY_SYMBOL]' it will NOT
be included because a dot ('.') symbol is an essential part of its filename).
file????2012.doc? : any file that has its filename starting with a word 'file', has any four symbols
between a word 'file' and '2012' and has extension that starts with 'doc' with any single one symbol at
the end (or even none at all, so 'file01012012.doc' is also covered) will be included.
Included files

A list of file masks that describe files to be included in the scope of task.

Excluded files

A list of file masks that describe files to be excluded from the scope of task.

Transfer Options
Maximum
transfer speed

This is the maximum incoming and outgoing speed of file transfer to and from
Source 1 and Source 2 set in bytes per second. If left blank, the speed is unlimited.

File Options
This section is visible only when both Source 1 and Source 2 are local and (or) LAN folders.
Files in Source may have certain properties like NTFS permissions and file attributes. These properties
may be or may be not inherited when these files are transferred to Target(s). This group of options
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defines which properties will be inherited by Target files from their Source originals.
Copy NTFS
permissions

NTFS permissions are special rights of file access set by either by a computer
administrator or Windows system itself for other users. These are full control,
modify, read and execute, read, write, special permission.
If any of these parameters are set at Source (they must be located at a hard drive
with NTFS file system) and may be preserved by Target (in other words, Target hard
drive supports NTFS file system), then these permissions will be transferred if the
checkbox is checked.
Administrator's rights may be required to set NTFS permissions at Target.

Copy file
attributes

If a file in Source has the following attributes (see below), an identical file in Target
will have exactly the same attributes (all of them):
'Hidden'
'Read only'
'System'

Reset 'Archive'
attribute

'Archive' attribute is automatically set for each file that is created in or copied to a
folder. It indicates that it is ready for backup by Windows (c) Backup.
When file with an 'Archive' attribute is being backed up by AnyFileBackup, this
attribute may be removed by AnyFileBackup after successful backup to indicate
that this file no longer needs backup up.

Miscellaneous
Notify if Source
is inaccessible

If AnyFileBackup cannot read the Source's content for whatever reason (e.g.,
Source does not exist, access to Source is blocked by a firewall policies, etc),
AnyFileBackup can notify you about this error by e-mail.
Notification settings can be set up in 'Program Settings' > 'Error Handling'.

Title

5.5.1

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Folder (local / LAN)
Topic Content
General
Miscellaneous

This option defines Source properties for local area network (LAN) and local folders.

General
Source folder
Connect through
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'Remote account': access to a Source folder requires a remote computer
address, username, and password. Please read below how to select, access,
and configure your account on a remote computer.

Account name

If you connect to a Source folder located on a remote computer, here you may
select your pre-configured remote account. If there is none, or you need to create a
new one, access remote account properties as described below.

Account
properties

Click the 'Edit' button to access the Remote Accounts manager where you can
create and configure your remote accounts. Detailed information about this can be
found here.

Miscellaneous
Title

5.5.2

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

FTP
Topic Content
FTP Account
Miscellaneous

This option defines Source properties for FTP (file transport protocol) servers and folders.

FTP Account
Account name

Select a name of a pre-configured FTP account from the drop down list. If there is
none, or you need to create a new one, access FTP account properties as
described below.

Account
properties

Click the 'Edit' button to access the FTP Accounts manager where you can create
and configure your FTP accounts. Detailed information about this can be found here
.

Source folder

A name of the FTP server directory, where Source files are located.
That should be a full path from the server's root but excluding the FTP server
address.
Example: /FTP/IN/DATA/
A note on VMS FTP servers:
Notation: AnyFileBackup recognises whether a remote server runs VMS and
automatically converts UNIX/Linux notation into appropriate VMS notation.
Therefore, you must use usual UNIX/Linux notation for pointing to the remote
directory ('/FTP/IN/DATA/') instead of VMS notation ('[FTP.IN.DATA]').
Passive mode: use FTP passive mode when connecting to a VMS-based FTP
server.
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Miscellaneous

5.5.3

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Amazon S3
Topic Content
Cloud Account
Miscellaneous

This option defines Source properties for cloud storage. Currently only one cloud storage is supported -Amazon S3 Bucket. Other types will be added later and will include Dropbox, box.net, SkyDrive,
GoogleDrive, and some other.

Cloud Account
Bucket name

This is another name for a folder located in Amazon S3 cloud.

Security account Select a name of a pre-configured Amazon S3 account from the drop down list. If
name
there is none, or you need to create a new one, access Amazon S3 properties as
described below.
Account
properties

Click the 'Edit' button to access the Amazon S3 manager where you can create
and configure your Amazon S3 accounts. Detailed information about this can be
found here.

Use SSL

When enabled, SSL (Secure Sockets Layer) protocol is used to exchange data
with the selected cloud storage. SSL is a secured protocol that prevents
unauthorised access to information that is being transferred. It is recommended to
enable this option unless there are very strong reasons not to do so. Secure
Protocols extension is required to use this option.

Miscellaneous

5.6

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Monitoring
This mode has no specific settings. It does exactly what it means to -- monitors Source.
What happens when changes occur in Source or none occurs at all can be configured by adding
Messaging and (or) Management actions.
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Clean-Up
This mode has no specific settings. It does exactly what it means to -- cleans up Source according to filter
settings defined in Source. When cleaning Source, AnyFileBackup will remove the relevant files only
leaving all folders (whether empty or not) intact.
What happens when clean up is complete or unsuccessful can be configured by adding Messaging and (or)
Management actions.

5.8

Other Actions
Any action from this group of actions (except for the 'Miscellaneous' actions) can be a part of the Backup
step of the Task Scenario or be an independent step of the Task Scenario. The main difference is as
follows:
Task position in the Task
Scenario
A part of the Backup step
An independent step

5.8.1

Options
Additional File Filter

Conditional Start

supported

not supported

not supported

supported

Messaging Actions
This section explains how to configure AnyFileBackup actions that send the following types of messages:
E-mail messages
Computer messages that are sent via LAN
SMS ('Short Message Service') messages that are sent via an Android-power smartphone with the SMS
extension installed
Log messages that are either recorded to a designated file on disk or to an internal AnyFileBackup log
file

5.8.1.1

E-Mail
Topic Content
Recipients
Outgoing E-mail Server Account
Additional File Filter
Message
Miscellaneous

This option defines action properties for a mailbox (also known as an e-mail account) located on server or
web.

Recipients
Recipient list

Select a name or multiple names of pre-configured Recipient List(s) by checking
appropriate items. If there is none, or you need to create a new one, access
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Recipient List account properties as described below.
Account
properities

Click the 'Configure' button to access the Recipient List manager where you can
create and configure your recipient lists. Detailed information about this can be
found here.

Outgoing E-mail Server Account
Account name

Select a name of a pre-configured E-mail server account from the drop down list. If
there is none, or you need to create a new one, access E-mail account properties
as described below.

Account
properties

Click the 'Configure' button to access the Outgoing E-mail Accounts manager
where you can create and configure your e-mail accounts. Detailed information
about this can be found here.

Additional File Filter
This option is visible and applies if, and only if, the action is a PART of the Backup step of the
Task Scenario.
Additional File Filter distinguishes files by mask determining to which file(s) this particular action will or
will not apply. In all other respects it is no different from the Additional File Filter that exists in every
Target.
Included files

A list of file masks that describe files to which this particular action will apply.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, this action will not apply to any files.

Excluded files

A list of file masks that describe files to which this particular action will not apply.

Message
This group of options allows to set custom values for subject and text fields of e-mails. These values are
'custom' because they override the default values set in the Recipient List and apply to this Target only. If
any of these fields left blank, the values from the Recipient List will be used.
Subject

The subject matter of the e-mail. You may use Macro strings in this field.

Text

The body of the e-mail. You may use Macro strings in this field.

Miscellaneous
Condition

This option is visible and applies if, and only if, the action is located BELOW
the Backup, Two-Way Synchronization, Monitoring, or Clean-up step of the
Task Scenario.
This is a description of an event upon occurrence of which this action will be
performed. The event relates either to Source or to task generally. The following
events are covered:
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'Always': action is event-neutral and will always start when AnyFileBckup reaches
it at the Task Scenario.
'Success': the term 'success' refers to successful completion of either:
-- Backup stage (all files have been transferred from Source to Target(s) and other
actions within Backup have been performed), or
-- Two-Way Synchronization stage (Source 1 and Source 2 have been
synchronized), or
-- Monitoring stage (Source parameters that are being monitored are exceeded their
threshold limits or relevant changes have occurred).
When any of these stages is completed properly (depending on the task type),
action with this condition will perform.
'Error': action will start when task has not performed properly and produced an
error. This error may occur at any previous stage of task scenario. Please note
that this action will only work if task 'on error' behaviour is set to 'continue task
execution' (see Task error handling for details), otherwise this action will not start.
It is also recommended put action with this condition at the end of the task
scenario, so it can catch any errors that have occurred in a course of task
performance.
'No changes': this condition is the opposite to the 'Success'--when nothing
happens at any of the stages described above: no files have been transferred
between Source and Target(s), Source parameters that are being monitored are
within their threshold limits or no relevant changes have occurred.

5.8.1.2

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Computer
Topic Content
General
Additional File Filter
Message
Miscellaneous

This option defines action properties for a remote computer.

General
Computer

A name of a remote computer as it is displayed on the network.

Additional File Filter
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This option is visible and applies if, and only if, the action is a PART of the Backup step of the
Task Scenario.
Additional File Filter distinguishes files by mask determining to which file(s) this particular action will or
will not apply. In all other respects it is no different from the Additional File Filter that exists in every
Target.
Included files

A list of file masks that describe files to which this particular action will apply.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, this action will not apply to any files.

Excluded files

A list of file masks that describe files to which this particular action will not apply.

Message
Text

A message text that will be displayed in message delivered to a remote computer
and will be displayed for 60 minutes (unless closed earlier) after which it will
disappear.

Miscellaneous
Condition

This option is visible and applies if, and only if, the action is located BELOW
the Backup, Two-Way Synchronization, Monitoring, or Clean-up step of the
Task Scenario.
This is a description of an event upon occurrence of which this action will be
performed. The event relates either to Source or to task generally. The following
events are covered:
'Always': action is event-neutral and will always start when AnyFileBckup reaches
it at the Task Scenario.
'Success': the term 'success' refers to successful completion of either:
-- Backup stage (all files have been transferred from Source to Target(s) and other
actions within Backup have been performed), or
-- Two-Way Synchronization stage (Source 1 and Source 2 have been
synchronized), or
-- Monitoring stage (Source parameters that are being monitored are exceeded their
threshold limits or relevant changes have occurred).
When any of these stages is completed properly (depending on the task type),
action with this condition will perform.
'Error': action will start when task has not performed properly and produced an
error. This error may occur at any previous stage of task scenario. Please note
that this action will only work if task 'on error' behaviour is set to 'continue task
execution' (see Task error handling for details), otherwise this action will not start.
It is also recommended put action with this condition at the end of the task
scenario, so it can catch any errors that have occurred in a course of task
performance.
'No changes': this condition is the opposite to the 'Success'--when nothing
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happens at any of the stages described above: no files have been transferred
between Source and Target(s), Source parameters that are being monitored are
within their threshold limits or no relevant changes have occurred.

5.8.1.3

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

SMS
Topic Content
Recipients
Android Smartphone Connection
Additional File Filter
Message
Miscellaneous

This option defines action properties for a SMS message which is sent via an Android-powered
smartphone connected to a computer via WiFi, Bluetooth, or cable (provided that it has its own unique IP
address).

Recipients
Recipient list

Select a name or multiple names of pre-configured Recipient List(s) by checking
appropriate items. If there is none, or you need to create a new one, access
Recipient List account properties as described below.

Account
prosperities

Click the 'Configure' button to access the Recipients List manager where you can
create and configure your mobile accounts. Detailed information about this can be
found here.

Android Smartphone Connection
AnyFileBackup connects to an Android smartphone via HTTP protocol and, therefore, uses HTTP
Accounts manager to create and manage smartphone-related accounts.
Account name

Select a name of a pre-configured HTTP account from the drop down list. If there is
none, or you need to create a new one, access HTTP account properties as
described below.

Account
properties

Click the 'Edit' button to access the HTTP Accounts manager where you can create
and configure your HTTP accounts. Detailed information about this can be found
here.

Additional File Filter
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This option is visible and applies if, and only if, the action is a PART of the Backup step of the
Task Scenario.
Additional File Filter distinguishes files by mask determining to which file(s) this particular action will or
will not apply. In all other respects it is no different from the Additional File Filter that exists in every
Target.
Included files

A list of file masks that describe files to which this particular action will apply.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, this action will not apply to any files.

Excluded files

A list of file masks that describe files to which this particular action will not apply.

Message
Text

A text of an SMS message.

Maximum length

The maximum length of an SMS message. This helps to ensure that no lengthy
messages (which are in fact several standard messages which look like one) are
sent and also to control the budget.

Miscellaneous
Condition

This option is visible and applies if, and only if, the action is located BELOW
the Backup, Two-Way Synchronization, Monitoring, or Clean-up step of the
Task Scenario.
This is a description of an event upon occurrence of which this action will be
performed. The event relates either to Source or to task generally. The following
events are covered:
'Always': action is event-neutral and will always start when AnyFileBckup reaches
it at the Task Scenario.
'Success': the term 'success' refers to successful completion of either:
-- Backup stage (all files have been transferred from Source to Target(s) and other
actions within Backup have been performed), or
-- Two-Way Synchronization stage (Source 1 and Source 2 have been
synchronized), or
-- Monitoring stage (Source parameters that are being monitored are exceeded their
threshold limits or relevant changes have occurred).
When any of these stages is completed properly (depending on the task type),
action with this condition will perform.
'Error': action will start when task has not performed properly and produced an
error. This error may occur at any previous stage of task scenario. Please note
that this action will only work if task 'on error' behaviour is set to 'continue task
execution' (see Task error handling for details), otherwise this action will not start.
It is also recommended put action with this condition at the end of the task
scenario, so it can catch any errors that have occurred in a course of task
performance.
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'No changes': this condition is the opposite to the 'Success'--when nothing
happens at any of the stages described above: no files have been transferred
between Source and Target(s), Source parameters that are being monitored are
within their threshold limits or no relevant changes have occurred.

5.8.1.4

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Log File
Topic Content
Message to Log
Additional File Filter
Miscellaneous

This option defines action properties for a log message that is recorded in any file or AnyFileBackup log.

Message to Log
Text

A message text that will be recorded in a file or AnyFileBackup log.

Write to

Select where you want to write a message to:
a log file on disk (path and filename to be specified below), or
AnyFileBackup internal log which is displayed at the bottom of the Main Window.
If recorded to file, log messages will not be recorded to AnyFileBack up log and vise
versa.

File name

А full path and filename of a file where log messages will recorded to. Messages
will be recorded in plain text format.
If only filename is specified, that file will be saved in:
Windows Vista / 7 / 8 / 2008: 'C:\ProgramData\AnyFileBackupPro\'
Windows
XP:
'C:\Documents
Date\AnyFileBackupPro\'.

and

Settings\All

Users\Application

If left blank, the message will be recorded to 'AnyFileBackupPRO.log' that will be
saved in the folder mentioned above.
If file exists

If a log file already exists, AnyFileBackup can either:
'Overwrite file': existing log file will be deleted and replaced with a new one; all
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records in the existing log file will be lost; or
'Append file': every new log message will be added to the end of the existing log
file. This allows to keep a full record of all messages but there is a risk that the
log file may become very long and difficult to navigate.

Additional File Filter
This option is visible and applies if, and only if, the action is a PART of the Backup step of the
Task Scenario.
Additional File Filter distinguishes files by mask determining to which file(s) this particular action will or
will not apply. In all other respects it is no different from the Additional File Filter that exists in every
Target.
Included files

A list of file masks that describe files to which this particular action will apply.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, this action will not apply to any files.

Excluded files

A list of file masks that describe files to which this particular action will not apply.

Miscellaneous
Condition

This option is visible and applies if, and only if, the action is located BELOW
the Backup, Two-Way Synchronization, Monitoring, or Clean-up step of the
Task Scenario.
This is a description of an event upon occurrence of which this action will be
performed. The event relates either to Source or to task generally. The following
events are covered:
'Always': action is event-neutral and will always start when AnyFileBckup reaches
it at the Task Scenario.
'Success': the term 'success' refers to successful completion of either:
-- Backup stage (all files have been transferred from Source to Target(s) and other
actions within Backup have been performed), or
-- Two-Way Synchronization stage (Source 1 and Source 2 have been
synchronized), or
-- Monitoring stage (Source parameters that are being monitored are exceeded their
threshold limits or relevant changes have occurred).
When any of these stages is completed properly (depending on the task type),
action with this condition will perform.
'Error': action will start when task has not performed properly and produced an
error. This error may occur at any previous stage of task scenario. Please note
that this action will only work if task 'on error' behaviour is set to 'continue task
execution' (see Task error handling for details), otherwise this action will not start.
It is also recommended put action with this condition at the end of the task
scenario, so it can catch any errors that have occurred in a course of task
performance.
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'No changes': this condition is the opposite to the 'Success'--when nothing
happens at any of the stages described above: no files have been transferred
between Source and Target(s), Source parameters that are being monitored are
within their threshold limits or no relevant changes have occurred.

5.8.1.5

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Screen Pop-up
Topic Content
Pop-up Message
Additional File Filter
Miscellaneous

This option defines action properties for a screen pop-up window notification.

Pop-up Message
Text

A message text that will be displayed in a pop-up window. Macros can be used
here.

Pop-up type

If a message is associated with a particular type of event, an icon can be added to
the pop-up window helping to swiftly identify the category of message. Currently, all
messages can be classified as follows:
'None': no icon is displayed.
'Error': a red cross icon is displayed.
'Info': a blue information icon is displayed.
'Warning': a yellow warning icon is displayed.

Additional File Filter
This option is visible and applies if, and only if, the action is a PART of the Backup step of the
Task Scenario.
Additional File Filter distinguishes files by mask determining to which file(s) this particular action will or
will not apply. In all other respects it is no different from the Additional File Filter that exists in every
Target.
Included files

A list of file masks that describe files to which this particular action will apply.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
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Included Files (if in use). Otherwise, this action will not apply to any files.
Excluded files

A list of file masks that describe files to which this particular action will not apply.

Miscellaneous
Condition

This option is visible and applies if, and only if, the action is located BELOW
the Backup, Two-Way Synchronization, Monitoring, or Clean-up step of the
Task Scenario.
This is a description of an event upon occurrence of which this action will be
performed. The event relates either to Source or to task generally. The following
events are covered:
'Always': action is event-neutral and will always start when AnyFileBckup reaches
it at the Task Scenario.
'Success': the term 'success' refers to successful completion of either:
-- Backup stage (all files have been transferred from Source to Target(s) and other
actions within Backup have been performed), or
-- Two-Way Synchronization stage (Source 1 and Source 2 have been
synchronized), or
-- Monitoring stage (Source parameters that are being monitored are exceeded their
threshold limits or relevant changes have occurred).
When any of these stages is completed properly (depending on the task type),
action with this condition will perform.
'Error': action will start when task has not performed properly and produced an
error. This error may occur at any previous stage of task scenario. Please note
that this action will only work if task 'on error' behaviour is set to 'continue task
execution' (see Task error handling for details), otherwise this action will not start.
It is also recommended put action with this condition at the end of the task
scenario, so it can catch any errors that have occurred in a course of task
performance.
'No changes': this condition is the opposite to the 'Success'--when nothing
happens at any of the stages described above: no files have been transferred
between Source and Target(s), Source parameters that are being monitored are
within their threshold limits or no relevant changes have occurred.

Pop-up colour

A background colour of the pop-up window.

Pop-up position

A position of the pop-up window on the screen. The following options are available:
'Top left': the pop-up window will appear in the top left corner of the your desktop.
'Top right': the pop-up window will appear in the top right corner of the your
desktop.
'Bottom left': the pop-up window will appear in the bottom left corner of the your
desktop.
'Bottom right': the pop-up window will appear in the bottom right corner of the your
desktop.
'Top left overlay': the pop-up window will appear in the top left corner of the your
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desktop and if more than one message appears, the newer will overlay the older
(instead of the newer appearing under, for top positions, or above, for bottom
positions, the older).
'Desk top centre overlay': the pop-up window will appear in the centre of the your
desktop and if more than one message appears, the newer will overlay the older.

Timeout (sec)

A time limit in seconds for displaying the pop-up window. Upon expiration of this
time limit the pop-up window will automatically close and cannot be re-opened
manually.
By default, an infinite time limit is applied ('0' (zero) stands for infinitive). If left blank,
AnyFileBackup will automatically insert '0' (zero) as a time limit value.

5.8.2

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Management Actions
This section explains how to configure AnyFileBackup actions that control other applications or
AnyFileBackup tasks, namely:
Third party applications installed on your system that may be started or stopped
A time delay that may be inserted between actions in the Task Scenario
User sessions
Other AnyFileBackup tasks
System variables
System services

5.8.2.1

Start Application
Topic Content
Application
Additional File Filter
Miscellaneous

This option defines action properties for launching external applications (both executable and nonexecutable). It may be necessary to launch the Task Processor with system administrator's permissions
to execute this action.

Application
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Run file

A full path and application file that will be executed by AnyFileBackup. Executable
applications (that have EXE, COM, or BAT extensions) will be launched as usual;
non-executable files (for example, DOC, TXT, etc) will be opened with an associated
default application (default application can be set manually in Windows).

Parameters

A command line parameter that will be added after the file name. Only applicationspecific (that is application that is launched) parameters, macros, and commands
(if any) are permitted in this field.

Run in

A local or LAN folder (but not FTP or cloud) where an executable application will be
launched (not required for non-executable files). This is particularly necessary when
a command line parameter (see above) is a file located in a folder other than the
executable application's installation folder (otherwise it will be necessary to include
a full path to that file as a command line parameter; when you specify 'Run in' folder
it is enough to specify filename only as a command line parameter).
If left blank, the application will run in the folder set in the 'Run file' field above. If
there is no path in the 'Run file' field, then it will run in AnyFileBackup current
installation location.

Connect through

'--': you connect to a file directly.
'Remote account': access to a file requires a remote computer address,
username, and password. Please read below how to select, access, and
configure your account on a remote computer.

Account name

If you connect to a file located on a remote computer, here you may select your
pre-configured remote account. If there is none, or you need to create a new one,
access remote account properties as described below.

Account
properties

Click the 'Edit' button to access the Remote Accounts manager where you can
create and configure your remote accounts. Detailed information about this can be
found here.

Additional File Filter
This option is visible and applies if, and only if, the action is a PART of the Backup step of the
Task Scenario.
Additional File Filter distinguishes files by mask determining to which file(s) this particular action will or
will not apply. In all other respects it is no different from the Additional File Filter that exists in every
Target.
Included files

A list of file masks that describe files to which this particular action will apply.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, this action will not apply to any files.

Excluded files

A list of file masks that describe files to which this particular action will not apply.

Miscellaneous
Condition
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This is a description of an event upon occurrence of which this action will be
performed. The event relates either to Source or to task generally. The following
events are covered:
'Always': action is event-neutral and will always start when AnyFileBckup reaches
it at the Task Scenario.
'Success': the term 'success' refers to successful completion of either:
-- Backup stage (all files have been transferred from Source to Target(s) and other
actions within Backup have been performed), or
-- Two-Way Synchronization stage (Source 1 and Source 2 have been
synchronized), or
-- Monitoring stage (Source parameters that are being monitored are exceeded their
threshold limits or relevant changes have occurred).
When any of these stages is completed properly (depending on the task type),
action with this condition will perform.
'Error': action will start when task has not performed properly and produced an
error. This error may occur at any previous stage of task scenario. Please note
that this action will only work if task 'on error' behaviour is set to 'continue task
execution' (see Task error handling for details), otherwise this action will not start.
It is also recommended put action with this condition at the end of the task
scenario, so it can catch any errors that have occurred in a course of task
performance.
'No changes': this condition is the opposite to the 'Success'--when nothing
happens at any of the stages described above: no files have been transferred
between Source and Target(s), Source parameters that are being monitored are
within their threshold limits or no relevant changes have occurred.
Wait until
completion

If enabled, task will wail until an executable application is closed (that is unloaded
from system memory) or, in case of a non-executable file, until a file is no longer
opened with an application that has been used to open it.
Please use this option with caution because it may significantly delay task
performance if some application does not work correctly and remains running for a
long time. To eliminate this risk please consider using the 'Timeout' option (see
below).

Timeout

A time limit in seconds for waiting a file to be closed as described in the 'Wait until
completion' section (see above). Upon expiration of this time limit task will continue
as usual despite that a file may still be running or opened. It is recommended to
use a time limit.
By default, 180 seconds timeout is applied. If left blank, AnyFileBackup will
automatically insert 180 seconds as a timeout value.
'0' (zero) means that task will wait indefinitely for a file to be closed.
This option activates only when the 'Wait until completion' option is enabled.

Verify settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
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remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.
Title

5.8.2.2

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Stop Application
Topic Content
Application
Additional File Filter
Miscellaneous

This option defines action properties for stopping (that is completely unloading from a system memory) of
any third-party applications. It may be necessary to launch the Task Processor with system
administrator's permissions to execute this action.

Application
Application to
stop

A name of a third-party application that is active in a system memory and that will
be stopped (unloaded from system memory) by AnyFileBackup. You may select it
either from a drop-down list (which contains currently running memory processes)
or type a process name manually. The selected application will not be uninstalled,
just removed from a system memory and will no longer be running until launched
again.
Please note that there should be a complete match (as it is displayed in the
Process List in Windows Task Manager) and no macros are permitted.

Application list

Press the 'Refresh' button to update the list of currently running applications.

Additional File Filter
This option is visible and applies if, and only if, the action is a PART of the Backup step of the
Task Scenario.
Additional File Filter distinguishes files by mask determining to which file(s) this particular action will or
will not apply. In all other respects it is no different from the Additional File Filter that exists in every
Target.
Included files

A list of file masks that describe files to which this particular action will apply.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, this action will not apply to any files.

Excluded files

A list of file masks that describe files to which this particular action will not apply.

Miscellaneous
Condition
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the Backup, Two-Way Synchronization, Monitoring, or Clean-up step of the
Task Scenario.
This is a description of an event upon occurrence of which this action will be
performed. The event relates either to Source or to task generally. The following
events are covered:
'Always': action is event-neutral and will always start when AnyFileBckup reaches
it at the Task Scenario.
'Success': the term 'success' refers to successful completion of either:
-- Backup stage (all files have been transferred from Source to Target(s) and other
actions within Backup have been performed), or
-- Two-Way Synchronization stage (Source 1 and Source 2 have been
synchronized), or
-- Monitoring stage (Source parameters that are being monitored are exceeded their
threshold limits or relevant changes have occurred).
When any of these stages is completed properly (depending on the task type),
action with this condition will perform.
'Error': action will start when task has not performed properly and produced an
error. This error may occur at any previous stage of task scenario. Please note
that this action will only work if task 'on error' behaviour is set to 'continue task
execution' (see Task error handling for details), otherwise this action will not start.
It is also recommended put action with this condition at the end of the task
scenario, so it can catch any errors that have occurred in a course of task
performance.
'No changes': this condition is the opposite to the 'Success'--when nothing
happens at any of the stages described above: no files have been transferred
between Source and Target(s), Source parameters that are being monitored are
within their threshold limits or no relevant changes have occurred.

5.8.2.3

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Time Delay
Topic Content
Time Delay
Additional File Filter
Miscellaneous

This option defines action properties for a delay (pause) that can be inserted almost at any stage of the
task scenario.

Time Delay
Delay value

A period of time in seconds which defines for how long task will pause before
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continuing to the next step of task scenario. After delay has expired, task will
continue as usual.
This option may be useful to decrease workload on computer (insert a delay in
Backup so there will a delay between transfer of each file from Source to Target(s))
or to prevent mail server from treating AnyFileBackup e-mails as spam (frequent emails may be treated as spam and if you actually send many e-mails, it is
recommended to insert a delay between e-mails sending).

Additional File Filter
This option is visible and applies if, and only if, the action is a PART of the Backup step of the
Task Scenario.
Additional File Filter distinguishes files by mask determining to which file(s) this particular action will or
will not apply. In all other respects it is no different from the Additional File Filter that exists in every
Target.
Included files

A list of file masks that describe files to which this particular action will apply.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, this action will not apply to any files.

Excluded files

A list of file masks that describe files to which this particular action will not apply.

Miscellaneous
Condition

This option is visible and applies if, and only if, the action is located BELOW
the Backup, Two-Way Synchronization, Monitoring, or Clean-up step of the
Task Scenario.
This is a description of an event upon occurrence of which this action will be
performed. The event relates either to Source or to task generally. The following
events are covered:
'Always': action is event-neutral and will always start when AnyFileBckup reaches
it at the Task Scenario.
'Success': the term 'success' refers to successful completion of either:
-- Backup stage (all files have been transferred from Source to Target(s) and other
actions within Backup have been performed), or
-- Two-Way Synchronization stage (Source 1 and Source 2 have been
synchronized), or
-- Monitoring stage (Source parameters that are being monitored are exceeded their
threshold limits or relevant changes have occurred).
When any of these stages is completed properly (depending on the task type),
action with this condition will perform.
'Error': action will start when task has not performed properly and produced an
error. This error may occur at any previous stage of task scenario. Please note
that this action will only work if task 'on error' behaviour is set to 'continue task
execution' (see Task error handling for details), otherwise this action will not start.
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It is also recommended put action with this condition at the end of the task
scenario, so it can catch any errors that have occurred in a course of task
performance.
'No changes': this condition is the opposite to the 'Success'--when nothing
happens at any of the stages described above: no files have been transferred
between Source and Target(s), Source parameters that are being monitored are
within their threshold limits or no relevant changes have occurred.

5.8.2.4

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

End User Session
Topic Content
General
Additional File Filter
Miscellaneous

This option defines action properties for ending the current user's session in Windows. It may be
necessary to launch the Task Processor with system administrator's permissions to execute this action.

General
End session by

The current user's session may be ended in various ways. The following options are
available:
'Hibernate computer': also known as 'suspend to disk', this option powers down
the computer but at the same time it retains its state.
'Logoff user': the current user's session in Windows is ended by logging off from
the current user's account (that is the user who has launched AnyFileBackup).
'Restart computer': computer is fully rebooted.
'Shutdown computer': computer's power is fully off.
'Sleep': previously known as 'Stand by' in WindowsXP, computer is 'paused' by
entering into a power-saving mode.

Additional File Filter
This option is visible and applies if, and only if, the action is a PART of the Backup step of the
Task Scenario.
Additional File Filter distinguishes files by mask determining to which file(s) this particular action will or
will not apply. In all other respects it is no different from the Additional File Filter that exists in every
Target.
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A list of file masks that describe files to which this particular action will apply.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, this action will not apply to any files.

Excluded files

A list of file masks that describe files to which this particular action will not apply.

Miscellaneous
Condition

This option is visible and applies if, and only if, the action is located BELOW
the Backup, Two-Way Synchronization, Monitoring, or Clean-up step of the
Task Scenario.
This is a description of an event upon occurrence of which this action will be
performed. The event relates either to Source or to task generally. The following
events are covered:
'Always': action is event-neutral and will always start when AnyFileBckup reaches
it at the Task Scenario.
'Success': the term 'success' refers to successful completion of either:
-- Backup stage (all files have been transferred from Source to Target(s) and other
actions within Backup have been performed), or
-- Two-Way Synchronization stage (Source 1 and Source 2 have been
synchronized), or
-- Monitoring stage (Source parameters that are being monitored are exceeded their
threshold limits or relevant changes have occurred).
When any of these stages is completed properly (depending on the task type),
action with this condition will perform.
'Error': action will start when task has not performed properly and produced an
error. This error may occur at any previous stage of task scenario. Please note
that this action will only work if task 'on error' behaviour is set to 'continue task
execution' (see Task error handling for details), otherwise this action will not start.
It is also recommended put action with this condition at the end of the task
scenario, so it can catch any errors that have occurred in a course of task
performance.
'No changes': this condition is the opposite to the 'Success'--when nothing
happens at any of the stages described above: no files have been transferred
between Source and Target(s), Source parameters that are being monitored are
within their threshold limits or no relevant changes have occurred.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.
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Other Task
Topic Content
Other Task
Additional File Filter
Miscellaneous

This option defines action properties for controlling another existing AnyFileBackup task.

Other Task
Task name

A name of an existing AnyFileBackup task
AnyFileBackup.

that

will

be managed by

Task command

A command that is sent to another task. The following commands are supported:
'Start task ': this is an equivalent of pressing the 'Activate Task ' and 'Start Task
Manually' buttons on the panel in the Main Window (therefore, it is irrelevant
whether another task has already been activated or not). However, if task's '
Activation type' is set to 'Disabled', this task will not start and this will be
considered as an error.
'Interrupt task ': another task will be stopped but will remain in an active state
waiting for next start event.
'Deactivate task ': this is an equivalent of pressing the 'Deactivate Task ' button on
the panel in the Main Window and will completely deactivate another task.

Additional File Filter
This option is visible and applies if, and only if, the action is a PART of the Backup step of the
Task Scenario.
Additional File Filter distinguishes files by mask determining to which file(s) this particular action will or
will not apply. In all other respects it is no different from the Additional File Filter that exists in every
Target.
Included files

A list of file masks that describe files to which this particular action will apply.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, this action will not apply to any files.

Excluded files

A list of file masks that describe files to which this particular action will not apply.

Miscellaneous
Condition

This option is visible and applies if, and only if, the action is located BELOW
the Backup, Two-Way Synchronization, Monitoring, or Clean-up step of the
Task Scenario.
This is a description of an event upon occurrence of which this action will be
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performed. The event relates either to Source or to task generally. The following
events are covered:
'Always': action is event-neutral and will always start when AnyFileBckup reaches
it at the Task Scenario.
'Success': the term 'success' refers to successful completion of either:
-- Backup stage (all files have been transferred from Source to Target(s) and other
actions within Backup have been performed), or
-- Two-Way Synchronization stage (Source 1 and Source 2 have been
synchronized), or
-- Monitoring stage (Source parameters that are being monitored are exceeded their
threshold limits or relevant changes have occurred).
When any of these stages is completed properly (depending on the task type),
action with this condition will perform.
'Error': action will start when task has not performed properly and produced an
error. This error may occur at any previous stage of task scenario. Please note
that this action will only work if task 'on error' behaviour is set to 'continue task
execution' (see Task error handling for details), otherwise this action will not start.
It is also recommended put action with this condition at the end of the task
scenario, so it can catch any errors that have occurred in a course of task
performance.
'No changes': this condition is the opposite to the 'Success'--when nothing
happens at any of the stages described above: no files have been transferred
between Source and Target(s), Source parameters that are being monitored are
within their threshold limits or no relevant changes have occurred.
Wait until
completion

If enabled, task will wail until another AnyFileBackup task is finished (that is when
one task scenario round is fully completed, or stopped because of an error (as the
case may be), and entered in into a passive state waiting for the next scheduled
start).
Please use this option with caution because it may significantly delay task
performance if another AnyFileBackup task transfers significant number of files or
large files or connection speed between Source and Target is low. To eliminate this
risk please consider using the 'Timeout' option (see below).

Timeout

A time limit in seconds for waiting another AnyFileBackup task to be finished as
described in the 'Wait until completion' section (see above). Upon expiration of this
time limit task will continue as usual despite that another AnyFileBackup task may
still be running. It is recommended to use a time limit.
By default, 180 seconds timeout is applied. If left blank, AnyFileBackup will
automatically insert 180 seconds as a timeout value.
'0' (zero) means that task will wait indefinitely for another AnyFileBackup task to be
finished.
This option activates only when the 'Wait until completion' option is enabled.

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
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default title. Press the 'Apply' button for changes to take effect.

5.8.2.6

Set Variable
Topic Content
Windows Environmental Variable
Additional File Filter
Miscellaneous

This option defines action properties for setting up a Windows Environmental Variable which can be
permanently set and placed in Windows list of Environmental Variables.

Windows Environmental Variable
General

Environment variables are a set of strings that can affect the way Windows
applications and system processes behave on a computer. The strings may contain
information about drive, path, filename, etc. For example:
DATE expands to the current date. The date is displayed according to the current
user's date format preferences.
TIME points to the current time. The time is displayed according to the current
user's time format preferences.
AppData Contains the full path to the Application Data folder.
ProgramFiles points to Program Files directory. The default value is 'C:\Program
Files\'.
CommonProgramFiles points to Common Files directory. The default is 'C:
\Program Files\Common Files\'.
SystemDrive the drive upon which the system folder is located.
USERNAME displays the active users login.
WinDir points to the Windows directory.
When you set the same environmental variable twice, the most recent value will be
used replacing any previous value.
More information about
documentation.

Format

environment

variables

find in the Windows

help

The format of environmental variable in AnyFileBackup should be [Variable name]=
[Variable value]. You can set any variable name. No space symbols are allowed.
You may use ${ENVGET} macros to recall environmental variables that you have
created. Read more about Macro strings.
Examples:
TASKNAME=Replication_over_LAN
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ANYFILEBACKUPHOME=www.any-file-backup.com

Additional File Filter
This option is visible and applies if, and only if, the action is a PART of the Backup step of the
Task Scenario.
Additional File Filter distinguishes files by mask determining to which file(s) this particular action will or
will not apply. In all other respects it is no different from the Additional File Filter that exists in every
Target.
Included files

A list of file masks that describe files to which this particular action will apply.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, this action will not apply to any files.

Excluded files

A list of file masks that describe files to which this particular action will not apply.

Miscellaneous
Condition

This option is visible and applies if, and only if, the action is located BELOW
the Backup, Two-Way Synchronization, Monitoring, or Clean-up step of the
Task Scenario.
This is a description of an event upon occurrence of which this action will be
performed. The event relates either to Source or to task generally. The following
events are covered:
'Always': action is event-neutral and will always start when AnyFileBckup reaches
it at the Task Scenario.
'Success': the term 'success' refers to successful completion of either:
-- Backup stage (all files have been transferred from Source to Target(s) and other
actions within Backup have been performed), or
-- Two-Way Synchronization stage (Source 1 and Source 2 have been
synchronized), or
-- Monitoring stage (Source parameters that are being monitored are exceeded their
threshold limits or relevant changes have occurred).
When any of these stages is completed properly (depending on the task type),
action with this condition will perform.
'Error': action will start when task has not performed properly and produced an
error. This error may occur at any previous stage of task scenario. Please note
that this action will only work if task 'on error' behaviour is set to 'continue task
execution' (see Task error handling for details), otherwise this action will not start.
It is also recommended put action with this condition at the end of the task
scenario, so it can catch any errors that have occurred in a course of task
performance.
'No changes': this condition is the opposite to the 'Success'--when nothing
happens at any of the stages described above: no files have been transferred
between Source and Target(s), Source parameters that are being monitored are
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within their threshold limits or no relevant changes have occurred.

5.8.2.7

Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

System Service
Topic Content
System Service
Additional File Filter
Miscellaneous

This option defines action properties for controlling Windows system services. It may be necessary to
launch the Task Processor with system administrator's permissions to execute this action.

System Service
Service name

A name of a Windows system service that will be managed by AnyFileBackup. Use
drop-down list to find a service currently installed in your system.

Service list

Click the 'Refresh' button to update the service list (see above).

Service action

A type of command that will be sent to a selected system service. the following
options are available:
'Start': a selected service will be started. If it is already started nothing will
happen, and if it is disabled this will be considered as an error.
'Stop': a selected service will be stopped. If it is already stopped or disabled,
nothing will happen. Please note, that some services cannot be stopped.
'Pause': a selected service will be paused. If it is already paused, stopped, or
disabled, nothing will happen.
'Resume': a selected service will be resumed. If it is already started, stopped, or
disabled, nothing will happen. Please note, that some services cannot be paused
-- they can only be stopped.

Connect through

'--': you connect to a services directly.
'Remote account': access to a services requires a remote computer address,
username, and password. Please read below how to select, access, and
configure your account on a remote computer.

Account name

If you connect to a services located on a remote computer, here you may select
your pre-configured remote account. If there is none, or you need to create a new
one, access remote account properties as described below.

Account
properties

Click the 'Edit' button to access the Remote Accounts manager where you can
create and configure your remote accounts. Detailed information about this can be
found here.
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Additional File Filter
This option is visible and applies if, and only if, the action is a PART of the Backup step of the
Task Scenario.
Additional File Filter distinguishes files by mask determining to which file(s) this particular action will or
will not apply. In all other respects it is no different from the Additional File Filter that exists in every
Target.
Included files

A list of file masks that describe files to which this particular action will apply.
Please note, that these masks should somehow overlap with masks specified in
SOURCE > Additional File Filter > Included Files (if in use) and should not be
completely excluded by masks specified in SOURCE > Additional File Filter >
Included Files (if in use). Otherwise, this action will not apply to any files.

Excluded files

A list of file masks that describe files to which this particular action will not apply.

Miscellaneous
Condition

This option is visible and applies if, and only if, the action is located BELOW
the Backup, Two-Way Synchronization, Monitoring, or Clean-up step of the
Task Scenario.
This is a description of an event upon occurrence of which this action will be
performed. The event relates either to Source or to task generally. The following
events are covered:
'Always': action is event-neutral and will always start when AnyFileBckup reaches
it at the Task Scenario.
'Success': the term 'success' refers to successful completion of either:
-- Backup stage (all files have been transferred from Source to Target(s) and other
actions within Backup have been performed), or
-- Two-Way Synchronization stage (Source 1 and Source 2 have been
synchronized), or
-- Monitoring stage (Source parameters that are being monitored are exceeded their
threshold limits or relevant changes have occurred).
When any of these stages is completed properly (depending on the task type),
action with this condition will perform.
'Error': action will start when task has not performed properly and produced an
error. This error may occur at any previous stage of task scenario. Please note
that this action will only work if task 'on error' behaviour is set to 'continue task
execution' (see Task error handling for details), otherwise this action will not start.
It is also recommended put action with this condition at the end of the task
scenario, so it can catch any errors that have occurred in a course of task
performance.
'No changes': this condition is the opposite to the 'Success'--when nothing
happens at any of the stages described above: no files have been transferred
between Source and Target(s), Source parameters that are being monitored are
within their threshold limits or no relevant changes have occurred.
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Enabled

If enabled, this action is active and will be used in Scenario. If disabled, it will
remain in the Task Scenario but will be completely ignored by task. To distinguish it
from enabled actions, disabled actions are strokeout and coloured in gray.

Title

This is a custom name that will be displayed in the Task Scenario instead of the
default title. Press the 'Apply' button for changes to take effect.

Miscelaneous Actions
This section explains how to configure AnyFileBackup actions that do not fit the categories of Management
or Messaging:
Delete empty folders

5.8.3.1

Delete Empty Folders
This action deletes empty subfolders in Source and has no specific settings.
It can be placed only immediately after the Backup step of task scenario.

6

Program Settings
In this section you can read how to configure AnyFileBackup itself. Settings in this section apply to all
tasks but some of them may be overridden by task-specific settings. The following chapters are included in
this section:
Common Settings: date and time formats, interface and autosave settings.
Network Settings: timeouts for FTP, SMTP etc, UNIX characters and ASCI conversion.
Logging Settings: everything related to configuring how AnyFileBackup stores loges its history of
activities.
Accounts: properties that defines how AnyFileBackup accesses certain locations (FTP, Amazon,
Mailbox etc.) which require login, password, certificate etc.
Error Handling: everything related to how AnyFileBackup responds to errors that might occur during file
transfer or elsewhere during task performance.
Task Processor: everything related to configuring the Task Processor, the core of AnyFileBackup.

6.1

Common
Topic Content
Appearance
System
Access Permissions for Users

This group of options defines some basis program settings like standard date and time format,
appearance, etc.

Appearance
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A format of a date that is used throughout in AnyFileBackup. You may choose a
pre-defined format or specify your own format using the following letters:
d: a day number
m: a month number; use 'mmm' (without quotes) to display a month name
instead of a month number.
y: a digit of a year

Time format

A format of time that is used throughout in AnyFileBackup. You may choose a predefined format or specify your own format using the following letters:
h: hours
n: minutes
s: seconds

Hide after start

If enabled, AnyFileBackup will be minimised to tray immediately after start.

Always show
navigation tree

If enabled, a tree on the left in the Task Properties window will be visible every time
Task Properties is opened even if the tree has been previously hidden. If disabled,
AnyFileBackup will use tree visibility settings depending on whether the tree has
been hidden or made visible by pressing the 'Show/Hide Tree' button (F12).

System
Autosave task
settings

If enabled, AnyFileBackup will automatically save any changes made in Task
Properties without prompting. If disabled, a confirmation window will appear every
time changes have been made.

Configuration
files

A full path and filename of AnyFileBackup configuration file. This file may be saved
anywhere and with any filename and extension.

Communication
port

A port through which AnyFileBackup communicates with Task Processor. It can be
changed to any other unused port. You may view a list of used ports by typing
'netstat' (without quotes) in cmd.exe (can be launched from 'Start' > 'Run').

Special settings

Click the 'Configure' button to open a window where you can manually add certain
special settings. Please do not use this option unless specifically advised by
support service.

Access Permissions for Users
Access
restrictions

If enabled, User Accounts restrictions will apply. This means that different users will
have different access level to AnyFilebacup. If no users exist in User Accounts,
then no restrictions will apply. Read below how to create and configure user
accounts.

Access
properties

Click the 'Configure' button to access the User Accounts manager where you can
create and configure your user accounts. Detailed information about this can be
found here.
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Network
Retry count

a number of attempts AnyFileBackup will make to access Source, to copy file, or
to send an e-mail, etc. When none of these attempts is successful, AnyFileBackup
will treat this as an error and will proceed according to the Common Error Handling
Rules or Task-Specific Error Handling Rules.

SMTP timeout

an interval in seconds after which AnyFileBackup will attempt to send another
SMTP request when the previous one has failed.

Ping timeout

an interval in seconds after which AnyFileBackup will attempt to send another Ping
request when the previous one has failed.

POP3 timeout

an interval in seconds after which AnyFileBackup will attempt to send another
POP3 request when the previous one has failed.

FTP/HTTP
timeout

an interval in seconds after which AnyFileBackup will attempt to send another FTP/
HTTP request when the previous one has failed.

Character
translation

This option is relevant for FTP only. File names in UNIX/LINUX may contain
symbols which are not allowed in Windows and such files cannot be transferred to
Windows-based computers. Examples of such symbols include: "<" (less-than
sign), ">" (greater-than sign), ":" (colon), etc.
In this field you can specify a replacement for these characters.
Example: a file with the name <File.txt> (UNIX) will have name %3cFile.txt%3e
(Windows).
To specify a new value, please use the following format (without brackets):
[UNIX/LINUX symbol]=[replacement symbol]

Use FTP ASCII
transfer

A list of file templates that defines files which AnyFileBackup will transfer with 8-bit
ASCII convertion. This means that only Latin characters will remain in these files
and any other characters (non-Latin or non-printable characters) will be removed.
This mode is suitable for plain text files only.
Files that are not in that list will be transmitted as binary.

6.3

Logging
Topic Content
Event List
Log File

This group of option defines logging properties of AnyFileBackup.

Event List
Event List
entries

A maximum number of entries in AnyFileBackup Event List displayed in the Main
Window. For effective memory usage it is recommended to keep the default number
of 200 entries.

Event List level

Type of events that will be displayed in AnyFileBackup Event List. It is generally
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recommended not to use the 'Debug' mode unless recommended by support
service.

Log File
Logging is
enabled

if enable, AnyFileBackup will keep tasks activity log in a log file as defined below.

Log file folder

A full path to a log file. When changed, the changes will take effect after Task
Processor restarts.

Keep log data

A number of days during which log file records will be kept. After this timelimit
expires, older records will be removed from a log file.
Set number of days to '0' (zero) to disable log file cleaning.

Old log records

6.4

Press the 'Remove' button to remove all records in AnyFileBackup log file that
[records] have been created to date. The task processor must be launched to
complete this task.

Accounts
Account is a group of settings that defines how AnyFileBackup accesses certain locations (FTP, Mailbox
etc.). Once configured, the same account may be used with multiple tasks by simply selecting it from a
drop-down list in task properties. Having an account is a convenient way to store all relevant settings in one
place and use it with one click where you need it.
The following accounts are currently available in AnyFileBackup:
Access Properties to configure access rights and permissions for AnyFileBackup users
Amazon S3 to access buckets located in Amazon Simple Storage Service
Certificate for access SFTP and FTPS servers
FTP
Google Drive for access Google's cloud storage
HTTP
Incoming E-Mail (POP3 and IMAP)
Microsoft OneDrive for access Microsoft's cloud storage
Outgoing E-Mail (SMTP and IMAP)
Password for archive passwords
PGP
Ping to check whether a server is on-line
Recipient List to crate lists of e-mail recipients
Remote Computer
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SMS to configure access to an Android-power smarphone

6.4.1

Access Properties
Topic Content
General
Miscellaneous

This group of option defines users' permissions to access, configure, and manage AnyFileBackup and its
tasks.

User
User name

A log in name that is used to access this account. The name is case neutral that
means it does not distinguish between upper or lower case letters.

Password

A secret combination of symbols that is used to access your server, computer, or
account.

Confirm
password

Retype the password to confirm that it was entered correctly.

Enabled

If enabled, this account will be active and a person who knows user name and
password associated with this account will be able to use them to access
AnyFileBackup.

Administrator

If enabled, a user with this status will have all permissions available and will be able
to set permissions for any other users. This means that if there are two
administrator accounts, then one will be able to set a new password for another or
remove the administrator's status of another.

Permissions
Activate/
deactivate tasks

A permission to activate and deactivate task(s) and start tasks manually.

Start/stop Task
Processor

A permission to start Task Processor as a system service and as an application,
and to stop and terminate Task Processor. Configuring Task Processor is covered
by the 'Edit program and extension settings' permission.

Edit program
and extension
settings

A permission to change all AnyFileBackup Program Settings and Extension
Settings. This permission does NOT permit managing (change, add, delete)
other users' access permissions -- only administrators are allowed to do this.

Remote access

A permission to AnyFileBackup remotely when the Remote Console extension is
installed.

Access to
reports

A permission to view, add new (including to create custom), and delete reports.

Edit task
properties

A permission to change any task settings, including task group settings.

Access to
groups

A permission to view and configure tasks in a particular group or groups; in other
groups task names will remain visible but no task settings will be visible. To add a
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group right-click in this field and select a group from the list. Enabling this
permission in itself does not permit a user to view or change task settings in the
selected group. Enable the 'Edit task s settings' above to permit changing task
settings.

Miscellaneous

6.4.2

Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

Amazon S3
Topic Content
Introduction
General
Miscellaneous

This group of option defines properties for key files that are used to access Amazon S3 buckets.

Introduction
Access and secret keys are used to access Amazon S3 folders (known as 'buckets'). Please follow this
guide to create new or find existing keys:
(1) If you already have created Amazon S3 'Access Key' and 'Secret Key', you may find them in a key file
on your hard disk. If you do not have this file, there is no way to view a 'Secret Key' anywhere else.
Therefore, you need to create another 'Access Key' and 'Secret Key'.
(2) If you need to create new 'Access Key' and 'Secret Key', please do the following:
(a) Log in to you Amazon S3 account at https://console.aws.amazon.com
(b) At the top right corner click on a username and then select the 'Security Credentials' item from the
drop-down menu

2015 AAR Innovations (R)

140

AnyFileBackup

(c) Click on the 'Access Keys (Access Key ID and Secret Access Key)' item from the list

(d) Click the 'Create New Access Key' button. Please note, if you already have two (2) access k eys, this
button may be unavailable.

(e) In an opened window you will see your new 'Access Key' and 'Secret Key'. Please click the 'Download
Key File' button to download a backup copy of these keys and store them securely.
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General
Access key

An 'Access Key ID' for Amazon S3 account.

Secret key

A 'Secret Access Key' for Amazon S3 account.

Miscellaneous

6.4.3

Account name

A name of the current account that will be displayed in account list. If left blank,
the address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.

Used by the
following tasks

A list of tasks that use this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

Certificate
Topic Content
Current Keys
New Keys
Miscellaneous

This group of option defines properties for key files and certificates that are used to access FTP servers.
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Current Keys
Private and public keys are used to enhance security. Usually access to FTP servers or Amazon S3
cloud storage is secured by this method.
Private key file

A path to and filename of a private key. This file may have any extension and
usually located in a secured folder or disk. AnyFileBackup needs to have access to
this key every time it attempts to use it to access FTP server or Amazon S3.

Public key file

A path to and filename of a public key. This file may have any extension.
AnyFileBackup needs to have access to this key every time it attempts to use it to
access FTP server or Amazon S3.

Key password

If a private key requires a password to decrypt it, it must be entered here.
Otherwise, leave this field blank.

New Keys
New keys

If there are no private and public keys, they may be generated with AnyFileBackup
and then saved to disk for further usage.
The following parameters of the keys may be set up:
'Algorithm': an encryption algorithm which is used to generate keys and can be
either RSA or DSS (Digital Signature Standard)
'Key length': a length of a private key in bits which may be 128, 256, 512, 1024,
2048, or 4096 bits per key long
'Key format': OpenSSH, IETF, PuTTY

Miscellaneous

6.4.4

Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.

Used by the
following tasks

A list of tasks that use this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

FTP
Topic Content
General
Proxy Settings
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Security
FTP Settings
Miscellaneous

This group of option defines properties for accessing FTP server.

General
Host address

An address of FTP sever which normally looks like 'ftp.myserver.com' or an IPv4
address (for example, 192.168.0.100).

Host port

A port that AnyFileBackup will use to access FTP server. The default port is 21. If
left blank, the default port will be used automatically.

User name

A log in name that is used to access FTP server.

Password

A secret combination of symbols that is used to access your server, computer, or
account.

Confirm
password

Retype the password to confirm that it was entered correctly.

Proxy Settings
Address

An address of a proxy sever which normally looks like an IP address (for example,
192.168.0.100).

Port

A port that AnyFileBackup will use to access a proxy server. The most common
ports are 80, 8080, 3128.

Type

Proxy servers may require certain command (username and password) sequence.
The following sequences are supported:
USER -> PASS
USER ProxyUserName -> PASS ProxyPass -> SITE -> USER -> PASS
USER ProxyUserName -> PASS ProxyPass -> USER UserName@FTPServer ->
PASS
USER ProxyUserName -> PASS ProxyPass -> USER -> PASS
OPEN -> USER -> PASS
USER UserName@FTPServer -> PASS
USER ProxyUserName@FTPServer -> PASS ProxyPass -> USER -> PASS
USER UserName@FTPServer ProxyUserName -> PASS
USER UserName@ProxyUserName@FTPServer -> PASS Pass@ProxyPass
SOCKS4
SOCKS5
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User name

A log in name that is used to access proxy server.

Password

A secret combination of symbols that is used to access your server, computer, or
account.

Security
Security mode

If FTP server is accessed via encrypted connection, this option allows to specify the
type of encryption used. The following encryption methods are supported:
FTPS (also known as Implicit FTPS): an alder version of the FTP protocol where
AnyFileBackup uses SSL to connect to the FTP server.
SFTP (Secure Shell File Transfer Protocol) is a part of SSH2 protocol family.
However, FTP servers with SSH1 protocol may still support SFTP. We strongly
advise to check whether your FTP server supports SFTP connection; otherwise
connection security may be compramised.
SFTP is not as sophisticated as an ordinary FTP. It has less commands and
features, in particular SFTP does not support:
- passive mode
- IPv6
- proxy
- transfer type selection
- transfer resuming
- file attributes
- VMS OS
- some others
When any these options is selected for Source or Target (which is SFTP), the
above options simply will not work (for example, instead of passive mode
AnyFileBackup connect to the FTP server in active mode, etc.).
AUTH TLS (also known as Explicit FTPS or FTPES): a newer version of the FTP
protocol where AnyFileBackup send an AUTH command to request TLS.

Certificate
account

FTP server may use private and public keys as an additional level of security. Click
the 'Configure' button to access the Security Accounts manager where you can
create and configure your security accounts. Detailed information about this can be
found here.

FTP Settings
Use passive
mode

FTP client may work in active or passive mode. This mode defines how connection
with FTP server is established. Active mode requires additional incoming
connection. This may not be permitted by certain firewall policies. In this case the
passive mode is recommended.

FTP server type

There are various types of FTP servers. The following types are supported:
'Autodetect': the type of most FTP servers are identified by AnyFileBackup
automatically. In rare situations when it is impossible, please specify the type
FTP server manually (see below).
'UNIX/LINUX': a UNIX/LINUX-based FTP server
'VMS': an FTP server which runs Virtual Memory System
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'TFTP': a Trivial FTP server which has very limited functionality, including lack of
any authentication
Transfer type

The mode of file transfer between Source and FTP server. The following modes are
available:
'Auto': AnyFileBackup automatically determines which transfer mode is suitable
for a particular file. In particular, it takes into account files that are set for transfer
in ASCII mode only (see 'Program Settings' > 'Network' > 'Use FTP ASCII
transfer'). It is recommended to use this type of transfer.
'Binary': force to transfer all files in a binary mode. This is mode is suitable for all
types of files .
'ASCII': force to transfer all files in an ASCII mode. This is mode is suitable for
plain text files only.

Use IPv6 mode

Internet Protocol version 6 is the latest development of the Internet Protocol. It must
be supported by your ISP (Internet Service Provider) and it must be enabled in
Windows where AnyFileBackup is installed. If it is selected but not supported, an
older version of IPv4 will used instead.

Timezone shift

This option applies only when the 'Set original file timestamp' option is enabled in
Target FTP settings.
A time interval in minutes which allows to eliminate a time difference between a
Source computer (where AnyFileBackup is installed) and Target FTP server. This
may be necessary due to timezone differences.
The effect of this option is illustrated below (please see the examples).
Please note that some FTP servers do not allow changing file time and date. You
will also need appropriate FTP permissions to change file time and date.
Examples:
+60 min: suitable when AnyFileBackup is working in the United Kingdom (UTC
+0) and FTP server is located in Germany (UTC +1). Thus, a UK file created at
1.00 AM on 25.12.2010 is transferred to Germany, this file will have creation time
changed to 2.00 AM 25.12.2010 to reflect 1 hour time difference between the UK
and Germany.
-300 min: suitable when AnyFileBackup is working in the United Kingdom (UTC
+0) and FTP server is located in New York, USA (UTC -5). Thus, a UK file
created at 1.00 AM on 25.12.2010 is transferred to New York, USA, this file will
have creation time changed to 20.00 PM 24.12.2010 to reflect 5 hours time
difference between the UK and the USA.

Transform
names

If enabled, the 'Character translation' option (see Program Settings' > 'Network') will
be enabled for this particular FTP server. If disabled, characters in filenames will be
transferred as is. This option may be needed when files are transferred from a UNIX/
LINUX-based FTP server to a Windows-based computer.

File time modify
command

This option applies only when the 'Set original file timestamp' option is enabled in
Target FTP settings. It sets the method how file timestamp is modified by
AnyFileBackup on a particular FTP server.
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The following options are available:
'Auto': AnyFileBackup will automatically determine the most suitable method for
file timetamp modification.
'MDTM': please consult your FTP server documentation to ensure that it supports
this time modification command.
'MFTM': please consult your FTP server documentation to ensure that it supports
this time modification command.

File listing
command

This option sets the method how AnyFileBackup requests a file list from a particular
FTP server.
The following options are available:
'Auto': AnyFileBackup will automatically determine the most suitable method for
requestion a file list.
'LIST': please consult your FTP server documentation to ensure that it supports
this file list request method.
'MLSD': please consult your FTP server documentation to ensure that it supports
this file list request method.

Timeout

A time interval in seconds during which AnyFileBackup will wait for a response from
an FTP server. If no response is received during this time, AnyFileBackup will treat
this as an error and will proceed according to the Common Error Handling Rules or
Task-Specific Error Handling Rules.

Miscellaneous

6.4.5

Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.

Used by the
following tasks

A list of tasks that use this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

Google Drive
Topic Content
Introduction
General
Set Up Access to Google Drive
Miscellaneous
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This group of option defines properties for key files and certificates that are used to access Google (c)
Drive cloud.

Introduction
For AnyFileBackup to have access to Google Drive, it needs the 'Client ID' and 'Client secret'. These are
two secret keys that may be created in your Google account at https://console.developers.google.com
To create new 'Client ID' and 'Client secret' for AnyFileBackup, please follow this instruction.
(a) Log in to your Google account at https://console.developers.google.com/start
(b) Click on the 'Enable and manage APIs' link.

(c) On the next screen enter the 'Project name' (for example, 'AnyFileBackup'), choose whether you want
to receive informational messages from Google, accept the 'Terms of Service' and click the 'Create'
button.
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(d) Then you will see a confirmation message. You may close it.

(e) In the 'API Manager' go to 'Credentials' > 'Credentials' tab and click on the 'New credentials button'
selecting the 'OAuth client ID' item.
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(f) Most likely Google will ask you to create a so-called 'consent screen'. Press the 'Configure consent
screen' button to proceed.

(g) Fill in two fields: 'Email address' and 'Product name shown to users', then press the 'Save' button at
the bottom. You may also fill in other fields, but its optional.
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(h) At the next screen select 'Other' for the 'Application type' and enter the application 'Name' (for
example, 'AnyFileBackup'). Then press the 'Create' button.

(i) A confirmation window will show your newly created 'Client ID' and 'Client Secret'. Copy them to the
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relevant 'Client ID' and 'Client Secret' fields in AnyFileBackup Account Manager for Google Drive. Press
the 'OK' button to close this pop-up window.

(j) Leave the 'Credentials' section and go to the 'Overview' section. Type 'Drive API' in the search box as
shown below. Click the 'Drive API' link.

(k) Press the 'Enable API' button to enable authorised non-Google software to access your Google Drive.
Then you may sign out from your Google account.
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General
Client ID

A 'Client ID' specified in your Google account for AnyFileBackup.

Client secret

A 'Client secret' specified in your Google account for AnyFileBackup.

Authorisation

Displays AnyFileBackup authorisation status with Google Drive, which can be either
of:
'Authorisation required': means you need to grant an authorisation to
AnyFileBackup with Google Drive. To do this, press the 'Execute' in the 'Step 2:
Authorise' item of the 'Set Up Access to Google Drive' section below.
'Authorised': means AnyFileBackup has all necessary rights to access Google
Drive (copy / move files to and from Google Drive, etc) and no action is required
from you.

Set Up Access to Google Drive
Step 1:
Register

After pressing the 'Execute' button a default web browser window will open bringing
you to Google Developers Console starting page (you may be asked to enter your
Google account login and password). Please proceed with adding AnyFileBackup as
an application that can access Google Drive as described above.

Step 2: Authorise After pressing the 'Execute' button an internal web browser window will open bringing
you to a permissions management page (you may be asked to enter your Google
account login and password). You will be asked to grant the following permission to
AnyFileBackup:
'View and manage the files in your Google Drive', which includes:
'Upload, download, update, and delete files in your Google Drive'
'Create, access, update, and delete native Google documents in your Google
Drive'
'Manage files and documents in your Google Drive (e.g., search, organize, and
modify permissions and other metadata, such as title)'
You will be able to change these permissions at any time in your Google account
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settings (you may be asked to enter your Google account login and password):
https://security.google.com/settings/security/permissions?pli=1
Press the 'Allow' button at the bottom of the screen (you may need to scroll down) to
grant these permissions to AnyFileBackup. After that the browser window will
automatically close and the authorisation status in the 'General' section will
automatically change to 'Authorised'.

Miscellaneous
Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from General
section above will be used as the account name.

Notes

Any notes related to this account.

Used by the following
A list
tasks
of tasks that use this account.

6.4.6

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

HTTP
Topic Content
General
Proxy Settings
Miscellaneous

This group of option defines properties for accessing HTTP host.

General
Host address

An address of HTTP host which normally looks like 'www.website.com' or an IPv4
address (for example, 192.168.0.100).
When this account is used to connect to an Android-based smartphone (which has
its own IP address) in order to send SMS messages, use the address and port
displayed by the SMS Extension Client (smartphone side) installed on the Androidbased smartphone (for example: 192.168.1.104:8080).

User name

A log in name that is used to access HTTP host. It is required only for accessrestricted servers which are not publicly available. For most servers no user name
and password are required.

Password

A secret combination of symbols that is used to access your server, computer, or
account.
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Confirm
password

Retype the password to confirm that it was entered correctly.

Security mode

If an HTTP host can be accessed via an encrypted connection (SSL, a Secure
Sockets Layer), this option allows to enable it. Select 'None' to access HTTP host
via ordinary, not secured, connection. Secure Protocols extension is required to
use SLL connection.

Send method

A method used by AnyFileBackup for sending files to HTTP host.
The following options are available:
'POST': please consult HTTP host documentation to ensure that it supports this
method.
'POST form': please consult HTTP host documentation to ensure that it supports
this method.
'PUT': please consult HTTP host documentation to ensure that it supports this
method.

Form field name

This option applies only when the 'POST form' option is selected as a send method
(see above).
A name of field in an HTML-form file to be sent to HTTP host.

Proxy Settings
Address

An address of a proxy sever which normally looks like an IP address (for example,
192.168.0.100).

Port

A port that AnyFileBackup will use to access a proxy server. The most common
ports are 80, 8080, 3128.

Type

Proxy servers may require certain command (username and password) sequence.
The following sequences are supported:
USER -> PASS
USER ProxyUserName -> PASS ProxyPass -> SITE -> USER -> PASS
USER ProxyUserName -> PASS ProxyPass -> USER UserName@FTPServer ->
PASS
USER ProxyUserName -> PASS ProxyPass -> USER -> PASS
OPEN -> USER -> PASS
USER UserName@FTPServer -> PASS
USER ProxyUserName@FTPServer -> PASS ProxyPass -> USER -> PASS
USER UserName@FTPServer ProxyUserName -> PASS
USER UserName@ProxyUserName@FTPServer -> PASS Pass@ProxyPass
SOCKS4
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SOCKS5
User name

A log in name that is used to access proxy server.

Password

A secret combination of symbols that is used to access your server, computer, or
account.

Miscellaneous

6.4.7

Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.

Used by the
following tasks

A list of tasks that use this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

Incoming E-Mail
Topic Content
General
Security
Miscellaneous

This group of option defines properties for receiving e-mail massages from a mail server.

General
Mail server
address

An address of an external mail server which normally looks like pop.company.com
or imap.company.com (depending on the protocol selected) or an IP address.
Please consult relevant documentation for mail server address used by the mail
server you intend to use.

Mail server port

A port that AnyFileBackup will use to access the mail server. The common server
ports are 110 (for POP3 Regular and STARTTLS protocols) and 995 (for POP3 TLS
protocol). Please consult relevant documentation for port number used by the mail
server you intend to use.

User name

A log in name that is used to access the mail server. Please note that it may or
may not include mail server name itself. It may be just (without quotes) 'username'
OR 'username@mailserver.com'.

Password

A secret combination of symbols that is used to access your server, computer, or
account.
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Confirm
password

Retype the password to confirm that it was entered correctly.

Security
Protocol

A system protocol via which AnyFileBackup receives e-mails from the mail server.
The following protocols are supported:
POP3
IMAP
Please consult relevant documentation for protocol type that is used by the mail
server you intend to use.

Authentication
type

A method of authorisation that the mail server will accept. The following methods
are available:
Plain text login
APOP
AUTH LOGIN (uses Base64 encoding)
AUTH CRAM-MD5
AUTH CRAM-SHA1

Security mode

A type of connection to the mail server. The following methods are available:
None
Implicit (TLS Connection)
Explicit (STARTTLS)

Miscellaneous
Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.

Used by the
following tasks

A list of tasks that use this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.
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Microsoft OneDrive
Topic Content
Introduction
General
Set Up Access to OneDrive
Miscellaneous

This group of option defines properties for key files and certificates that are used to access Microsoft (c)
OneDrive cloud.

Introduction
For AnyFileBackup to have access to OneDrive, it needs the 'Client ID' and 'Client secret'. These are two
secret keys that may be created in your Microsoft account at https://account.live.com/developers/
(1) If you already have set up the 'Client ID' and 'Client secret' for AnyFileBackup or another application,
you may view them here: https://account.live.com/developers/applications/index

(2) If you need to create new 'Client ID' and 'Client secret' for AnyFileBackup, please follow this
instruction.
(a) Log in to your Microsoft account at https://account.live.com/developers/applications/create
(b) Enter 'AnyFileBackup' into the 'Application name' field and press the 'I accept' button.
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(c) On the next screen go to 'Settings' > 'API Settings' and Select 'YES' for the 'Mobile or desk top client
app' checkbox. The default value for the 'Restrict JWT issuing' is 'YES' -- do not change it.
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(d) Then go to 'Settings' > 'APP Settings'. Here you can view AnyFileBackup 'Client ID' and 'Client secret
'.

General
Client ID

A 'Client ID' specified in your Microsoft account for AnyFileBackup.

Client secret

A 'Client secret (v1)' specified in your Microsoft account for AnyFileBackup.

Authorisation

Displays AnyFileBackup authorisation status with OneDrive, which can be either of:
'Authorisation required': means you need to grant an authorisation to
AnyFileBackup with OneDrive. To do this, press the 'Execute' in the 'Step 2:
Authorise' item of the 'Set Up Access to OneDrive' section below.
'Authorised': means AnyFileBackup has all necessary rights to access OneDrive
(copy / move files to and from OneDrive, etc) and no action is required from you.

Set Up Access to OneDrive
Step 1:
Register

After pressing the 'Execute' button a default web browser window will open bringing
you to the application management page (you may be asked to enter your Microsoft
account login and password). Please proceed with adding AnyFileBackup as an
application that can access OneDrive as described above.

Step 2: Authorise After pressing the 'Execute' button an internal web browser window will open bringing
you to a permissions management page (you may be asked to enter your Microsoft
account login and password). You will be asked to grant the following permission to
AnyFileBackup:
'Access your info at any time'
'Access and edit your OneDrive'
'View photos and documents on OneDrive'
'Access your photos and videos and those shared with you'
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You will be able to change these permissions at any time in your Microsoft account
settings.
Press the 'Yes' button at the bottom of the screen (you may need to scroll down) to
grant these permissions to AnyFileBackup. After that the browser window will
automatically close and the authorisation status in the 'General' section will
automatically change to 'Authorised'.

Miscellaneous
Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from General
section above will be used as the account name.

Notes

Any notes related to this account.

Used by the following
A list
tasks
of tasks that use this account.

6.4.9

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

Outgoing E-Mail
Topic Content
General
Security
Default Sender
Miscellaneous

This group of option defines properties for sending e-mail massages through a mail server.

General
Mail server
address

An address of an external mail server which normally looks like smtp.company.com
or an IP address. Please consult relevant documentation for mail server address
used by the mail server you intend to use.

Mail server port

A port that AnyFileBackup will use to access the mail server. The common server
ports are 25 or 587 (for STARTTLS protocol) and 465 (for TLS protocol). Please
consult relevant documentation for port number used by the mail server you intend
to use.

User name

A log in name that is used to access the mail server. Please note that it may or
may not include mail server name itself. It may be just (without quotes) 'username'
OR 'username@mailserver.com'.

Password

A secret combination of symbols that is used to access your server, computer, or
account.
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Retype the password to confirm that it was entered correctly.

Security
Authentication
type

A method of authorisation that the mail server will accept. The following methods
are available:
-- (=none)
'Plain text'
'Login'
'CRAM-MD5'
'POP3 before SMTP'

POP3 port

This option is active only if 'POP3 before SMTP' authentication type is selected
(see above). A port that AnyFileBackup will use to access the mail server. The
common server ports are 25 or 578 (for POP3 Regular protocol), and 465 (for
SMTPS). Please consult relevant documentation for port number used by your mail
server.
Please note that SMTPS requires Secure Protocols Extension to be installed.

Security mode

A type of connection to the mail server. The following methods are available:
None
Implicit (TLS Connection)
Explicit (STARTTLS)

Default Sender
This group of settings defines the default values (sender's name and e-mail address) for every message
sent thorough this outgoing mail server. However, these settings may be overridden by settings set for a
specific Recipient List. For example, if the sender name in the Outgoing E-Mail account is defined as
'John' and in the Recipient List it is defined as 'Paul', then every e-mail from this Recipient List will be
sent from 'Paul' regardless any name set in the Outgoing E-Mail account.
Sender name

A name that will be displayed in the 'From' field of the e-mail. Please note, that
some mail servers forcibly insert user name defined in this mail server settings
regardless any settings in AnyFileBackup.

Sender address

An e-mail address that will be displayed in the 'From' field of the e-mail after the
Sender name (if any).
Please note that:
some mail servers forcibly insert sender e-mail address (usually
'username@mailserver.com') that is used to log in to this mail server, or an e-mail
address associated with this mail server account, regardless any settings in
AnyFileBackup;
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if left blank, some mail servers (especially free mail servers) may reject such emails; so it is vital to ensure that sender e-mail address is the same as user
name that is used to log in to this server or the same as an e-mail address
associated with this this mail server account.

MessageID
domain

Text that will be displayed in the 'Message-ID' field of the e-mail. Please note, that
some mail servers forcibly insert their own MessageID regardless any settings in
AnyFileBackup.

Miscellaneous
Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.

Used by the
following tasks

A list of tasks that use this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

6.4.10 Password
Topic Content
General
Miscellaneous

This group of option defines properties for encryption and decryption passwords. Requires the 'File
Encryption' extension.

General
Password

A password that is used to encrypt and decrypt files. We recommend you to use
strong passwords.

Confirm
password

Repeat your password to confirm that is has been entered correctly. If it does not
match the password entered above, AnyFileBackup will not allow to save changes.

Miscellaneous
Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.
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Used by the
following tasks

A list of tasks that use this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

6.4.11 PGP
Topic Content
Current Key
Key Management
Miscellaneous

This group of option defines properties for PGP keys and their management. Requires the 'File
Encryption' extension.

Current Key
Below are parameters of your current PGP key. Key password must be entered manually. The other
parameters are set automatically when a key is imported or created (see the 'Key Management' section
below for details).
Key type

A type of a key, which may be either 'Public', or 'Secret', or both. To encrypt and
decrypt files you need both keys. Encryption requires only a 'Public' key and
decryption requires a 'Secret' key only.

User

An owner of a PGP key.

Key ID

Last 64 bits of a public key. Please note that different PGP public keys may have
the same 'Key ID's, therefore, please use a 'Key fingerprint' to identify your PGP
public key.

Key fingerprint

Also known as a 'thumbprint' in Microsoft software, this is a sequence of bytes that
has been created using a hash technology and that uniquely identifies a PGP
public key.

Key password

A secret password that is associated with your PGP secret key. If only a PGP
public key is present, this option is disabled.

Algorithm

A security algorithm that is used for key generation. Advanced algorithms can
increase a key's strength.

Created

Time and date when the current key has been created.

Expired

Time and date when the current key expires and will no longer be valid.

Key Management
New key
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that will store them internally. Press the 'Generate' button to generate new PGP
keys (public and secret) in just two step. Please note that generation of new keys
may take several minutes. If you have already had a key within the selected
account, it will be replace with the newly generated keys.

External key

If you already have a PGP key file, you may import it into AnyFileBackup. Please
note the following:
for file decryption (that is performed before files are transferred to Target) it is
necessary to import both a PGP secret key and a PGP public key; if only a PGP
public key is imported, only file encryption will be enabled;
a file with a PGP key(s) should start with the following line: '-----BEGIN PGP
PUBLIC KEY BLOCK-----' or '-----BEGIN PGP PRIVATE KEY BLOCK-----'

Current key

A current key (both a public key and, if any, a secret key) can be exported into an
unencrypted open file format. A secret key password is never exported. After
export, the following files may be saved (depends on which keys you have):
'[filename].pub': this is your public key, which may be shared with others
because it is used for encryption only,
'[filename].sec': this is your secret key, which is used to decrypt encrypted files.
Please keep this file safe and secure to prevent unauthorised access to
your files.

Miscellaneous
Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.

Used by the
following tasks

A list of tasks that use this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

6.4.12 Ping
Topic Content
General
Miscellaneous

This group of option defines properties for accessing a remote host via ICMP (Internet Control Message
Protocol).

General
Host address

An address of a remote host which normally looks like an IPv4 address (for
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example, 192.168.0.100).

Miscellaneous
Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.

Used by the
following tasks

A list of tasks that use this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

6.4.13 Recipient List
Topic Content
Recipients
Sender
Default Message Properties
Miscellaneous

This group of option defines properties for a list of e-mail recipients.

Recipients
To

A list of e-mail addresses of primary recipients who's addresses will be displayed in
the 'To' field. E-mail addresses may be entered as "Name" <name@mailserver.
com> or just name@mailserver.com. E-mail addresses should be separated by a
coma (','), semicolon (';'), or simply each should start at new line (use the 'Enter'
key to jump to a new line).

CC

A list of e-mail addresses of secondary recipients who's addresses will be
displayed in the 'CC' (='Carbon Copy')field. E-mail addresses may be entered as
"Name" <name@mailserver.com> or just name@mailserver.com. E-mail addresses
should be separated by a coma (','), semicolon (';'), or simply each should start at
new line (use the 'Enter' key to jump to a new line).

Sender
This group of settings defines specific sender's name and e-mail address that are unique to this recipient
list. These settings override the Default Sender values set in the Outgoing E-Mail server settings. If left
blank, the respective default values from the Default Sender section of the Outgoing E-Mail server
settings will be used.
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Sender name

A name that will be displayed in the 'From' field of the e-mail. Please note, that
some mail servers forcibly insert user name defined in this mail server settings
regardless any settings in AnyFileBackup.

Sender address

An e-mail address that will be displayed in the 'From' field of the e-mail after the
Sender name (if any).
Please note that:
some mail servers forcibly insert sender e-mail address (usually
'username@mailserver.com') that is used to log in to this mail server, or an e-mail
address associated with this mail server account, regardless any settings in
AnyFileBackup;
if left blank, some mail servers (especially free mail servers) may reject such emails; so it is vital to ensure that sender e-mail address is the same as user
name that is used to log in to this server or the same as an e-mail address
associated with this this mail server account.

Default Message Properties
This group of options allows to set the default values for subject and text fields of outgoing e-mails as
well to set some other settings. These values are 'default' because they are used only if not superseded
by specific values set for particular e-mail message in Task Scenario.
Subject

The subject matter of the e-mail. You may use Macro strings in this field.

Message text

The body of the e-mail. You may use Macro strings in this field.

Message
charset

An encoding that is used to create the e-mail message. Depending on your region
and recipients' e-mail clients you may choose the most appropriate encoding. It is
common to use UTF-8 as a default encoding.

Message format

A format of the e-mail message that can be either Plain text or HTML. In HTML you
may use additional text formatting (like making text bold, italic, or underline it),
create links and generally take all the advantages of HTML format.

Message priority

The urgency of the e-mail. E-mails with 'High' priority when displayed in e-mail
clients usually have a different colour or a special sign attracting attention of the
recipient. It is recommended to use 'Normal' priority by default unless
circumstances require otherwise.

Miscellaneous
Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.

Used by the
following tasks

A list of tasks that use this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.
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A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

6.4.14 Remote Computer
Topic Content
General
Miscellaneous

This group of option defines properties for accessing a remote computer connected to the same local
area network (LAN) to which AnyFileBackup has access.

General
Remote
computer name
or IP address

A name of a remote computer as it is displayed on the LAN or this computer's
unique IP address at this LAN.

User name

A log in name that is used to access this remote computer.

Password

A secret combination of symbols that is used to access your server, computer, or
account.

Confirm
password

Retype the password to confirm that it was entered correctly.

Miscellaneous
Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.

Used by the
following tasks

A list of tasks that use this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

6.4.15 SMS
Topic Content
General
Miscellaneous
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This group of option defines properties for sending SMS messages via an Android-based smartphone.

General
Phone number

An phone number in international format, including a plus ('+') sign, to which SMS
messages will be sent (for example, +1 100 123 456 789). Spaces are irrelevant
and do not affect the phone number.

Confirm phone
number

Retype the phone number to confirm that it was entered correctly.

Miscellaneous

6.5

Account name

A name of the current account that will be displayed in account list. If left blank, the
address (or number, or user name, or account ID, as the case may be) from
General section above will be used as the account name.

Notes

Any notes related to this account.

Used by the
following tasks

A list of tasks that use this account.

Account ID

A unique identification number that may be used as a macro string parameter. This
value cannot be changed.

Created

A calendar date and time when this account was created. This value cannot be
changed.

Modified

A calendar date and time when any of the properties of this account has been
changed. This value changes automatically and cannot be changed manually.

Error Handling
Topic Content
Error Notification
Outgoing Mail Server
Task Management
Miscellaneous

This option defines how AnyFilebackup behaves when an error occurs.
An 'error' is generally any misbehaviour in task performance. This may be, for example, a failure to copy
a file because a Target folder was inaccessible, or lack of disk space in Target, or failure to restart or
hibernate a computer after backup completion, or interruption of connection to FTP server.

Error Notification
Send error
notifications by
e-mail

This option defines how AnyFileBackup will inform about any errors occurred in a
course of task execution. The following options are available:
'Never': error notifications will not be sent.
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'In a single message': error notifications will be aggregated and send in one single
e-mail message at the end of task scenario. Please note that this may cause
delays because certain time may pass between an error and completion of task
scenario (when error notification is dispatched), especially when task performs
time-consuming operations like transfer of large files.
'In separate messages': error notifications are sent immediately when error
occurs. This is the most swift method of notification about errors and it is
recommended to use it when immediate notification is crucial. Please note, that
task may produce multiple errors and each will be notified in a separate e-mail
message. This may overload your mailbox and some mail servers may consider
these e-mails as spam. Therefore, it is important that you have sufficient space in
your mailbox and mail server filters allow all AnyFileBackup e-mail messages.
Recipient list

Select a name or multiple names of pre-configured Recipient List(s) by checking
appropriate items. If there is none, or you need to create a new one, access
Recipient List account properties as described below.

Recipient list
properties

Click the 'Configure' button to access the Recipient List manager where you can
create and configure your recipient lists. Detailed information about this can be
found here.

Outgoing Mail Server
Sender account
name

Select a name of a pre-configured E-mail server account from the drop down list. If
there is none, or you need to create a new one, access E-mail account properties
as described below.

Account
properties

Click the 'Configure' button to access the Outgoing E-mail Accounts manager
where you can create and configure your e-mail accounts. Detailed information
about this can be found here.

Task Management
This group of settings defines the default error handling rules for all tasks. These settings may be
overridden by Error Handling rules set for a particular task in Activation section of Task Properties.
Task retry count

Before AnyFileBackup proceeds according to 'On error' rules set in Error Handling
rules for a particular task in Activation section of Task Properties, it may attempt to
perform an action or a step, which caused error, again. This option defines a
number of attempts to perform this faulty action / step. If the last attempt is
unsuccessful, AnyFileBackup will proceed according to 'On error' rules.

Task retry
interval

This option defines an interval (in minutes) between attempts to perform a faulty
action / step. While waiting, task will not proceed but wait for the next attempt to
perform such faulty action / step.

Performance
index

This options defines how computer hard disk drive (HDD) is used by AnyFileBackup
when other applications and processes also need to access the HDD beyond usual
usage. The lower the performance index value is, the more priority will given to other
applications and process for accessing the HDD. The higher the performance index
value is, the more priority will be given to AnyFileBackup.

Miscellaneous
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Show tray
notifications

If enabled, a tray notification will be displayed every time when error occurs.
AnyFileBackup GUI (graphic user interface) must be running to display tray
notifications.

Verify Settings

Press the 'Start' button to direct AnyFileBackup to immediately launch this action.
This will verify whether all above settings were entered correctly; all errors, if any,
will be displayed in a log window.

Task Processor
Topic Content
Task Processor Working Mode
Application Mode
System Service Mode

This option defines the mode in which AnyFileBackup works.

Task Processor Working Mode
Mode

AnyFileBackup consists of two principal parts:
the GUI, or Graphic User Interface, which most users use to create and configure
tasks and view AnyFileBackup activity status (command line also supported),
the 'core' or, as we call it, the Task Processor, which performs backup,
synchronization, monitoring, and similar tasks. It can work in either of the
following modes:
'Application': the Task Processor runs as an ordinary Windows-based
application, that is in the same way as most of other applications work: a user
logon is required to launch it;
'System Service': the Task Processor runs as a system service, which means
that the Task Processor runs in background without user logging into the
system.
In both cases the Task Processor runs without the GUI and the difference is
whether user logon is necessary to launch the Task Processor.

Application Mode
Startup type

A method of how the Task Processor is launched after user logon. The following
options are available:
'Start with AnyFileBack up': the Task Processor will launch contemporaneously
with AnyFileBackup GUI.
'Manual': the Task Processor will launch when manually started from the top
menu 'File' > 'Task Processor' > 'Start as application' or by pressing the 'Task
Processor' button on the Buttons Bar in the Main Window and selecting 'Start as
application'.
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'Start on user logon': the Task Processor will launch automatically upon user
logging into the system.
On
AnyFileBackup
exit

This option defines what happens when you exit AnyFileBackup with the Task
Processor working in the Application mode. The following options are available:
'Always ask ': a pop-up window will appear every time you exit AnyFileBackup
asking you whether to shutdown the Task Processor or to let it continue running
in background.
'Shutdown Task Processor': the Task Processor will be automatically shutdown
when you exit AnyFileBackup and, respectively, all tasks will stop.
'Continue Running Task Processor': the Task Processor will continue running in
background and all tasks will continue working as usual.

System Service Mode
Setup

Press the 'Install/Uninstall' button to install or uninstall AnyFileBackup as a system
service. After that you will be prompted to enter the following information:
'Log on as': An existing user name that the Task Processor will use to logon into
the system. For example: .\Username (a dot and reverse solidus are required as
well).
'Password': A password that is set for the user selected above.
You can uninstall AnyFileBackup as a system service in a like manner by pressing
the same button.

Service manager

7

Press the 'Open' button to launch system Service Manager where you can configure
AnyFileBackup system service. You can, for example, change username and
password.

Reporting
Reporting is a powerful feature of AnyFileBackup that delivers to you a comprehensive statistics about
AnyFileBackup operations for the defined period of time. It helps to keep a detailed record of all relevant
AnyFileBackup events in a convenient format and be aware of any important AnyFileBackup activities.
The following chapters are included in this section:
Overview: a general explanation how to manage reports.
Adding a New Report: a step-by-step guide how to add a new report.
Editing an Existing Report: a step-by-step guide how to change properties of an already exiting report.

7.1

Reporting Overview
This section explains how to add new and customise existing reports and generate reports about
AnyFileBackup activities. Press the 'Create a Report' button on the Button Bar in the Main Window to
open a window from where you can create a report.
A registered version of the Reporting extension is required to create reports of unlimited length (the
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length, that is a number of events, or lines, included into the report, is limited in an unregistered version).

Report list

There are three pre-installed report templates that can be used to
create reports:
'Daily Report': creates a report about AnyFileBackup activity for the
preceding 24 hours.
'Traffic Report': creates a report about total file size transferred by
AnyFileBackup for the entire period covered by the AnyFileBackup
log file.
'Error Report': creates a report about error encountered by
AnyFileBackup for the preceding 48 hours.
A new (aka 'custom') report can be created by clicking on the 'Add
report' button. The Report Manager will launch and guide you through
setting up a report. You need to have the Reporting Extension
installed.

Report format

Reports may be created in either HTML or TXT (plain text) format. A
system default application for opening HTML or TXT files will be
launched when you press the 'Create a report' button.

Create report

Select a report from the 'Report list' and click this button to generate
a report. Depending on the 'Report format' selected, a system default
HTML or TXT viewer will open with the generated report.

Cancel report

Certain reports may take some time to generate (for example, when
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they cover several months of 24/7 AnyFileBackup activity). This
button interrupts report generation if it is taking too much time.

7.2

Add report

Launches the Report Manager that will assists you with creating a
new (aka 'custom') report. The Reporting Extension is required to use
the Report Manager.

Edit report

Select a report from the 'Report list' and click this button to launch
the Report Manager that will assists you with editing an existing
report. For pre-installed report templates only report dates, header,
style can be changed.

Delete report

Select a report from the 'Report list' and click this button to delete
the selected report. Pre-installed report templates cannot be deleted.

Adding a New Report
This section explains how to create a new report with the Report Manager (requires the Reporting
extension installed). Press the 'Add report' button to launch the Report Manager.

Step
1:
Report
Struct
ure

In this step report columns, their headings and order may be configured.
Selecting columns: check a tickbox opposite an appropriate column type for this column to
be included into the report. Unchecked columns will not be displayed in the report. At least
one column must be included in the report, otherwise it will be impossible to proceed to
next step.
Column headers: if left blank, column headers in the report will be identical to appropriate
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column types. In the 'Column Header' field custom column headers may be specified. The
header does not affect the content of the column. For example, changing kbytes to bytes
will not cause information to be displayed in bytes.
'GROUP': a name of group the task belongs to. Group name may be configured in the Task
Properties.
'TIMESTAMP': a time and date of an event recorded by AnyFileBackup.
'TASK': a task name that may be configured in the Task Scenario.
'TEXT': a message that is recorded into AnyFileBackup Event List.
'STATUS': a description of an event--an error or not.
Up/Down arrows: by moving columns up or down you specify its position in the report. The
top position means that this column will be the first to the left in the report; the bottom
position, respectively, means that it will the the last to the right.

Step
2:
Conditi
ons

In this step conditions for including or excluding events may be specified. In other words, it is
possible to filter in/out AnyFileBackup events. This step may be skipped if all events are to be
included in the report.
'Connector': a logical operator that defines whether conditions are treated separately or
cumulatively. First condition does not have a connector.
'OR' means that if either of two conditions are satisfied, an event will be included into the
report.
'AND' means that both conditions must be satisfied for an event to be included into the report.
This connector creates a group of conditions (1 AND 2 AND 3) that is treated as a single
condition (see the below example for details).
Example:
STATUS IS ERROR
OR GROUP IS NOT Samples
AND TASK IS Folder Back up
OR TEXT IS Failure
This means that there are three conditions:
Condition 1: STATUS IS ERROR
Condition 2: GROUP IS NOT Samples AND TASK IS Folder Back up (that is because 'AND'
creates a single condition consisting of two parts)
Condition 3: TEXT IS Failure
'Field': a property that is checked by AnyFileBackup. The following properties are
supported:
'GROUP': a name of group the task belongs to. Group name may be configured in the Task
Properties;
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'TASK': a task name that may be configured in the Task Scenario;
'TEXT': a message that is recorded into AnyFileBackup Event List;
'STATUS': a description of an event--an error or not, or both.
'Operator': an expression that defines the relation between the 'Field' and its 'Value'. The
following operators are available:
'IS': an expression meaning that for an event to be included into the report, it must have its
value in respective 'Field' be fully equal to a value defined in the 'Value';
'IS NOT': an expression meaning that for an event to be included into the report, it must not
have its value in respective 'Field' be equal (either partly or fully) to a value defined in the '
Value';
'CONTAINS': an expression meaning that for an event to be included into the report, it must
have its value in respective 'Field' be equal (either partly or fully) to a value defined in the '
Value'.
'Delete' button: deletes the current condition. To delete a condition in the middle of the list,
all subsequent (located below it in the list) must be deleted.
'Add' button: adds a condition to the bottom of the list.
Step 3:
Reports
Date,
Header,
and
Style

In this step general report settings may be configured.
'Report name': a name that is displayed in the report list of the Reports window.
'Report title': a title that is displayed at the top of the report.
'Report start date' and 'Report end date': these dates define the period which will be covered
by the report. If left blank, they are defined as ${YESTERDAY} and ${TODAY} meaning that
the report will cover up to 48 hours of AnyFileBackup activity from the date when the report
is generated.
There are two ways to define report start and end dates: with a macro and by defining an
exact date (or a combination of them). The below table summarizes all available options:
Start Date

End Date

Macro

${YESTERDAY}
${TODAY-[DAYS]}
${TODAY}

${YESTERDAY}
${TODAY-[DAYS]}
${TODAY}

Exact Date

Any calendar date

Any calendar date

Notes:
End date must always be greater or equal to the Start date, otherwise an empty report will
be generated.
If the 'Start date' field is left blank, the ${YESTERDAY} macro will be inserted there.
If the 'End date' field is left blank, the ${TODAY} macro will be inserted there.
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Macro: where the macro is ${TODAY-[DAYS]}, the [DAYS] is the number of days back from
from the current date. For example, if today is 10th of April and the macro is ${TODAY-7}
then the period covered by the report will be from and including 4th of April to and including
10th of April.
Exact date: a date in Windows short date format which normally looks like dd/MM/yyyy.
You can select it by clicking on the 'Calendar' icon (proper format will be used
automatically) or type it manually. Windows short date format can be viewed at: 'Control
Panel' > 'Region and Language' > 'Format' tab (Windows Vista and 7) OR 'Control Panel' > '
Region' > 'Formats' tab (Windows 8 and 8.1)

'A file with the report style': A full path to a file in XSL format with styles that may be applied
to the report. If left blank, a default style will be used.

7.3

Editing an Exisitng Report
This section explains how to edit an existing report with the Report Manager (requires the Reporting
extension installed). Select a report in the 'Report List' and press the 'Edit report' button to launch the
Report Manager.
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Editing an existing report is identical to adding a new report. Please see the 'Adding a New Report'
section for details.
For three pre-installed report templates you may only change their start and end dates, header, and
style.

8

Miscellaneous
This topic describes three major areas:
the syntax of CRON format,
keys for macro strings, and
command line parameters.

8.1

CRON Format
CRON, or Cron, is a powerful UNIX time format. With CRON time scheduling becomes flexible and
powerful as never before. You may switch from an ordinary style schedule to a CRON-style schedule by
enabling the 'Advanced mode' for the Periodical Schedule in the Start step of the Task Scenario.
CRON has certain rules which are outlined in this section.
Permitted values

2015 AAR Innovations (R)

Field

Permitted Value Range

Comment

178

AnyFileBackup

Special symbols

Minute

0 – 59

Hour

0 – 23

Day of week

0–6

Day of month

1 – 31

Month

1 – 12

0 (zero) is Sunday
SUN – SAT not
supported

JAN – DEC not
supported

There are certain special symbols that help to configure CRON schedule:
Asterisk ('*'): means all values within the permitted rage of values for the selected
field.
Plus ('+'): converts a value into an interval. For example, Minute: 5 means the fifth
minute of an hour and Minute: +5 means every five minutes during an hour.
Hyphen ('-'): means a range including numbers that are used to limit the range.
Example: 9-11 h means hours 9, 10, and 11.
Comma (','): used to separate values in the field.

Lists

A list is a combination of values set with special symbols and separated by
comma. Lists are supported by AnyFileBackup.
Example: 0-4,8-12

Common
examples

Field

Description

Minute

Hour

Day

Month

Weekda
y

+1

*

*

*

*

execute
minute

task

every

0

0

*

*

*

execute
midnight

task

every

0

+12

*

*

1-5

execute task at midnight
and at noon from Monday
to Friday

0

0

1

*

*

execute task at midnight
after the end of every
month

0

0

*

*

6

execute task at midnight
on Saturday

15

+6

*

*

*

execute task on 15th
minute every 6 hours (that
is 0:15, 6:15, 12:15,
18:15)

0

8-16

*

*

1-5

execute

task

at

the
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beginning of every hour
from 8 in the morning till
16 in the evening from
Monday to Friday

8.2

Macro Strings
Topic Content
Macro Assistant
Universal Macros
Macros That Can be Used Within Backup Step Only
Macros That Can be Used After Backup, Two-Way Sync, Monitoring, or Clean-up Step

This sections explains how to use AnyFileBackup macro strings. Each macro starts with a dollar sign
followed by a left curly bracket (${). Then you type a macro string. Each macro must end with a right
curly bracket (})

Macro Assistant
Macro Assistant is designed to help you to access the most common macro strings without looking into
the help documentation. It can be accessed by clicking on the button with '< >' icon (see the screenshot
below) from the Task Properties window.
Each macro string has at between one and values. The first value is always mandatory (without it macro
will not be recognised) and any others (if any) are optional.
To select a macro, left-click on the macro name in the table. To select any of its values, left-click on the
respective value available for that macro. To select another value, left-click on it. It is important to leftclick on the value itself, not anywhere else.
When you click the 'OK' button, the string that you have selected (macro and its value(s)) will be
automatically copied to clipboard. You may insert it by pressing 'Ctrl-V' key sequence or by mouse rightclick and then select 'Paste'
Macro
assistant
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Universal Macros
These macros may be used almost universally, with any action or source, at any point of task scenario.
AnyFileBacku
p full edition
name

${AFBNAME}

AnyFileBacku
p installed
version

${AFBVER}

Current date

${DATE}

Current date
format

${DATE=[DATE FORMAT]}
Example: ${DATE=yyyy-mm-dd}

Current time

${TIME}

Current time in ${TIME=[TIME FORMAT]}
specified
format
Example: ${TIME=hh:nn:ss}
E-mail
attachment

${ATTACHMENT,FILE=[PATH TO FILE]}
Example: ${ATTACHMENT,FILE=C:\Readme.txt}

Environment
variable

${ENVGET=[ENVIRONMENT VARIABLE VALUE]}
Read also about environment variables values.

Load text from
file

${EXTTEXT,FILE="[PATH TO FILE]",[KEYS]}
FILE="[PATH TO FILE]" a full path in double quotes ("") to a file (usually a plain text
file) which contains text to be included into a message body.
[KEYS] are additional optional parameters separated by a comma (',') without space:
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CR=[CHARACTER CODE] (specifies a code of character which should replace CR
(cartridge return) code in the loaded text. Example: CR=32 (CR will be replaced
with space).
LF=[CHARACTER CODE] (specifies a code of character which should replace LF
(line feed) code in the loaded text. Example: LF=124 (LF will be replaced with "|", a
vertical line)
To find character codes (in decimal) search Google for "character codes decimal" or
for "ASCII table".
Location of
Source

${SOURCEPATH}

Log file
message

${LOGMSG}
A custom text message that is written into AnyFileBackup log file (distinguish it from
AnyFileBackup Event List).

Name of the
current task

${TASKNAME}

Name of the
group task
belongs to

${GROUPNAME}

Reporting
extension
macro

There are few macros that are only used with the Report Manager. You can read
about them in the dedicated section of this help.

Macros That Can be Used Within Backup Step Only
These macros may be used ONLY within the Backup step of the Task Scenario.
Amazon S3
URL to an
uploaded file

${AMAZON_S3_FILEURL}

Conflict
resolution
rules only
macro

These macro strings are only available when BACKUP > Conflict Resolution Rules
are configured to rename files with identical names.
The following macros are available:
${FULLNAME}: a full file name including its extension
${FILENAME}: a full file name excluding its extension
${FILEEXT}: a file's extension
${NUM}: a file's index number which is automatically assigned to it and which
automatically increased by one with every file renamed.

E-mail sender
address

${FROM}
Where Source is a mailbox: an e-mail address of the sender from the received e-mail
message

E-mail
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recipient
address
E-mail subject

Where Source is a mailbox: an e-mail address of the receipient from the received email message
${SUBJECT}
Where Source is a mailbox: subject from the received e-mail message

E-mail ID

${MESSAGEID}
Where Source is a mailbox: e-mail message identification number from the received
e-mail message

File name and
its parameters

${FILE[,KEYS]}
[KEYS] are additional optional parameters separated by comma (',') without space:
PATH (to include file path).
Example: ${FILE,PATH}.

File size in
specified units

${FILESIZE=[B,K,M]} where B=bytes, K=kilobytes, and M=megabytes. If no value is
entered, a default value is =B.
Example: ${FILESIZE=M}

File
timestamp in
specified
format

${FILETIME=[TIMESTAMP FORMAT]}
If no value is entered, a default value is a format set in AnyFileBackup 'Program
Settings' > 'Common' > 'Appearance'.
Example: ${FILETIME=yy-mm-dd hh:nn:ss} will look like 14-07-25 13:10:55

Target file

${TARGETFILE}
This macro is replaced with a full path and filename of a file that has been backed up
to Target. If this files has been renamed in a course of the backup, then the macro will
use the renamed file.

Macros That Can be Used After Backup, Two-Way Sync, Monitoring, or Clean-up Step
These macros may be used ONLY when the Backup, Two-Way Sync, Monitoring, or Clean-up step of
the Task Scenario has been completed.
Amazon S3
URL list to all
uploaded files

${AMAZON_S3_URLS}

Disk space:
free or
occupied

${DISKSPACE}

E-mail sender
address

${FROM}

Disk space monitoring only

Where Source is mailbox: an e-mail address of the sender from the received e-mail
message
E-mail
recipient

${TO}
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address

Where Source is mailbox: an e-mail address of the receipient from the received e-mail
message

E-mail subject

${SUBJECT}
Where Source is a mailbox: subject from the received e-mail message

E-mail ID

${MESSAGEID}
Where Source is a mailbox: e-mail message identification number from the received
e-mail message

Event log:
event ID

${EVENTLOG_EVENTID}
Where Source is Windows Event Log: Event ID of a new event log record that was
detected by AnyFileBackup when it monitors Windows Event Log (Event Log
extension is required)

Event log:
event level

${EVENTLOG_EVENTLEVEL}
Where Source is Windows Event Log: Event Level of a new event log record that was
detected by AnyFileBackup when it monitors Windows Event Log (Event Log
extension is required)

Event log:
event source

${EVENTLOG_EVENTSOURCE}
Where Source is Windows Event Log: Event Source of a new event log record that
was detected by AnyFileBackup when it monitors Windows Event Log (Event Log
extension is required)

Event log
event text

${EVENTLOGMSG}
Where Source is Windows Event Log: text of a new event log record that was
detected by AnyFileBackup when it monitors Windows Event Log (Event Log
extension is required)

File counter
(for files
transferred)

${FILESCOUNT[,KEYS]}
Only work s with Source that has files (that means that it does not work with PING
monitoring, HDD space monitoring, etc.)
[KEYS] are additional optional parameters separated by commas (',') without space:
FILTER=NEW (only created and changed files are included in a total files count),
=DEL (only deleted files are included in a total files count). Default value is =NEW.
DIR=Y (this will count directories alongside with files and include them [directories]
in a total files count), =N (directories are not counted and not included in a total
files count). If no value is entered, a default value is =N.

File list (for
files
transferred)

${FILELIST[,KEYS]}
Where Source has files that means that it does not apply to PING monitoring, HDD
space monitoring, etc..
[KEYS] are additional optional parameters separated by comma (',') without space:
PATH (to include file path).
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"DL=[CHARACTER]" a separator between files in the file list. The separator can
consist of one or more characters. This key must be put in double quotes (""). If no
value is entered, a default value is LF (line feed).
FILTER=NEW (only created (aka 'new') and changed files are included in a total
files count), =DEL (only deleted files are included in a total files count). Default
value is =NEW.
Example: ${FILELIST,PATH,"DL=;",FILTER=NEW} means that created and changed
files with their full paths separated by a semicolon (";") are included in the file list.

8.3

Command Line Parameters
Topic Content
General
Task Commands
Miscellaneous Commands

This sections explains how to manage AnyFileBackup from command line.

General
Managing AnyFileBackup from command line requires two things:
- the Task Processor, a module responsible for all operations, must be running; and
- a proper command is sent to the Task Processor with sendcmd.exe utility located in AnyFileBackup
installation folder.
Task Processor

AnyFileBackup Task Processor can be launched from command line as an ordinary
Windows-based application only (not as a Windows system service). To launch the
Task Processor please type the following:
"C:\Program Files (x86)\AnyFileBackupPro\afbtppro.exe" /EXE

Commands

The list of commands with description can be found below. The simple rules for
using the commands are:
sendcmd.exe utility is used to send commands to the Task Processor
commands can be used in any order
it is possible to use several commands contemporaneously
any new command must start with the solidus symbol ('/') or the hyphen-minus
symbol ('-')
all commands are case-sensitive and it is essential that you type them
with CAPITAL LETTERS

Command line
template
example

The typical command line looks like this:
sendcmd.exe /[COMMAND1] [COMMAND1 PARAMETER(S)] /[COMMAND2] [
COMMAND2 PARAMETER(S)]
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where:
[COMMAND] is a key word from the list below;
[COMMAND PARAMETER(S)] is one or more options depending on the
preceding command.

Task Commands
Activate task

Command: ACTIVATETASK
Parameter: TASK_ID is a Task ID which can be found in task's Advance Options
located in the Activation section of the Task Scenario.

Activate all
tasks

Command: ACTIVATEALL
Parameter: none

Deactivate task

Command: DEACTIVATETASK
Parameter: TASK_ID is a Task ID which can be found in task's Advance Options
located in the Activation section of the Task Scenario.

Deactivate all
tasks

Command: DEACTIVATEALL
Parameter: none

Start task
manually

Command: STARTTASK
Parameter: TASK_ID is a Task ID which can be found in task's Advance Options
located in the Activation section of the Task Scenario.

Examples

Single task example:
sendcmd.exe /ACTIVATETASK 1ACE909E /STARTTASK 1ACE909E
Multiple tasks example:
sendcmd.exe /ACTIVATETASK 1ACE909E /ACTIVATETASK
STARTTASK 1ACE909E /STARTTASK 1112835C

1112835C /

BAT-file example:
start /D"C:\Program Files (x86)\AnyFileBackup Pro" afbtppro.exe /EXE
"C:\Program Files (x86)\AnyFileBackup Pro\sendcmd.exe" /VERBOSE /PAUSE
10 /ACTIVATETASK 1ACE909E /STARTTASK 1ACE909E
pause
In this third example the PAUSE command is recommended because it gives the
Task Processor time to start.

Miscellaneous Commands
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Communication
port

Command: PORT
Parameter: a port number that the Task Processor is using to communicate with
AnyFileBackup GUI, a graphic user interface window. By default the value is 18410.

Detailed log in
command line

Command: VERBOSE
Parameter: none

No logo when
AnyFileBackup
GUI is loading

Command: NOLOGO
Parameter: none
This command must be used with afbackuppro.exe.
Example: "C:\Program Files (x86)\AnyFileBackupPro\afbackuppro.exe" /NOLOGO

Pause

Command: PAUSE
Parameter: a pause length in seconds

Stop Task
Processor

Command: STOPTP
Parameter: none

9

Extensions
This section explains how to further extend AnyFileBackup functionality adding certain specialist functions
with extension modules:
Additional tasks extension
Could extension
Event log extension
File compression extension
File encryption extension
Google Drive extension
OneDrive extension
Remote console extension
Reporting extension
Secure protocols extension
SMS extension
Task import export extension
TFTP extension
Time synchronisation extension
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Extensions may be downloaded at www.any-file-backup.com/download/

9.1

Additional Tasks
This extension increases the number of tasks that can simultaneously co-exist in AnyFileBackup.

9.2

Basic package

By default, up to 50 tasks can simultaneously co-exist in AnyFileBackup (either in
trial or registered version).

Additional tasks

If you need a greater number of tasks, then the Additional Tasks extension can
increase this number by 50 tasks per one extension licence. Please note that
certain packaged upgrades may include this extension allowing you to significantly
increase AnyFileBackup functionality for a lower cost.

Requirements

This extension works only with a registered version of AnyFileBackup.

Amazon S3
This extension adds Amazon S3 support to AnyFileBackup that can use it as Source and Target.
Functions

The following functions are supported:
uploading files to Amazon S3 bucket;
downloading files from Amazon S3 bucket;
Amazon S3 bucket real-time monitoring;
generating public links (URLs) to files (that have been uploaded to Amazon S3)
allowing users to download these files from Amazon S3 without entering login and
password;
setting the validity period for generated Amazon S3 public URLs upon expiration of
which [period] these links will no longer permit users to download files. The validity
period can be set to indefinite making the links exist permanently, as long as files are
available in Amazon S3 Cloud Storage;
distributing generated Amazon S3 public links to any number of users by e-mail, SMS,
or in LAN messages, etc.

9.3

Event Log
This extension adds Windows 2000/Server 2003/XP/Vista/7/8 event log monitoring support (Application,
Security, System and any other custom event log) to AnyFileBackup.
Log filtering

All event log messages can be carefully filtered by:
Log type (Application, Security, Setup, System, etc.),
Type of event (Error, Warning, Information, etc.),
Event ID number,
Source (Security-SPP, SecurityCenter, Winlogon, SkypeUpdate, etc.),
Task category (Search service, Service events, Setup, UNS, etc.).
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Response to log
events

9.4

When the relevant event is detected, AnyFileBackup may launch any action,
including notification by e-mail, SMS, or in LAN messages, etc. It is also possible
to use the data contained in the detected event as a command line parameter for
third-party applications.

File Compression
This extension allows to compress and uncompress files in Source before these files are transferred to
Target. The extension uses ZIP compression algorithm. This reduces network traffic and decreases the
amount of time required for file transfer.

9.5

Files in Target

After compressed files have been transferred to Target, they can be uncompressed
with any ZIP-compatible software, such as WinZip, PKWare pkzip, etc. (not
provided). This also may be done automatically by AnyFileBackup if it is installed
on a Target computer.

Password
protection

If the File Compression extension is used in conjunction with the File Encryption
extension, it can set password to ZIP-compressed files. This makes transfer of
these files both safer and quicker.

File Encryption
This extension adds a file protection feature to AnyFileBackup helping to prevent unauthorized access to
files by encrypting them with powerful encryption algorithms when these files are transferred via internet
or local area network.
Supported
algorithms

The following encryption algorithms are supported:
AES (Advanced Encryption Standard) is the replacement for the Data
Encryption Standard (DES). It is a symmetric block cipher with variable key
lengths and block sizes. It supports 128, 192, and 256-bit keys and 128-bit
blocks.
Blowfish is a symmetric block cipher with key lengths from 32 bits to 128 bits
with the block length 64 bits. The algorithm is patent, royalty, and license free.
Blowfish has been extensively analysed and it is acknowledged as a strong
cipher.
DES (Data Encryption Standard) algorithm was the first encryption standard.
DES is a symmetric block cipher. The key length is usually quoted as 64 bits,
but in reality only 56 bits of these 64 participate in the encryption algorithm. DES
was extensively analysed and is now accepted to be a strong algorithm, except
for one area: the key length. A 56-bit key is within the reach of brute-force
attacks using a network of high-powered machines. DES should therefore only be
used for temporary data; data that would be out-of-date before someone bruteforce cracked an encrypted message.
PGP (Pretty Good Privacy) is a software algorithm for file encryption and
decryption that uses public and secret keys for that purpose. You can read more
about this algorithm at the Wikipedia: https://en.wikipedia.org/wiki/
Pretty_Good_Privacy
Triple-DES since DES's 56-bit key is too short to counter brute-force attacks,
several modifications to the DES standard have been proposed in order to
strengthen it. The most successful of these is the Triple-DES algorithm. TripleDES is three times slower than DES however the cipher is much more secure
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than simple DES. It uses two keys as a single 128-bit value and follows the
encrypt-decrypt-encrypt process with blocks 64 bits long.
ZIP encryption can be used if the 'File Encryption' extension is used in
conjunction with the 'File Compression' extension enabling to set password to
ZIP-compressed files. This makes transfer of these files both safer and quicker.
Legal notice

9.6

Some countries restrict, or even prohibit, the use of software that encrypts
data. If you intend to use this extension, we strongly advise you to seek an
independent legal advice whether any relevant laws and (or) regulations
may apply (i) in a country where AnyFileBackup with the File Encryption
extension will be used to encrypt files and (ii) in a country where such
encrypted files will be received.

Google Drive
This extension adds Google (c) Drive support to AnyFileBackup that can use it as Source and Target.
Functions

The following functions are supported:
Upload, download, update, and delete files in your Google Drive;
Create, access, update, and delete native Google documents in your Google Drive;
Manage files and documents in your Google Drive (e.g., search, organize, and modify
permissions and other metadata, such as title).

9.7

OneDrive
This extension adds Microsoft's (c) OneDrive support to AnyFileBackup that can use it as Source and
Target.
Functions

The following functions are supported:
uploading files to OneDrive folders;
downloading files from OneDrive folders;
periodical monitoring of OneDrive folders;
clean up OneDrive folders.

9.8

Remote Console
Topic Content
Remote Console Options
Accessing AnyFileBackup Remotely

This extension makes AnyFileBackup manageable remotely via a web browser from any computer
connected to the internet or LAN.
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Remote Console Options
Access

enables or disables access to AnyFileBackup via remote console.

HTTP port

a local port number through which the Remote Console can be accessed from a
web browser. It can be any port that is not in use on a computer where
AnyFileBackup is installed. By default the port number is 18440.

Allowed
connections

a number of users that can remotely manage AnyFileBackup at the same time.

Accessing AnyFileBackup Remotely
User account

A user connecting remotely to AnyFileBackup must have an account with
AnyFileBackup Account Manager. This user's account must have the 'Remote
Access' option enabled.

Web browser

To access AnyFileBackup with a web browser type:
from LAN: http://[YOUR_COMPUTER_LAN_NAME]:
[DESIGNATED_HTTP_PORT]
Example: http://backup_server:18440
from the internet: http://[EXTERNAL_IP_ADDRESS]:
[DESIGNATED_HTTP_PORT]
Example: http://111.222.111.222:18440

Firewall and
router settings

in your firewall or router settings an external port shall be mapped to an internal IP
address and port of a computer where AnyFileBackup with the Remote Console
extension is installed. The protocol should be TCP (UDP is not supported). Please
see the example below.
In this example:
'Service Port': an external port accessible from the internet
'IP Address': an IP address of a computer where AnyFileBackup with the Remote
Console extension is installed
'Internal Port': a port of a computer where AnyFileBackup with the Remote
Console extension is installed
'Protocol': a protocol which is used to access a computer where AnyFileBackup
with the Remote Console extension is installed. It should be TCP.
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VIRTUAL SERVERS
Server Port: 5000
Internal Port: 18440
IP Address: 192.168.1.200
Protocol: TCP
Status: Enabled

9.9

Reporting
This extension adds new reporting features to AnyFileBackup making it possible to create new and
customise existing reports. The detailed description of this extension and its functions can be found in the
dedicated section of this help.

9.10

Secure Protocols
This extension adds SSL (Secure Sockets Layer) encryption support to HTTP, FTP, SMTP, and POP3
protocols converting them to HTTPS, FTPS, SMTPS, and POP3S and it also adds separate SFTP
(Secure Shell File Transfer Protocol) encryption support. It is a powerful tool in preserving confidentiality
of your data when it is transferred over the internet or unsecured public networks.
Installation

Please exit AnyFileBackup before installing the extension. If AnyFileBackup Task
Processor is running in background or in the System Service mode, then press the '
Task Processor' button in the Main Window and select 'Stop'.
After the extension is installed, the 'Security mode' field will become enabled in the

Encryption
features

SSL and SFTP encryption have some specifics:
SSL: to use the SSL connection an internet server must also have SSL
supported and enabled.
SFTP: this protocol is a part of SSH protocol family and the extension supports
both older SSH1 and newer SSH2 protocols. SFTP is not as sophisticated as
FTP and has various limitations that affect its usefulness.

9.11

SSH keys

SSH private and public keys for SFTP can be created and managed using the
Certificate Manager.

Legal notice

Some countries restrict, or even prohibit, the use of software that encrypts
data. If you intend to use this extension, we strongly advise you to seek an
independent legal advice whether any relevant laws and (or) regulations
may apply (i) in a country where AnyFileBackup with the Secure Protocols
extension will be used to initiate an encrypted connection or to accept an
incoming encrypted connection, and (ii) in a country with which this
encrypted connection will be established.

SMS
Topic Content
Getting Prepared
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Configuring the SMS Extension Client on Android-Based Smartphone

This extension adds SMS messaging support to AnyFileBackup allowing to send SMS messages to
designated recipients via Android-based smartphones (version 2.1 and above) connected to via Wi-Fi,
USB, or Bluetooth to a computer where AnyFileBackup is installed.

Getting Prepared
SMS Extension

Download and install the SMS extension (server side).

Android client for Download the SMS Extension Client (smartphone side) from www.any-file-backup.
AnyFileBackup
com/download/ and install it on your Android-based smartphone.
Installing this APK file may require a permission to install Android applications from
'unknown' (that is just to say that they have not come directly from Google Play)
sources:

SMS Extension Client requires only the most basic permissions that will not
compromise your security and privacy. Please note that the extension requires any
sleeping mode to be turned off because it needs to constantly monitor for
commands from AnyFileBackup.
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Please be advised that sending SMS messages may cost you money and it is your
responsibility to pay any costs and fees associated with sending SMS messages.
AAR Innovations will not and cannot compensate you any costs and fees resulting
from or associated with sending SMS messages. AAR Innovations also accept no
responsibility for the content of SMS messages.

When installation is successfully completed, please press the 'Open' button to
launch the SMS Extension Client on your Android device.
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Connect
smartphone with
your PC

Permanently connect your Android-based smartphone to a computer (where
AnyFileBackup with the SMS extension (server side) is installed) via Wi-Fi, USB, or
Bluetooth. The connected smartphone must have its unique individual IP address on
the network. This is easier to achieve when it is connected via Wi-Fi.

Configuring the SMS Extension Client on Android-Based Smartphone
The SMS extension client has a very simple and straight-forward interface. Its main screen looks as
follows:
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SMS extension
status

The top line displays the current status of the SMS extension. Use the 'Server start/
stop' button to stop it and then start it again. When the SMS extension is launched,
it is automatically set to active ('start') mode.

Android-based
smartphone
address

This is an IP address that is used by AnyFileBackup to connect to an Androidbased smartphone. It must be entered in the 'Host address' field of the HTTP
account.
Please note, every time Android-based smartphone Wi-Fi or Bluetooth is turned on,
a new IP address may be assigned to it and this new IP address may be different
from an IP address that has been assigned to this smartphone before. This will
require changing AnyFileBackup settings mentioned above.
To avoid this inconvenience, you may:
set a permanent IP address in your smarphone connection settings; or
assigned a permanent IP address to your smarphone in your Wi-Fi router
settings (by linking the smartphone's MAC address to a permanent IP address).

Android-based
smartphone port
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number may be manually changed in the SMS extension settings. Press the
'Settings' button below to access the settings screen and enter the required port
number.

Security settings Access to the SMS extension may be restricted by setting user name, password,
and port number. This will prevent AnyFileBackup users who do not know these
parameters from using the SMS extension. Please note, that this will not mak e the
extension itself protected by user name and password -- anyone who has access to
the smartphone where the SMS extension is installed will be able to configure and
re-configure it.
Press the 'Settings' button to access the SMS extension settings. The following
security settings may be configured:
'Port': a port number required to access the SMS extension from AnyFileBackup.
It must coincide with a port number set in the 'Host address' filed of the HTTP
account (used to configure access to the Android-based smapthone).
'User name': a user name required to access the SMS extension from
AnyFileBackup. It must coincide with a user name set in the 'User name' filed of
the HTTP account (used to configure access to the Android-based smapthone).
'Password': a password required to access the SMS extension from
AnyFileBackup. It must coincide with a password set in the 'Password' filed of
the HTTP account (used to configure access to the Android-based smapthone).
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If enabled, the SMS extensions will prevent the Android-based smarphone from
entering into any kind of power-saving mode. Its necessary because the extension
is permanently monitoring for commands from AnyFileBackup and in power-saving
mode Wi-Fi, Bluetooth, and similar services are normally turned off to reduce
battery consumption.
If disabled and the Android-based smarphone enters into a power-saving mode, then
AnyFileBackup will not be able to maintain the connection to the smartphone via
Wi-Fi and Bluetooth and no SMS messages will be be sent. This will be treated by
AnyFileBackup as an error and it will proceed according to the Common Error
Handling Rules or Task-Specific Error Handling Rules.

9.12

Task Import / Export
This extension allows to save AnyFileBackup task settings to an XML file for backup, transfer between
different instances of AnyFileBackup, or other purposes. For example, this XML file may be manually
edited with third-party software (not provided) and imported into any copy of AnyFileBackup where this
extension is installed.
Export Settings
File type
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file format is supported. XML is an open file format and it is strongly advised to
store AnyFileBack up XML configuration files in a secure location to prevent
unauthorised access.

XSL styles file

A full path to an XSL file with styles that adds additional formatting to an exported
file with AnyFileBackup task configuration. This field may be left blank.

Task list

A list of AnyFileBackup tasks which can be exported. Select one or more tasks by
ticking a relevant ckeckbox left to a task. By ticking a relevant ckeckbox left to a
task group, all tasks within this group will be selected.

Select all

Click this button to select all tasks in the Task list.

Deselect all

Click this button to deselect all tasks in the Task list.

Export

This function work s only with a registered copy of Task Import / Export Extension.
Click this button to select a location and filename of a file where AnyFileBackup
task configuration will be saved.
Important notice: any passwords and information from the accounts are NOT
exported.

Import Settings
Import

9.13

Click this button to select a file with AnyFileBackup task configuration in an XML
format. Please note that after you select a relevant task configuration file,
AnyFileBack up (including it Task Processor module) will automatically stop. This is
necessary to make certain changes to its configuration files. After that you may
launch AnyFileBackup as usual.

TFTP
This extension adds TFTP (Trivial File Transfer Protocol) protocol support to AnyFileBackup. TFTP is
used to transfer files and has the functionality of a very basic form of FTP. Usually it is used for
transmission of files to LAN routers and switches, IP-phones, for booting of diskless workstations.
TFTP at glance

These are the most common TFTP features:
uses UDP port 69 as its transport protocol
has no authentication
cannot list directory contents
is used to read files from, or write files to, a remote server
supports three different transfer modes: "NETASCII", "OCTET", and "MAIL"
has a file size limit of 32 MB

Supported
parameters

TFTP supports the following parameters:
'Transfer mode': binary transfer (OCTET) and text modes only. In the binary mode
files are moved byte by byte.
'Host': the remote host name or address.
'GET': transfer file from a remote host to a local computer.
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'PUT': transfer file from a local computer to a remote host.
'Source': the file to transfer.
'Destination': where to transfer files to.
TFTP limitations

When Source or Target is accessed via TFTP, the following options are not
supported for that Source or Target:
any filter other than the 'Full Filter' in the Primary File Filter;
move and delete file operations;
file renaming;
file replacement;
subfodlers scanning;
user name and password;
proxy;
security modes other than 'None';
some other FTP options.

9.14

Time Synchronization
This extension adds a time synchronization feature to AnyFileBackup making AnyFileBackup
responsible for synchronising computer's clock with a time server (also known as 'Atomic Clock Server').
This extensions requires an internet connection because it uses SNTP (Simple Network Time Protocol)
protocol.
Time server

A name and address of a time server that is used for time synchronization. A list of
time servers is stored in 'TimeSync.dat' file located in the extension folder (by
default 'C:\Program Files (x86)\AnyFileBackupPRO\Extensions\Time Sync\'). Its
content can be updated manually with any text editor (not provided).

Active

If enabled, the extension will be active and will automatically synchronize computer
time and date with the selected time server at specified time intervals.

Adjust computer
time every ...
hours

A time interval in hours (full hours without decile) which defines how often
AnyFileBackup will synchronize computer time with the selected time server.

Adjust minutes
and seconds
only

If enabled, the extension will ignore any hour and date difference (for example, when
Windows does not support Daylight time or does it incorrectly) and will synchronize
minutes and seconds only.
If disabled, the extension will synchronize computer time as usual: hours, minutes,
seconds.

Socks settings

Complete this section if a socks proxy is used to access the internet.

Sync now

Press this button to manually initiate an immediate time synchronization overriding
the current time adjustment schedule.
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Firewall and
router settings

Some firewalls and routers block SNTP protocol by default. In that case they must
be configured as follows:
Source

Destination

Protocol

UDP

UDP

IP address

Any

Any

Port forwarding

123

123

Permit

Permit

Action
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Licensing
Topic Content
General
Individuals
Companies, Non-Commercial NGOs, Governments
Useful Links

In this section you may read how AnyFileBackup may be lawfully used for business or personal needs
and how to purchase a licence and obtain a discount.

General
AnyFileBackup is distributed as a commercial trial. That means that it can be lawfully used for testing
purpose only within 30 (thirty) calendar days as of the first installation date. Limited exceptions are
specified below.
Testing
purposes

A purpose is 'for testing' when its primary and sole purpose of the use is to verify
whether AnyFileBackup meets user's needs and is compatible with user's software
and hardware. For example, a purpose will be 'for testing' if AnyFileBackup is used
to test its capability to function in an ordinary course of trade, business, craft, or
profession.
However, a purpose will not not be 'for testing' if AnyFileBackup is used in trial
mode in an ordinary course of trade, business, craft, or profession as if it was
registered (that is as if a licence was lawfully purchased) when it is clear or very
likely to be clear that AnyFileBackup fits user's purposes and compatible with his
hardware and software.

Extension of trial
period

Trial period is strictly set to 30 (thirty) calendar days as of the first installation date.
Uninstallation followed by a fresh installation on the same computer, or a fresh
installation on a different computer owned by the same individual or his employee,
or a company or its subsidiary does not extend or restart the trial period.
Please contact us to request an extension of the trial period. Our policy is to grant
such extension unless special circumstances exist.

When trial period After expiration of 30 (thirty) calendar days trial period you must either:
has expired
purchase a licence for AnyFilebackup, or
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stop using AnyFileBackup without uninstalling it, or
uninstall AnyFileBackup.
Nothing here precludes you from lawfully keeping your AnyFileBackup configuration
files (.cfg and .dat) which may be found at:
Windows Vista / 7 / 8 / 2008: 'C:\ProgramData\AnyFileBackupPro\'
Windows
XP:
'C:\Documents
Date\AnyFileBackupPro\'.
Purchasing a
licence

and

Settings\All

Users\Application

A licence to use AnyFileBackup can be purchased at www.any-file-backup.com/
order/
If you purchase a certain number of licences, you may be entitled to a discount.
We also offer various corporate discounts. This includes an instalment option.
Please contact us for details.

Individuals
Home or
personal noncommercial use

It is lawful to for an individual to use AnyFileBackup for any home or personal noncommercial needs in trial mode both during the trial period and afterwards (when the
trial period has expired). None of these needs shall be directly or indirectly
connected with that individual's trade, business, craft, or profession.

Use for trade,
business, craft,
or profession

An individual who intends to use AnyFileBackup in his trade, business, craft, or
profession is subject to the same restrictions and limitations as Companies, NonCommercial NGOs, Governments (see below).

Use for other
purposes

It is intended that any use will fall within one of the above categories. However, we
anticipate that there may be rear case where it is not clear which category is
suitable for a particular situation. In case of any doubt please assume that such
use falls within the category of the use for trade, business, craft, or profession and
contact us to clarify this matter.

Companies, Non-Commercial NGOs, Governments
Trial period

It is lawful for Companies, Non-Commercial NGOs, Governments, and their
employees and officers acting in their professional capacity to use AnyFileBackup
within 30 (thirty) calendar days trial period as described above.

When trial period It is unlawful for Companies, Non-Commercial NGOs, Governments, and their
has expired
employees and officers acting in their professional capacity to use AnyFileBackup
after expiration of 30 (thirty) calendar days trial period. How trial period is calculated
and what steps must be taken when it has expired is described above.

Useful Links
Licence

A product licence can be found in AnyFileBackup installer. Please read it carefully
before accepting it.

Terms and
conditions

www.any-file-backup.com/terms/
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FAQ
Please visit our Frequently Asked Questions page for the latest version of AnyFileBackup FAQ: www.anyfile-backup.com/faq/
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Contact
We always welcome your questions and suggestions. Any feedback or question is important for us. Please
have your say and we will do our best to improve AnyFileBackup to meet your needs.
Please contact us:
By e-mail:
General support and any technical inquiries: support@any-file-backup.com
Discounts, subscriptions, corporate programs, etc.: sales@any-file-backup.com
Via website form (all inquiries): www.any-file-backup.com/contact/
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